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Licensing 11.17.2 build 48000

June 19, 2024

Citrix licensing is a system of components that functions together. Before you use any of your Citrix
products, learn about licensing components. The Citrix licensing system includes:

• License Server ‑ Every Citrix product environment must have at least one shared or dedicated
License Server. Servers running Citrix products contact the License Server to obtain licenses.
For more information, see License Server.

• License files ‑ The license file is a text file containing the product licensing information. It in‑
cludes License Server name, license expiration date, and other information. For more informa‑
tion, see License files.

• Citrix Licensing Manager ‑ The Citrix Licensing Manager is a web‑based management console
for Citrix Licensing. For more information, see Citrix Licensing Manager.

• Licensing Services ‑ The Citrix Licensing service is the Windows service responsible for the fol‑
lowing core licensing functionality:

– Citrix Web Services for Licensing
– Citrix Licensing Support Service
– Citrix Licensing WMI
– CITRIX vendor daemon

For more information, see Licensing services.

• Product‑side settings in your Citrix products that are associated with the License Server.

For more information about licensing components, see Citrix licensing technical overview.

Citrix licensing: User workflow

The following image describes the Citrix licensing workflow.
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Key

*‑ Before downloading and installing the License Server, an existing user logs on to citrix.com, while
a new user creates a citrix.com account.

CC ‑ Citrix Cloud

CLM ‑ Citrix Licensing Manager

LAC ‑ License Access Code

LS ‑ License Server

LUI ‑ License Usage Insights

What’s new

June 28, 2024
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What’s new in the License Server version 11.17.2 build 48000

Release date: June 27, 2024

Apache version update

Apache 2.4.59

libJWT version update

libJWT 1.17.1

zlib version update

zlib‑1.3.1

Enhancements to Citrix Licensing telemetry data collection

Starting with the 11.17.2 build 48000 version, Citrix Licensing telemetry data collection program now
supports de‑identificationof user identifiers. The telemetry data nowde‑identifies the following iden‑
tifiers before uploading them to Citrix:

• Users ID
• Device Name
• Fully Qualified Domain Name (FQDN)

Byanonymizing thesedetails, Citrix ensures that sensitive information remains confidential. Formore
information, see Citrix Licensing Telemetry.

What’s new in the License Server version 11.17.2 build 47000

Release date: April 15, 2024

This release includes bug fixes that improves user experience.

What’s new in the License Server version 11.17.2 build 46000

Release date: February 19, 2024

This release addresses an issue that helps to improve overall stability.
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What’s new in the License Server version 11.17.2 build 45000

Release date: December 07, 2023

OpenSSL version update

OpenSSL 1.1.1w

Apache version update

Apache 2.4.58

Libxml2 version update

zlib‑ 1.3

Enhancements to the Licensing data collection programs

The contents of Citrix Licensing Compliance for various Licensing data collection programs are up‑
dated. For more information, see Citrix Licensing data collection programs and Usage and Statis‑
tics.

Enhancements to themanual upload procedure for licensing telemetry data program

Startingwith the License Server 11.17.2 build 45000, Administratorswho opt tomanually upload data
to Citrix have to upload both License Server and Citrix Virtual Apps and Desktops data elements. For
more information about the manual upload procedure, see Citrix Licensing Telemetry.

What’s new in the License Server version 11.17.2 build 44000

Release date: July 26, 2023

OpenSSL version update

OpenSSL 1.1.1u
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What’s new in the License Server version 11.17.2 build 43000

Release date: May 22, 2023

Moment.js version update

Moment.js 2.29.4

Apache version update

Apache 2.4.57

OpenSSL version update

OpenSSL 1.1.1t

jQuery version update

jQuery 3.5.1

Configure a proxy server within Citrix Licensing Manager

Starting with the License Server version 11.17.2 build 43000, you can view and configure proxy server
settings from the Citrix Licensing Manager UI. Go to Settings > Server Configuration > Configure a
ProxyServer to view your proxy server settings. You can edit these settings to add,modify, or remove
a proxy server as needed. For more information, see Configure a proxy server within Citrix Licensing
Manager.

Alert for licenses with a future start date

An alertmessage appearswhen youupload a license file that contains licenseswith a future start date.
The message states that your licenses won’t be visible in the License Server inventory until the start
date. This alert is displayed in the Citrix Licensing Manager > Install Licenses tab.

When there are multiple licenses with a future start date, the following message appears:
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When there is a single license with a future start date, the following message appears:

Addition of Product Information tab

In this release of Citrix Licensing Manager, a new section about product information is added. This
section provides information about License Server updates such as:

• the latest version of License Server available for download
• the most recent updates
• the last successful attempt for updates
• updates to open‑source software such as OpenSSL and Apache versions for a particular release

Note:

The License Server Updates section requires internet access to view the latest product informa‑
tion. For more information, see the Product information page.

What’s new in the License Server version 11.17.2 build 42000

Release date: February 01, 2023

This release addresses an issue that helps to improve overall stability.

What’s new in the License Server version 11.17.2 build 41000

Release date: December 22, 2022

Collect device IDs along with a timestamp

Starting with this release, device IDs along with the timestamp of the systems that use the Citrix Con‑
current license are collected as part of the Citrix Licensing Telemetry data.

What’s new in the License Server version 11.17.2 build 40000

Release date: October 19, 2022
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Enhancement to data collection programs

Starting with this release, the requirements and contents of the Citrix Licensing Compliance are up‑
dated. In addition, the selection of the Citrix Licensing Customer Experience Improvement Program
(CEIP) and Citrix Licensing Call Home are also updated. For more information about these changes,
see Citrix Licensing data collection programs.

Apache version update

Apache/2.4.54

OpenSSL version update

OpenSSL 1.1.1q

jQuery UI version update

jQuery UI 1.13.2

What’s new in the License Server version 11.17.2 build 39000

Release date: May 11, 2022

Apache version update

Apache/2.4.53

OpenSSL version update

OpenSSL 1.1.1n

Libxml2 version update

zlib‑ 1.2.12

What’s new in the License Server version 11.17.2 build 37000

Release date: December 13, 2021
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Option to send your License Server event data to Citrix Cloud

After you register your License Server with Citrix Cloud, you can choose to send your License Server’s
event data to Citrix. This option is enabled by default and is available only after registration. Formore
information, see Collect License Server event data under the Usage and Statistics section.

Awhat’s newmodal window

From this release onwards, when you launch your Citrix Licensing Manager, amodal window appears
that provides information about:

• Features that are newly available
• Features that are already available, but currently disabled on your Citrix Licensing Manager
• Network‑related issues and recommended steps to mitigate them

For more information, see A what’s newmodal window.

Apache version update

Apache version 2.4.51.

What’s new in the License Server version 11.17.2 build 36000

Release date: September 16, 2021

Support for 4096 key size in self‑signed certificates

From this release onwards, the key size supported in self‑signed certificates is 4096 only. Uninstall the
existing License Server and install the upgraded version (11.17.2.0 build 36000) which contains the
4096 key length self‑signed certificate. To create your own self‑signed certificate, see Get started.

OpenSSL version upgrade

OpenSSL version: 1.1.1k

Apache version update

Apache version 2.4.48.
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What’s new in the License Server version 11.17.2 build 35000

Release date: June 16, 2021

Windows Server 2022 support

The Citrix components and technologies in this release that support Windows Server platforms now
also support Windows Server 2022, unless otherwise noted. For more information, see Windows
Server 2022 support.

A support bundle to troubleshoot License Server issues

A support bundle (.zip file) contains information that is used to troubleshoot and debug license server
issues by Citrix Support team. You can use this file to initiate a Citrix support call or to provide docu‑
mentation to Citrix or its agents for license compliance purposes. For more information, see Support
Bundle.

OpenSSL version upgrade

OpenSSL version: 1.1.1i

What’s new in the License Server 11.16.6 build 34000

Release date: March 17, 2021

Lmadmin.exe transitioned to Lmgrd.exe

In this release, the Citrix License Server’s existing user management lmadmin.exe is transitioned to
Citrix ownedusermanagement lmgrd.exe for improved security and less thirdparty dependencies.

OpenSSL version upgrade

OpenSSL version: 1.1.1h

Libxml2 version upgrade

libxml2 version: 2.9.10
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Fixed issues

June 19, 2024

Fixed issues in License Server version 11.17.2 build 48000

There are no fixed issues in this build.

Fixed issues in License Server version 11.17.2 build 47000

There are no fixed issues in this build.

Fixed issues in License Server version 11.17.2 build 46000

There are no fixed issues in this build.

Fixed issues in License Server version 11.17.2 build 45000

There are no fixed issues in this build.

Fixed issues in License Server version 11.17.2 build 44000

• In License Server version 11.17.2 build 40000, 41000, or 43000, youmight see the application er‑
ror message for the CognizanceCoreModule.exe process in the Windows event log. [LIC‑
5553]

• When you install a license with a future start date, you might notice the inventory data that
displayed in the Citrix Licensing Manager is incorrect. For example, the number of licenses that
displayed in the Citrix Licensing Manager can be incorrect. [LIC‑5565]

Fixed issues in License Server version 11.17.2 build 43000

There are no fixed issues in this build.
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Fixed issues in License Server version 11.17.2 build 42000

In License Server version 11.17.2 build 40000 or in 11.17.2 build 41000, you might see the applica‑
tion error message for the CognizanceCoreModule.exe process in the Windows event log. [LIC‑
5153]

Fixed issues in License Server version 11.17.2 build 41000

There are no fixed issues in this build.

Fixed issues in License Server version 11.17.2 build 40000

There are no fixed issues in this build.

Fixed issues in License Server version 11.17.2 build 39000

• After upgrading the License Server to version 11.17.2 build 36000, the Citrix licensing service
fails to start in the clustered License Servers. It is recommended not to upgrade your License
Server to version 11.17.2 build 36000 in a clustered setup. [LIC‑4615]

Fixed issues in License Server version 11.17.2 build 37000

There are no fixed issues in this build.

Fixed issues in License Server version 11.17.2 build 36000

• When registering your License Server with Citrix Cloud, the Citrix Licensing Manager UI might
become unresponsive and display a spinningwheel. To avoid this issue, before registering your
License Server with Citrix Cloud, ensure that you have the Digicert Global Root CA certificates
installed in the system. These certificates are updated in the Windows update. If they’re not
installed, download them manually and install the certificates before starting the Citrix Cloud
registration. Also, ensure you verify firewall settings. For more information, see the Important
note under Register and remove registration with Citrix Cloud. [LIC‑1510]

Fixed issues in License Server version 11.17.2 build 35000

• User/device license fails to check out with a space in the user name and displays the following
error message:
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Error: checkoutOutBatch failed: Error_UNEXPECTED_DATA: Unexpected
server response 'UD: ERROR_SYNTAX'.[LIC‑3506]

• The overdraft count displayed in the Citrix Licensing Manager is incorrect. In a license file
withmultiple incremental lines for the sameProduct_Edition_Model, theoverdraft count
that displayed in theCitrix LicensingManager is incorrect. Insteadof adding the overdraft count
fromall the incremental lines, it adds only the first incremental line in the license file. [LIC‑3651]

Fixed issues in License Server build 34000

• In theCitrix LicensingManager >Settings >Account >User Administration section, theUser‑
name/Group name in the Japanese language or double‑byte characters appear garbled. The
registered double‑byte User/Group names cannot log on to the Citrix Licensing Manager. [LIC‑
2032]

Known issues

June 19, 2024

Known issues in License Server version 11.17.2 build 48000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 47000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 46000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 45000

• In the Citrix Licensing installationwizard for theGerman version, theUI textSpeicherort is trun‑
cated. For the French version, the text Emplacement is truncated. This issue does not impact
the intended action. [LIC‑5994]

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 14
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• When uninstalling the License Server with the Windows Installer file (*.msi), you might
notice an incomplete cleanup of certain folders in C:\Program Files (x86)\Citrix
\Licensing. As a solution, backup the files in C:\Program Files (x86)\Citrix\
Licensing\MyFiles andmanually delete the remaining folders. [LIC‑6010]

• When using the Citrix Licensing Manager to generate the support bundle, you might not be
able to generate it if the size of the licensing directory is too large. This issue mostly happens
with users reporting telemetry data with Citrix by manual upload procedure. As a workaround,
manually upload the License Server and Citrix products data elements that are stored
in c:\Program Files (x86)\Citrix\Licensing\LS\resource\usage and
c:\Program Files (x86)\Citrix\Licensing\LS\resource\cis bundles\
ul_usage with Citrix and then delete these files. For more information about the manual
upload procedure, see Citrix Licensing Telemetry. After deleting these files, attempt to generate
and download the support bundle again. [LIC‑6014]

Known issues in License Server version 11.17.2 build 44000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 43000

• When you install a license with a future start date, youmight notice the inventory data that dis‑
played in the Citrix LicensingManager is incorrect. For example, the number of licenses that dis‑
played in the Citrix LicensingManager can be incorrect. This issue is due to the display problem
in theCitrix LicensingManager anddoesn’t impact licenses installedor in‑use. As aworkaround,
use the lmstat command to view the complete License Server inventory. [LIC‑5565]

Known issues in License Server version 11.17.2 build 42000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 41000

Youmight see the application errormessage for theCognizanceCoreModule.exe process in the
Windows event log. However, this error doesn’t impact the functionality of the License Server. [LIC‑
5153]
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Known issues in License Server version 11.17.2 build 40000

Youmight see the application errormessage for theCognizanceCoreModule.exe process in the
Windows event log. However, this error doesn’t impact the functionality of the License Server. [LIC‑
5153]

Known issues in License Server version 11.17.2 build 39000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 37000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 36000

There are no known issues in this release.

Known issues in License Server version 11.17.2 build 35000

There are no known issues in this release.

Known issues in License Server build 34000

• In a cross‑domain environment, the Citrix Licensing Manager and POSH cmdlet support only
two‑way trust to add a user.

With the external trust(one‑way trust), the Citrix Licensing Manager, and the POSH cmdlet displays
the following error message Active Directory account resolution failed.

Werecommendthatyou run theCtxManageUserAndGroup.exe fromthe ‘Citrix\Licensing\LS\resource’
location with the following parameters:
‑ Command to add a user: CtxManageUserAndGroup.exe –useradd “domain\username”
-Role “admin/user”

‑ Command to addagroup: CtxManageUserAndGroup.exe –useradd “domain\username
” –Role “adminGroup/userGroup

For example, if domain1hasanoutgoing trust todomain2, thenauser fromdomain2canauthenticate
in domain1. Then, add a user to License Server using the executable only. [LIC‑3268]

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 16
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License file issues

• The License Server ignores license files that have multiple lines referencing HOSTNAME=. Li‑
censes in these files cannot be checked out. This issue is caused when you download licenses
associated to different License Server host names in to the same license file.

To resolve this issue, download again separate license files for each Citrix product tied to differ‑
ent License Server names.

• Licenses with expiry date incorrectly formatted as D-MMM-YYYY appear as permanent in Stu‑
dio. Use the Citrix Licensing Manager to display the correct license expiration dates. [LIC‑2556]

Third party notices

June 19, 2024

Citrix Licensing 11.17.2 includes thirdparty software licensedunder the termsdefined in the following
documents:

• Non‑Commercial Software Disclosures For FlexNet Publisher 2020 (11.17.2) (PDF download)

• FlexNet Publisher Documentation Supplement Open Source Software Licenses applicable to
FlexNet Publisher 11.17.2 (PDF download)

Open source software version

License Server version 11.17.2 build 48000 includes the following versions of open source software:

• Apache 2.4.59
• jQuery 3.5.1
• jQuery UI 1.13.2
• libjwt 1.17.1
• libapr 1 1.6.5
• libiconv 1.16.0
• libxml2 2.10.4
• OpenSSL 1.1.1w
• RapidJson 1.1.0
• SQLite 3.43.1
• Zlib 1.3
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License Server

December 17, 2023

License Servers are computers that are partly or completely dedicated to store and manage licenses.
If you attempt to connect to a device the Citrix product requests licenses from a License Server. Every
Citrix product environment must have at least one shared or dedicated License Server. Servers run‑
ning Citrix products contact the License Server to obtain licenses.

If youconnect toaCitrixproduct, it draws licenses fromtheLicenseServer. TheCitrixproduct requests
to check out a license from the License Server on behalf of the user or client device. When the license
is checked out, you can access a product’s features and functionality based on the license type and
edition.

Note:

Citrix ADC and Citrix Gateway do not obtain licenses from the Citrix License Server. For more
information about the product‑specific licensing, see Product‑specific licensing information.

The following image shows the Citrix products, License Server, Citrix LicensingManager, and consoles
workflow:

• 1‑User devices connect to a Citrix product.
• 2‑Citrix products request to check out licenses from the License Server for the user or client
devices.

• 3‑Citrix Licensing Manager is an administrative web interface used to manage the License
Server.

• 4‑Consoles (such as Studio andDirector) can connect to a License Server tomonitor license use,
see alerts and other licensing configuration.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 18
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Depending on the size and configuration of your product deployment, youmight deploy licensing on
a server shared with other applications, a dedicated License Server, or multiple License Servers. For
more information, see License optimization.

License files must be on the License Server that is associated with the product you’re licensing. The
product must be configured to communicate with that specific License Server. The Citrix Licensing
Manager lets youmanage andmonitor your Citrix licenses by providing a user interface to the License
Server. You can view licenses and alerts, import license files, create historical usage reports, andman‑
age License Server settings.

Related links

• Technical overview
• Licensing elements
• License types
• Getting started
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Licensing elements

October 7, 2023

The License Server comprises several licensing elements:

• Citrix vendor daemon
• Options configuration file
• License request process
• Citrix Licensing data collection programs

The following diagram shows how Citrix products connect to the License Server.

Citrix vendor daemon

The Citrix vendor daemon (CITRIX), a process that runs on the License Server, grants licenses. The
Citrix vendor daemon tracks thenumber of licenses that are checkedout andwhichproduct has them.
Citrix products communicatewith theCitrix vendor daemonusingTCP/IP. Bydefault, theCitrix vendor
daemon uses TCP/IP port 7279.
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Options file

The options file (Citrix.opt) is a License Server configuration file. The Citrix vendor daemon reads this
file every time it restarts or receives a command to reread the file. This configuration file defines li‑
censing behavior‑the number of licenses a product server can use, the location of the System Logs,
logging levels, and other user‑defined customizations. The Customer Experience Improvement Pro‑
gram (CEIP) and Call Home configurations are stored in this file.

License request process

When a product requests a license from the License Server, the Citrix vendor daemon determines
whether a license is available for the request.

The license request process has two phases: the product startup phase and the user connection
phase.

Product Start‑Up Phase:

• When a Citrix product starts, it retrieves the License Server location from its data store.
• The product connects to the Citrix vendor daemon.
• The product checks out a startup license.

User connection phase:

• A user connects to a computer running the Citrix product.
• The product requests a license from the License Server.
• The Citrix vendor daemon checks to see if any licenses are available and grants or denies the
product’s request.

• The licensemodule in theproduct grants or denies theuseof theproductbasedon the response
from the Citrix vendor daemon.

Citrix Licensing data collection programs

June 18, 2024

The following data collection programs are designed to improve your product experience, drive adop‑
tion, and gather basic licensing information:

• Citrix Licensing Call Home ‑ This program is optional.
• Citrix Licensing Customer Experience Improvement Program (CEIP) ‑ This program is optional.
• Citrix License Server Events –This program is optional.
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• Citrix Licensing Telemetry ‑ This program is required.
• NetScaler telemetry program ‑ This program is required.

– For Netscaler Console service
– For Netscaler Console on‑prem

Citrix handles your data in accordance with the terms of your contract with Citrix, and protects it as
specified in the Services Security Exhibit available on the Citrix Trust Center.

For information about configuring a proxy server, see Configure a proxy server manually in the Get
started article.

For information about command‑line installation, see Use the Windows command line to install li‑
censing.

Citrix Licensing Call Home

Call Home program improves your experience, helps you understand your product usage over time
and drive adoption and improves Citrix products. This program shares system configuration, product
configuration and usage data including user or device data with Citrix.

This information is transmitted to Citrix once a day, based on the service start time. This program is
optional.

Important

The Citrix Service Provider program requires Call Home. When the License Server detects Citrix
Service Provider licenses, it enforces daily uploads.

If you want to register your License Server with Citrix Cloud or remove your registration, see Register
and remove registration with Citrix Cloud in Usage and statistics.

You can change your participation in the programs at any time by using the Citrix Licensing Manager.
For more information, see “Share usage statistics”under Usage and statistics.

Data collected Description What we use it for

License usage data Information about the Citrix
licenses installed on the
License Server, including
product ID, license type,
quantity, user, and device data,
in addition to license usage
information.

We use this data to drive
adoption and helps you to
understand your license usage
over time.
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Data collected Description What we use it for

License Server deployment and
configuration data

Information about the License
Server and how it was
deployed, including License
Server version, operating
system version, and
configuration states.

We use this data to inform
further development of Citrix
products and to improve the
customer experience.

For the list of Call Home data elements, see Citrix Licensing Call Home data elements.

Citrix Licensing Customer Experience Improvement Program

CEIP does a periodic collection of system and product configuration and non‑identifiable usage data.
Providing this data helps Citrix to improve customer experience. This information is transmitted to
Citrix once a day, based on the service start time. This program is optional.

You can change your participation in the programs at any time by using the Citrix Licensing Manager.
For more information, see “Share usage statistics”under Usage and statistics.

Data collected Description What we use it for

License usage data Information about the Citrix
licenses installed on the
License Server, including
product ID, license type, and
quantity, in addition to license
usage information.

We use this data to track how
licenses are consumed and
track customer population.

License Server deployment and
configuration data

Information about the License
Server and how it was
deployed, including License
Server version, operating
system version, and
configuration states.

We use this data to inform
further development of Citrix
products and to improve the
customer experience.

For the list of CEIP data elements, see Citrix Licensing CEIP data elements.
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Citrix License Server Event data

The following table displays data that is collected from the License Server and used for the follow‑
ing:

• Display information in customer facing dashboards
• Provide alerts and notifications about license expiry, license renewals, and supplemental grace
period.

This functionality is available only when the License Server is registered with the Citrix Cloud.

Data collected Description What we use it for

License usage data Information about the Citrix
licenses installed on the
License Server, including
product ID, license type, and
quantity, in addition to license
usage information.

We use this data to enable
alerts and notification about
license expiry, license renewals,
etc.

License Server system
information

Information about the License
Server(such as Hardware ID).

We use this data to identify the
License Server in the customer’
s environment.

For informationonhowtoenableordisable this functionality, see theShareusage statistics section.

For the list of license server event data elements, see Citrix License Server Event data elements

Citrix Licensing Telemetry

Citrix Licensing Telemetry is a mandatory data collection program. The automatic upload of data is
enabled when the License Server is installed.

The Citrix License Server collects and reports limited license telemetry to Citrix for on‑premises product
licenses to support license compliance. For those licenses, Citrix requires that you transition to themost
recent License Server version within 6 months of release of each new version. License Server license col‑
lectionand reporting (electronic ormanual)must beactive for LicenseServer Version11.17.2Build 40000
and beyond. Unless you have electedmanual reporting, you agree to adjust your firewalls as necessary
toallowelectronic license reporting. Should youhavequestions or concerns, contact CustomerCare. Cit‑
rix may suspend or terminate your Citrix Support for non‑compliance with these requirements without
liability in addition to any other remedies Citrix may have at law or equity. These requirements do not
apply to the extent prohibited by law or regulation. See our License Telemetry FAQ for more details.
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Important:

To remain compliant, the number of days since the last successful upload must not be greater
than 90 days.

Prerequisites to successfully upload telemetry data:

Outbound to https://cis.citrix.com/ from the License Server. If not available, create required firewall
rule or configure a proxy.

Data Collected Description What we use it for

License usage data Information about the Citrix
licenses installed on the
License Server, including
product ID, license type, and
quantity, user, and device data,
in addition to license usage
information.

We use this data for our
legitimate interests, including
license compliance.

License Server system
information

Information about the License
Server (such as Hardware ID)

We use this data to identify the
License Server in the customer’
s environment.

For the list of Licensing Telemetry data elements, see Citrix Licensing Telemetry data elements.

Reporting options

The License Management Service uses product telemetry, built into the License Server, to electroni‑
cally send data to Citrix periodically.

The first upload occurs approximately five minutes after the License Server first starts or restarts and
the next uploads occur once a day thereafter. The schedule resets if you reinstall the License Server.
If an upload fails, another attempt is made in 24 hours until either the upload succeeds or the License
Management Service is disabled.

You can opt for manually reporting this data by disabling the License Management Service. For more
information on how to disable the LicenseManagement Service, see Use the command line to enable
or disable the License Management Service.

The files required to report with Citrix are kept on the License Server locally to enable the manual
upload. Youmustuse theCitrix Insight Services toupload this data. For informationabout themanual
upload procedure using the Citrix Insight Services, see the Knowledge Center article ‑ CTX472950.
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Note

In the Citrix Insight Services, themaximum file size that a user can upload is limited. Formore in‑
formation about the file uploading requirements, see the Knowledge Center article ‑ CTX131233.

Startingwith the 11.17.2 build 45000, userswhoopt tomanually report datawithCitrix have toupload
both License Server and Citrix Virtual Apps and Desktops data elements. The Licensing server data
elements are bundled in upload_compliance*.zip files. The Citrix Virtual Apps and Desktops
data elements are bundled in upload_usage_*.zip files.

You can locate the upload_compliance*.zip files at c:\Program Files (x86)\Citrix
\Licensing\LS\resource\usage. You can save all the upload_compliance*.zip files
into a single zip file and then send this .zip file to Citrix by using the Citrix Insight Services.

You can locate the upload_usage_*.zip files at c:\Program Files (x86)\Citrix\
Licensing\LS\resource\cis bundles\ul_usage. You can save all theupload_usage_
*.zip files into a single zip file and then send this .zip file to Citrix by using the Citrix Insight
Services.

After theupload is successful, you candelete allupload_*.zip files fromtheLicenseServer. Failure
to delete the .zip files might result in the License Server running out of disk space.

To check the status of your latest upload (whether manual or automatic), you can evaluate the
contents of the text file at C:\Program Files (x86)\Citrix\Licensing\LS\resource
\cache\upload_compliance_result.xml. This file provides detailed informationon the last
compliance upload including whether it was successful or failed and the reasons for any failures.

Sample data:

Success:

1 <CtxUploaderResult><Code>CTX_UPLOADER_SUCCESS</Code><Msg></Msg><t
>1679283497</t><UploadType>CTX_UPLOAD_TYPE_COMPLIANCE</UploadType></
CtxUploaderResult>

2 <!--NeedCopy-->

Failure:

1 <CtxUploaderResult><Code>CTX_UPLOADER_ERROR_NETWORK_OPEN</Code><Msg>
SocketOpen(cis.citrix.com:443) exception: {

2 GetAddrInfoW(cis.citrix.com) failed: WSAHOST_NOT_FOUND : code 0
x00002af9: No such host is known.

3 }
4 </Msg><Arg>cis.citrix.com:443</Arg><t>1679283245</t><UploadType>

CTX_UPLOAD_TYPE_COMPLIANCE</UploadType></CtxUploaderResult>
5 <!--NeedCopy-->
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Citrix Licensing Call Home data elements

November 15, 2023

Metadata fields

Field Description Example

ClientTool This field isn’t in use. Not applicable

UploadUser This field isn’t in use. Not applicable

UTCDate Report generation time in UTC
format.

2022‑10‑10T06:11:14Z

Date Report generation time in local
time format.

10/10/2022 02:11:14

Product Name of the upload. LicenseServerDiagnostic

ProductVersion The version of the upload. 2.0

ProductUTCDeployDate Denotes the time when the
License Server is installed.

2022‑08‑16T00:00:00Z

SiteID This field isn’t in use. Not applicable

SiteName This field isn’t in use. Not applicable

Component This field isn’t in use. Not applicable

License Server feature usage data

Field Description Example

prod Product reporting V6.Licensing

DateSampleStartUTC Start time of the sample being
collected.

1970‑01‑01T00:00:00Z
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Field Description Example

DateSampleStopUTC Latest sample time of license
usage which ideally is the same
as when the report was
generated. The sample start
isn’t specified because that
varies between license types
and therefore isn’t a global
property.

1970‑01‑01T00:00:00Z

CLM-WSLUsage Count for individual API calls
within Citrix Licensing Manager
interface for Citrix Web Services
for Licensing service.

10

POSH-WSLUsage Count for individual API calls
within PowerShell interface for
Citrix Web Services for
Licensing service.

2

type Type of data. V6.WSLUsage

ver Version of the data. 1.0

LSVersion The version of the License
Server.

11.17.2.0 build 40000

License Server and License Usage information

Field Description Example

License Server Information

Feature

GUID A unique identifier created
during install and preserved
during upgrades. This field is
used to identify which uploads
are from the same server.

a5ae17c9‑8a4a‑4318‑938f‑
a8c6da2aa2ef
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Field Description Example

DateSampleStopUTC This field is the latest sample
time of license usage which
ideally is the same as when the
report was generated. The
sample start is not specified
because that varies between
license types and therefore isn’
t a global property.

2019‑11‑09T00:57:14Z

DateSampleStop The latest sample time of
license usage which ideally is
the same as when the report
was generated. License Server
local time.

11/8/2019 19:57

PortLACHTTP HTTP port that the License
Administration Console is
configured for.

0

PortLACHTTPS HTTPS port that the License
Administration Console is
configured for (0 for builds with
Citrix Licensing Manager only).

8082

PortLACRedirect Administration Console HTTP
to HTTPS port. The value can
be either true or false. You can
set the value to false only for
builds with the Citrix Licensing
Manager.

PortLS Citrix Licensing Service
(lmgrd.exe) port configuration.

27000

PortVD CITRIX vendor daemon
(CITRIX.exe) port configuration.

7279

CustomerID The Customer ID received
during the registration.

citrix780933

OrgID The organization ID received
during the registration.

int1d91480f

PortWSL Citrix Web Services for
Licensing port configuration.

8083
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Field Description Example

UDUseDomain If the value is 1, don’t strip the
domain from the users name.
(user@domain.com). If the
value is 0, strip the domain
from the users name.

1

OptFileNoLogStatus If the value is 0, log both
checkins and checkouts. If the
value is 0x1 bit set, checkins are
not logged (no log in). If the
value is 0x2 bit set, checkouts
aren’t logged (no log out).

3

OptFileComplianceConfig This value can be “enabled”or
“disabled”.

enabled

UDUserNameCase The License Server
configuration that denotes how
the UserID case‑folding is set
for User/Device licensing. The
values are: 0=nochange;
1=tolower; 2=toupper.

1

UDDeviceNameCase The License Server
configuration that denotes how
the DeviceID case‑folding is set
for User/Device licensing. The
values are: 0=nochange;
1=tolower; 2=toupper

1

SARenewalCheckOption The values can be “Install”,
“Notify”, or “Manual”.

Notify

EncoreSamplingPeriod License usage sampling period
in minutes.

15

EncoreRetentionTime Historical use data retention in
days.

180

EncoreEnabled The option is either true or
false.

TRUE
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Field Description Example

SLSProxy The proxy chosen from various
sources in the order of priority.
(1) WinAutoURL using
“citrix.com”. (2) WinIE =
Internet Explorer settings
which require the licensing
service to run under a user
account rather than local
service. (3) WinDefault = The
old method that relies on a
setting in the windows registry.
(4) SimpleLicenseServiceCon‑
fig.xml. If the upload is
anonymous, this parameter
value is either “1”or “0”. If
diagnostic (not anonymous),
this parameter is the proxy
server string and port, or
empty.

0

SLSProxyWinAutoURL If the upload is anonymous,
this value is either “1”or “0”. If
diagnostic (not anonymous),
this value is the proxy server
string and port, or empty.

0

SLSProxyWinIE If the upload is anonymous,
this field value is either “1”or
“0”. If diagnostic (not
anonymous), this value is the
proxy server string and port, or
empty.

0

SLSProxyWinDefault If the upload is anonymous,
this field value is either “1”or
“0”. If diagnostic (not
anonymous), this value is the
proxy server string and port, or
empty.
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Field Description Example

SLSProxySlsConfig If the upload is anonymous,
this field value is either “1”or
“0”. If diagnostic (not
anonymous), this value is the
proxy server string and port, or
empty.

OS Information about the server
machine and operating system
that the License Server is
installed on.

6.3.9600.17031

WindowsBuildLabEx Information about the server
machine and operating system
that the License Server is
installed on.

9600.17041.x86fre.winblue_gdr.140305‑
1710

WindowsEditionID Information about the server
machine and operating system
that the License Server is
installed on.

Enterprise

WindowsInstallationType Information about the server
machine and operating system
that the License Server is
installed on.

Client

WindowsProductName Information about the server
machine and operating system
that the License Server is
installed on.

Windows 8.1 Enterprise

WindowsDomainMember Information about the server
machine and operating system
that the License Server is
installed on.

N

OSBits Information about the server
machine and operating system
that the License Server is
installed on.

32

OSLocale Information about the server
machine and operating system
that the License Server is
installed on.

en-US
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Field Description Example

VM Information about the server
machine and operating system
that the License Server is
installed on.

Y

VMIDString Information about the server
machine and operating system
that the License Server is
installed on.

Microsoft Hv

VMHVIDString Information about the server
machine and operating system
that the License Server is
installed on.

Hv#1

HardwareId Information about the server
machine and operating system
that the License Server is
installed on.

E824249098A96BF0

FQDN License Server machine and
domain name. This value is
sent to help identify license
Servers in the reporting
experience. Used to pair a
License Server calling home to
a license allocation record in
the back office.

CITRIX‑12T5MRV4

UDUploadEnabled Denotes whether the user or
device upload is enabled or
not.

true or false

PrivacySetting Denotes if the customer has
chosen to scramble PII (user
names and device names). On:
Scrambled and Off:
Unscrambled

Off

InstallUTC This value denotes the time
when the License Server is
installed.

2016‑10‑12T00:00:00Z

ProductVersion The current version of the
License Server.

11.14.0.1 build 18000
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Field Description Example

UpgradeFrom The previous version of the
License Server if the current
install was an upgrade.

SetupCluster Indicates whether a License
Server cluster is set up or not.

0

SGPClockErrorCode Error code indicating why the
License Server entered the
supplemental grace period.

0

SGPMaxDays Maximum days remaining in
the Supplemental Grace
Period.

15

SupplementalGracePeriod Grace Periods that Citrix
provides when you run out of
licenses or the product is
unable to contact the License
Server. This grace period helps
the product continues to
operate.

Feature

FeatureID The tag of the feature.

UDBinFileCreatedUTC User/Device Only –not
applicable for Concurrent
usage

2016‑11‑09T00:55:56Z

UDReportGenerationUTC User/Device Only –not
applicable for Concurrent
usage

2016‑11‑09T00:55:56Z

EventLog User/Device Only –not
applicable for Concurrent
usage

<FirstCreation t=”
timestamp”/>

UDAdminUsersReleased Count of users released by
udadmin.

3

UDAdminDevicesReleased Count of devices released by
udadmin.

3

SADate

DateSampleStartUTC Start time of the sample being
collected.

2016‑11‑08T01:08:13Z
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Field Description Example

DateSampleStopUTC End time of the sample being
collected.

2016‑11‑09T00:55:56Z

CountUsedMax Themaximum number of
licenses used.

3

Active If the value is ‘1’, it’s in the
current inventory. If the value
is ‘0’, it appears only in
historical records and is no
longer part of the current
inventory either because it is
removed or expired.

1

Licensees

CountInstalled The number of licenses
installed.

1203

Pool For examples, see Pool in the
following section.

CountTotal The total number of licenses in
use at the time the sample was
taken. Total number is the sum
of users and devices.

3

Users Specific users where a user
license is assigned,
contributing to the total count.

Scrambled:
1EC4ED037766AA18,
Unscrambled:
user@domain.com or user

Devices Specific devices where a device
license is assigned contributing
to the total count.

Scrambled:
C648FE671A44B3F7
Unscrambled: C39A925064A3

UsageSamples For examples, see Sample in
the following section.

Pool

Serial Serial number for the license
entitlements in the pool.

OR10:13

DateExpiration Most recent expiration date
that impacts the license count
in the pool.

1‑Dec‑20
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Field Description Example

DateIssued The date that the license file
was issued. The date issued of
the license file that expires first.

1‑Dec‑03

VendorStr Representation of licensing
information that informs
products of what edition and
mode that they must operate
in.

<![CDATA[;LT=Retail;
GP=2;PSL=10;CL=ENT,
ADV,STD,AST;SA=1;ODP
=0]]>

CountInstalled Number of licenses installed
among the pools for a given
feature.

100

CountOverdraft Number of licenses used above
the installed quantity.

0

Sample

Timestamp Timestamp of the sample
collection.

2016‑11‑09T00:55:56Z

CountInUse Number of licenses in use at
the specific time stamp.

3

OverDraft Number of licenses used above
the installed quantity.

0

Installed Number of licenses installed at
the specific time stamp.

100

StartupCounts

LPE ID Information provided to the
License Policy Engine ‑
Interface to the License Server.

<ID><![CDATA[
XDT_PLT_2020
.1201]]></ID>

SerialNumbers

Serial The unique identifier in Citrix
back office and license files for
a given license allocation and
files downloaded for that
allocation.
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Field Description Example

ID The feature code ID that
represents a specific product
entitlements (edition and
license mode). Such as: Citrix
Virtual Apps –Premium –User
Device

XDT_PLT_UD

SADate Subscription Advantage Date.
This date represents the
termination date of the CSS
entitlement.

2020.1201

SN Serial number for the license
entitlements in the pool.

OR10:13

Citrix Licensing CEIP data elements

November 15, 2023

Metadata fields

Field Description Example

ClientTool This field isn’t in use. Not applicable

UploadUser This field isn’t in use. Not applicable

UTCDate Report generation time in UTC
format.

2022‑10‑10T06:11:14Z

Date Report generation time in local
time format.

10/10/2022 02:11:14

Product Name of the upload. LicenseServerAnonymous

ProductVersion The version of the upload. 2.0

ProductUTCDeployDate Denotes the time when the
License Server is installed.

2022‑08‑16T00:00:00Z

SiteID This field isn’t in use. Not applicable

SiteName This field isn’t in use. Not applicable
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Field Description Example

Component This field isn’t in use. Not applicable

License Server feature usage data

Field Description Example

prod Product reporting V6.Licensing

DateSampleStartUTC Start time of the sample being
collected.

1970‑01‑01T00:00:00Z

DateSampleStopUTC Latest sample time of license
usage which ideally is the same
as when the report was
generated. The sample start
isn’t specified because that
varies between license types
and therefore isn’t a global
property.

1970‑01‑01T00:00:00Z

CLM-WSLUsage Count for individual API calls
within Citrix Licensing Manager
interface for Citrix Web Services
for Licensing service.

10

POSH-WSLUsage Count for individual API calls
within PowerShell interface for
Citrix Web Services for
Licensing service.

2

type Type of data. V6.WSLUsage

ver Version of the data. 1.0

LSVersion The version of the License
Server.

11.17.2.0 build 40000

License Server and License Usage information
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Field Description Example

License Server Information

Feature

GUID An anonymous identifier
created during install and
preserved during upgrades.
This field is used to identify
which uploads are from the
same server.

a5ae17c9‑8a4a‑4318‑938f‑
a8c6da2aa2ef

DateSampleStopUTC This field is the latest sample
time of license usage which
ideally is the same as when the
report was generated. The
sample start is not specified
because that varies between
license types and therefore isn’
t a global property.

2019‑11‑09T00:57:14Z

DateSampleStop The latest sample time of
license usage which ideally is
the same as when the report
was generated. License Server
local time.

11/8/2019 19:57

PortLACHTTP HTTP port that the License
Administration Console is
configured for.

0

PortLACHTTPS HTTPS port that the License
Administration Console is
configured for (0 for builds with
Citrix Licensing Manager only).

8082

PortLACRedirect Redirect License
Administration Console HTTP
to HTTPS port. The value can
be either true or false. You can
set the value to false only for
builds with the Citrix Licensing
Manager.

PortLS Citrix Licensing Service
(lmgrd.exe) port configuration.

27000
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Field Description Example

PortVD CITRIX vendor daemon
(CITRIX.exe) port configuration.

7279

PortWSL Citrix Web Services for
Licensing port configuration.

8083

UDUseDomain If the value is 1, don’t strip the
domain from the users name.
(user@domain.com). If the
value is 0, strip the domain
from the users name.

1

OptFileNoLogStatus If the value is 0, log both
checkins and checkouts. If the
value is 0x1 bit set, checkins are
not logged (no log in). If the
value is 0x2 bit set, checkouts
aren’t logged (no log out).

3

OptFileComplianceConfig This value can be “enabled”or
“disabled”.

enabled

UDUserNameCase The License Server
configuration that denotes how
the UserID case‑folding is set
for User/Device licensing. The
values are: 0=nochange;
1=tolower; 2=toupper.

1

UDDeviceNameCase The License Server
configuration that denotes how
the DeviceID case‑folding is set
for User/Device licensing. The
values are: 0=nochange;
1=tolower; 2=toupper

1

SARenewalCheckOption The values can be “Install”,
“Notify”, or “Manual”.

Notify

EncoreSamplingPeriod License usage sampling period
in minutes.

15

EncoreRetentionTime Historical use data retention in
days.

180

EncoreEnabled The option is either true or
false.

TRUE
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Field Description Example

SLSProxy The proxy chosen from various
sources in order of priority. (1)
WinAutoURL using “citrix.com”.
(2) WinIE = Internet Explorer
settings which require the
licensing service to run under a
user account rather than local
service. (3) WinDefault = The
old method that relies on a
setting in the windows registry.
(4) SimpleLicenseServiceCon‑
fig.xml. If the upload is
anonymous, this value is either
“1”or “0”. If diagnostic (not
anonymous), this value is the
proxy server string and port, or
empty.

0

SLSProxyWinAutoURL If the upload is anonymous,
this value is either “1”or “0”. If
diagnostic (not anonymous),
this value is the proxy server
string and port, or empty.

0

SLSProxyWinIE If the upload is anonymous,
this value is either “1”or “0”. If
diagnostic (not anonymous),
this value is the proxy server
string and port, or empty.

0

SLSProxyWinDefault If the upload is anonymous,
this value is either “1”or “0”. If
diagnostic (not anonymous),
this value is the proxy server
string and port, or empty.

0

SLSProxySlsConfig If the upload is anonymous,
this value is either “1”or “0”. If
diagnostic (not anonymous),
this value is the proxy server
string and port, or empty.

0
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Field Description Example

OS Information about the server
machine and operating system
that the License Server is
installed on.

6.3.9600.17031

WindowsBuildLabEx Information about the server
machine and operating system
that the License Server is
installed on.

9600.17041.x86fre.winblue_gdr.140305‑
1710

WindowsEditionID Information about the server
machine and operating system
that the License Server is
installed on.

Enterprise

WindowsInstallationType Information about the server
machine and operating system
that the License Server is
installed on.

Client

WindowsProductName Information about the server
machine and operating system
that the License Server is
installed on.

Windows 8.1 Enterprise

WindowsDomainMember Information about the server
machine and operating system
that the License Server is
installed on.

N

OSBits Information about the server
machine and operating system
that the License Server is
installed on.

32

OSLocale Information about the server
machine and operating system
that the License Server is
installed on.

en-US

VM Information about the server
machine and operating system
that the License Server is
installed on.

Y
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Field Description Example

VMIDString Information about the server
machine and operating system
that the License Server is
installed on.

Microsoft Hv

VMHVIDString Information about the server
machine and operating system
that the License Server is
installed on.

Hv#1

InstallUTC This value denotes the time
when the License Server is
installed.

2016‑10‑12T00:00:00Z

ProductVersion This value is the current version
of the License Server.

11.14.0.1 build 18000

UpgradeFrom The previous version of the
License Server if the current
install was an upgrade.

SetupCluster Indicates whether a License
Server cluster is set up or not.

0

SGPClockErrorCode Error code indicating why the
License Server entered the
supplemental grace period.

0

SGPMaxDays Maximum days remaining in
the Supplemental Grace
Period.

15

SupplementalGracePeriod Grace Periods that Citrix
provides when you run out of
licenses or the product is
unable to contact the License
Server. This grace period helps
the product continues to
operate.

Feature

FeatureID The tag of the feature.

UDBinFileCreatedUTC User/Device Only –not
applicable for Concurrent
usage

2016‑11‑09T00:55:56Z
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Field Description Example

UDReportGenerationUTC User/Device Only –not
applicable for Concurrent
usage

2016‑11‑09T00:55:56Z

EventLog User/Device Only –not
applicable for Concurrent
usage

<FirstCreation t=”
timestamp”/>

UDAdminUsersReleased Count of users released by
udadmin.

3

UDAdminDevicesReleased Count of devices released by
udadmin.

3

SADate

DateSampleStartUTC Start time of the sample being
collected.

2016‑11‑08T01:08:13Z

DateSampleStopUTC End time of the sample being
collected.

2016‑11‑09T00:55:56Z

CountUsedMax Themaximum number of
licenses used.

3

Active If the value is ‘1’, it’s in the
current inventory. If the value
is ‘0’, it appears only in
historical records and is no
longer part of the current
inventory either because it is
removed or expired.

1

UsageSamples For examples, see Sample in
the following section.

DateExpiration Most recent expiration date
that impacts the license count
in the pool.

1‑Dec‑20

DateIssued The date that the license file
was issued. The date issued of
the license file that expires first.

1‑Dec‑03

VendorStr Representation of licensing
information that informs
products of what edition and
mode that they must operate
in.

<![CDATA[;LT=Retail;
GP=2;PSL=10;CL=ENT,
ADV,STD,AST;SA=1;ODP
=0]]>
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Field Description Example

CountInstalled Number of licenses installed
among the pools for a given
feature.

100

CountOverdraft Number of licenses used above
the installed quantity.

0

Sample

Timestamp Timestamp of the sample
collection.

2016‑11‑09T00:55:56Z

CountInUse Number of licenses in use at
this specific time stamp.

3

OverDraft Number of licenses used above
the installed quantity.

0

Installed Number of licenses installed at
this specific time stamp.

100

Users Specific users where a user
license is assigned,
contributing to the total count.

Scrambled:
1EC4ED037766AA18,
Unscrambled:
user@domain.com or user

StartupCounts

LPE ID Information provided to the
License Policy Engine ‑
Interface to the License Server.

<ID><![CDATA[
XDT_PLT_2020
.1201]]></ID>

SerialNumbers

Serial The unique identifier in Citrix
back office and license files for
a given license allocation and
files downloaded for that
allocation.

ID The feature code ID that
represents a specific product
entitlements (edition and
license mode). Such as, Citrix
Virtual Apps –Premium –User
Device

XDT_PLT_UD
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Field Description Example

SADate Subscription Advantage Date.
This date represents the
termination date of the CSS
entitlement.

2020.1201

SN Serial number for the license
entitlements in the pool.

OR10:13

Citrix License Server Event data elements

Field Description Example

Header

tenant_id The Customer ID received
during the registration.

citrix780933

dvc (unique GUID generated
by LS)

A unique identifier created
during install and preserved
during upgrades. This field is
used to identify which uploads
are from the same server.

a5ae17c9‑8a4a‑4318‑938f‑
a8c6da2aa2ef

type Type of event. LicenseServer.Inventory

prod Type of product. License Server

id Information about the server
machine and operating system
that the License Server is
installed on.

E824249098A96BF0

st Timestamp of the event. 2021‑08‑27T04:22:56.745631Z

ver Version of the payload. 1

prodVer Version of the License Server. 11.16.6.0 build 35000

$schema Schema for the event Header. https://cas.citrix.
com/schemas/event.
json

Payload
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Field Description Example

FQDN License Server machine and
domain name. This value is
sent to help identify License
Servers in the reporting
experience. Used to pair a
License Server calling home to
a license allocation record in
the back office.

CITRIX‑12T5MRV4

DateSampleStartUTC Start time of the sample being
collected.

2016‑11‑08T01:08:13Z

DateSampleStopUTC End time of the sample being
collected.

2016‑11‑09T00:55:56Z

Feature

SADate This field represents the CSS
date for which the
supplemental grace period was
triggered.

2019.1201

PEM The tag of the feature. CEHV_ENT_CCS

Notice NOTICE field from the license
file. This is populated with
Company Name.

Citrix Systems Inc

FriendlyName Friendly name of license XenDesktop Enterprise
User/Device

CountInstalled The number of licenses
installed.

1203

CountOverdraft Number of licenses used above
the installed quantity.

0

CountUsedMax Themaximum number of
licenses used.

3

DateExpiration Most recent expiration date
that impacts the license count
in the pool.

12/1/2020.

DateIssued The date that the license file
was issued. The date issued of
the license file that expires first.

1‑Dec‑03

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 47



Licensing 11.17.2 build 48000

Field Description Example

DateStart Date fromwhich licenses are
valid on.

31‑Dec‑2014

Serial This information allows Citrix
to identify who the product is
entitled to.

OR10:13

VendorStr Representation of licensing
information that informs
products of what edition and
mode that they must operate
in.

<![CDATA[;LT=Retail;
GP=2;PSL=10;CL=ENT,
ADV,STD,AST;SA=1;ODP
=0]]>

Citrix License Server Event data elements

November 15, 2023

Field Description Example

Header

tenant_id The Customer ID received
during the registration.

citrix780933

dvc (unique GUID generated
by LS)

A unique identifier created
during install and preserved
during upgrades. This field is
used to identify which uploads
are from the same server.

a5ae17c9‑8a4a‑4318‑938f‑
a8c6da2aa2ef

type Type of event. LicenseServer.Inventory

prod Type of product. License Server

id Information about the server
machine and operating system
that the License Server is
installed on.

E824249098A96BF0

st Timestamp of the event. 2021‑08‑27T04:22:56.745631Z

ver Version of the payload. 1
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Field Description Example

prodVer Version of the License Server. 11.16.6.0 build 35000

$schema Schema for the event Header. https://cas.citrix.
com/schemas/event.
json

Payload

FQDN License Server machine and
domain name. This value is
sent to help identify License
Servers in the reporting
experience. Used to pair a
License Server calling home to
a license allocation record in
the back office.

CITRIX‑12T5MRV4

DateSampleStartUTC Start time of the sample being
collected.

2016‑11‑08T01:08:13Z

DateSampleStopUTC End time of the sample being
collected.

2016‑11‑09T00:55:56Z

Feature

SADate This field represents the CSS
date for which the
supplemental grace period was
triggered.

2019.1201

PEM The tag of the feature. CEHV_ENT_CCS

Notice NOTICE field from the license
file. This is populated with
Company Name.

Citrix Systems Inc

FriendlyName Friendly name of license XenDesktop Enterprise
User/Device

CountInstalled The number of licenses
installed.

1203

CountOverdraft Number of licenses used above
the installed quantity.

0

CountUsedMax Themaximum number of
licenses used.

3
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Field Description Example

DateExpiration Most recent expiration date
that impacts the license count
in the pool.

12/1/2020.

DateIssued The date that the license file
was issued. The date issued of
the license file that expires first.

1‑Dec‑03

DateStart Date fromwhich licenses are
valid on.

31‑Dec‑2014

Serial This information allows Citrix
to identify who the product is
entitled to.

OR10:13

VendorStr Representation of licensing
information that informs
products of what edition and
mode that they must operate
in.

<![CDATA[;LT=Retail;
GP=2;PSL=10;CL=ENT,
ADV,STD,AST;SA=1;ODP
=0]]>

Citrix Licensing Telemetry data elements

June 28, 2024

License Server data elements

Metadata fields

Field Description Example

ClientTool This field isn’t in use. Not applicable

UploadUser This field isn’t in use. Not applicable

UTCDate Report generation time in UTC
format.

2022‑10‑10T06:11:14Z

Date Report generation time in local
time format.

10/10/2022 02:11:14

Product Name of the upload. LicenseServerCompliance
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Field Description Example

ProductVersion This is the version of the
upload.

2.0

ProductUTCDeployDate Denotes the time when the
License Server is installed.

2022‑08‑16T00:00:00Z

SiteID This field isn’t in use. Not applicable

SiteName This field isn’t in use. Not applicable

Component This field isn’t in use. Not applicable

UI This field ensures the integrity
of the uploaded file.

8826d6ac8e1c8e68e471ae90c2bacbe1854f8281a6f5ae40cc7b74114e026abc

License Server and License Usage information

Field name Description Example value

License Server information

GUID A unique identifier created
during install and preserved
during upgrades. This field is
used to identify which uploads
are from the same server.

a5ae17c9‑8a4a‑4318‑938f‑
a8c6da2aa2ef

HardwareId This field is a unique identifier
for the License Server instance.

E824249098A96BF0

FQDN License Server machine and
domain name. This value is
sent to help identify License
Servers in the reporting
experience. Used to pair a
License Server calling home to
a license allocation record in
the back office.

C648FE671A44B3F7 (always
scrambled)

InstallUTC This value denotes the time
when the License Server is
installed.

2016‑10‑12T00:00:00Z

ProductVersion Identifies the License Server
version.

11.16.6.0. build 35000
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Field name Description Example value

SGPClockErrorCode Error code indicating why the
License Server entered the
supplemental grace period.

0

SGPMaxDays Maximum days remaining in
the Supplemental Grace
Period.

15

Inventory

Feature

ID This value represents the
product code license usage is
associated with

CAG_AAC_CCU

UDBinFileCreatedUTC Timestamp of when the file
used to track user or device
licenses was created.

2016‑11‑09T00:55:56Z

UDReportGenerationUTC Timestamp of when the user or
device report was generated.

2016‑11‑09T00:55:56Z

UDAdminUsersReleased Count of users released by
udadmin.

3

UDAdminDevicesReleased Count of devices released by
udadmin.

3

SADate This field is used to build a view
of license usage over time.

For examples, see SADate in
the following section.

SADate

id Captures the SA Date through
the ID attribute of the SADate
element.

2022.1231

DateSampleStartUTC Start time of the sample being
collected.

2016‑11‑08T01:08:13Z

DateSampleStopUTC End time of the sample being
collected.

2016‑11‑09T00:55:56Z

CountUsedMax This value represents the
maximum number of licenses
used by this customer.

6

CCUDevices Lists the device IDs that use the Citrix concurrent licenses. This
helps in getting the license usage over time.
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Field name Description Example value

Active If the value is ‘1’, it’s in the
current inventory. If the value
is ‘0’, it appears only in
historical records and is no
longer part of the current
inventory either because it is
removed or expired.

1

Licensees The Licensees field has three
sub fields namely CountTotal,
Users, and Devices.

For examples, see Licensees in
the following section.

CountInstalled The number of licenses
installed.

1203

Pool For examples, see Pool in the
following section.

CCUDevices

DevId Specifies the unique
concurrent device identifier.
This is applicable only for
concurrent licenses.

C39A925064A3

Licensees

CountTotal Total number of licenses in use
at the time the sample was
taken. Total number is the sum
of users and devices.

3

Users Specific users where a user
license is assigned,
contributing to the total count.
This is applicable only for
user/device licenses.

For examples, seeUsers in the
following section.

Devices Specific devices where a device
license is assigned contributing
to the total count. This is
applicable only for user/device
licenses.

For examples, see Devices in
the following section.

Users

timeLastLogin Last login time event from a
user.

2022‑07‑12T10:00:00
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Field name Description Example value

ID Specific users where a user
license is assigned,
contributing to the total count.

1EC4ED037766AA18 (always
scrambled)

Devices

timeLastLogin Last login time event from this
device.

2022‑07‑12T10:00:00

DevId Specifies the unique device
identifier where a device
license is assigned,
contributing to the total count.

C39A925064A3

Name Friendly name for the device. Q648GE661F14B3H7 (always
scrambled)

Pool

Serial This information allows Citrix
to identify who the product is
entitled to.

OR10:13

DateExpiration Most recent expiration date
that impacts the license count
in the pool.

12/1/2020.

DateIssued The date that the license file
was issued. The date issued of
the license file that expires first.

1‑Dec‑03

VendorStr Representation of licensing
information that informs
products of what edition and
mode that they must operate
in.

<![CDATA[;LT=Retail;
GP=2;PSL=10;CL=ENT,
ADV,STD,AST;SA=1;ODP
=0]]>.

CountInstalled Number of licenses installed
among the pools for a given
feature.

100

CountOverdraft Number of licenses used above
the installed quantity.

0

UsageSamples For examples, see Sample in
the following section.

DateStart Date fromwhich licenses are
valid on.

31‑Dec‑2014

Sample
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Field name Description Example value

Timestamp Timestamp of the sample
collection.

2016‑11‑09T00:55:56Z

CountInUse Number of licenses in use at
the specific time stamp.

3

OverDraft Number of licenses used above
the installed quantity.

0

Installed Number of licenses installed at
the specific time stamp.

100

StartupCounts data elements

LPE Product, Edition, and version
information for each server
communicating with the
License Server. Example from
left ‑ Apps and Desktops
Premium ‑ 2012.

<ID><![CDATA[
XDT_PLT_2020
.1201]]></ID>

Count Total number of LPEs
connected to the License
Server.

2

SupplementalGracePeriod

ID This field represents the
product code following the
supplemental grace period
detail is associated with.

XDT_ENT_UD

SADate This field represents the CSS
date for which the
supplemental grace period was
triggered.

2019.1201

SGPErrorCode Error code for which
supplemental grace period was
triggered.

‑4

LicCount License count for which
supplemental grace period for
triggered.

100
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Field name Description Example value

DateTriggerUTC UTC date on which
supplemental grace period was
triggered for ID and SADate.

2022‑07‑19T14:35:59Z

DateTriggerLocal Local date on which
supplemental grace period was
triggered for ID and SADate.

2022‑07‑19T10:35:59

Citrix Virtual Apps and Desktops data elements

Metadata fields

Field Description Example

ClientTool This field isn’t in use. Not applicable

UploadUser This field isn’t in use. Not applicable

UTCDate Report generation time in UTC
format.

2022‑06‑30T15:31:34Z

Date Indicates the upload bundle
creation date.

06/30/2022 11:31:34

Product Identifies the upload bundle LicenseServer.OnPremUsage

ProductVersion Manifest schema version. 1.0

ProductDeployUTCDate Denotes the time when the
License Server is installed.

2022‑03‑21T00:00:00Z

GUID A unique identifier created
during install and preserved
during upgrades. This field is
used to identify which uploads
are from the same server.

a5ae17c9‑8a4a‑4318‑938f‑
a8c6da2aa2ef

UploadType Indicates if the license upload
is manual or automatic.

Auto

Ccid Indicates the Citrix Cloud
Customer ID; only available
with registered License Server.

xaxddaily1
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Field Description Example

OrgID Indicates the Org ID, the
installed licenses are tied to;
only available with registered
License Server.

23456123

TotalFiles Total number of files in the
upload bundle.

6

SerialNumbers → Serial → ID Represents the product code
associated with the installed
license.

XDS_ADV_CCS

SerialNumbers → Serial →
SADate

Represents the CSS date
associated with the installed
license.

2023.1201

SerialNumbers → Serial → SN This information allows us to
identify who the product is
entitled to.

eval1

File → Name Name of the uploaded file. ue_lt_1683864965.zip

File → UI Hash to indicate the integrity of
the file.

4d14a58f98b1ae2e9d965b2980b67853cfcac7c76e655952bd056ad6dc7a80ae

File → EventStartTS Indicates the bundle data start
time.

1697417241680

File → EventEndTS Indicates the bundle data end
time.

1697430741834

File → OfferingType → Name Indicates the product. Broker

FilesUI Hash to indicate integrity of the
bundle

4d14a58f98b1ae2e9d965b2980b67853cfcac7c76e655952bd056ad6dc7a80ff

ManifestUI Hash to indicate integrity of the
manifest.

4d14a58f98b1ae2e9d965b2980b67853cfcac7c76e655952bd056ad6dc7a8345

LSVersion Identifies the License Server
version.

11.17.2.0 build 48000

DiskFreeMB Identifies the free disk space in
megabytes.

357821

DiskTotalMB Identifies the total disk space in
megabytes.

383070

Headers
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Field Description Example

ver Version of the license usage
event.

1.0

id Unique identifier of the usage
event.

d4ce7919‑5d80‑44de‑a8fa‑
102923fe0ead

type Event type used by CAS to
identify cloud usage events.

Cloud.Licensing

st Timestamp when the event is
generated in Broker.

2011‑08‑12T20:17:46.384Z

prod Originating product and
deployment of the usage event.

XenDesktop.Broker

prodVer DaaS or Citrix Virtual Apps and
Desktops product version

7.25.0.0

user Specifies the unique User ID
used to identify the user
initiating the session launch.

fullName: User‑Steven

samName:
CTXLAB\User‑Steven
upn:User‑Steven@ctxlabs.onm
icrosoft.com
userLicenseId:
User‑Steven@CTXLABS04
userSid: S‑1‑5‑21‑3711855558‑
820010554‑2448362978‑22222

tenant ‑> id Customer ID of the Citrix Cloud
account. For on‑premises
environments the value is
always “CitrixOnPremises”.

joj1mh0598tj

dvc ‑> dvcId Specifies the unique device ID
used to identify a device from
where the session launch is
initiated.

AE18C4D5

dvc ‑> dvcName Friendly name for the device. Steven’s PC

Payload
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Field Description Example

appProtectionKeyLoggingRequiredDenotes if the session is
launched with Key Logging
Protection enabled.

False

appProtectionScreenCaptureRequiredDenotes if the session is
launched with Screen Capture
Protection enabled.

False

cspTenantCustomerId Customer ID of a CSP’s tenant’s
Citrix Cloud account. This field
is left empty if the customer ID
is not available, for example, in
on‑premises deployments.

6c2vtxgxyftt

isAnonymousUser Denotes if an unauthenticated
session is launched.

False

licenseActivityTimeStamp Timestamp when the payload
is generated.

2011‑08‑12T20:17:46.384Z

licenseActivityType Licensing event type. This field
indicates if the licensing event
type is for assignment or
release action.

Connect

licenseModel License model of the
deployment.

UserDevice

productEdition Product edition of the
deployment.

Premium or Advanced

productId Product ID of the product in the
deployment.

CAVDS

protocol The protocol used to launch the
session.

HDX

sessionKey Unique identifier for the
session.

uq390c5fc3‑86eb‑4df3‑bd9a‑
f4a8fed2c9e2

sessionSupport Session support type. SingleSession

sessionType The session type Application

ver Payload version. 1.3

workerSid Unique identifier for the VDA
used for the session.

S‑1‑5‑21‑3711855558‑
820010554‑2448362978‑27640

isWindows365 Denotes if the session is
launched for Windows 365

True
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Field Description Example

entitlementType Customer’s license entitlement
type

Production

siteId Unique identifier for the site a35647d0‑901c‑4477‑87e0‑
dcd781d455f4

desktopGroupId Unique identifier for the
Desktop or Delivery Group

e9d859dc‑1bfc‑4b3e‑bad3‑
41806bb4e694

clientType Citrix Workspace app type Windows

clientVersion Citrix Workspace app version 23.5.1.83

workerCloudType Public cloud type used for VDA
provisioning.

Azure

enabledFeatures Denotes the features that are
enabled for the session. For
example, in a session where
AppProtectionScreenCaptur‑
eRequired and
SessionRecording are enabled,
value of this field is 66.

66

isEvents Critical failures in License
Server

Unable to create ST Database.

heartBeatTime License server heart beat time
to CIS or CAS

1689058813

The following table specifies the numbers assigned to different features under enabledFeatures:

Feature enabledFeature number

AppProtectionKeyLoggingRequired 1

AppProtectionScreenCaptureRequired 2

AnonymousUser 4

Windows 365 8

SaaS 32

SessionRecording 64

WEM 128

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 60



Licensing 11.17.2 build 48000

Citrix Secure Private Access data elements

Admin payload

Event header:

Field Description Example

ver Header version. Hardcoded:
“ver”: “1.0”

1.0

id Unique event Id (GUID) 1fced2a0‑52e7‑4c48‑bf4e‑
6f2e06136e11

type Event type name. Hardcoded admin

“type”: “admin”

st UTC formatted timestamp 2011‑08‑12T20:17:46.384Z

prod Product name. Hardcoded.
“prod”:
“AccessSecurity.OnPrem”

AccessSecurity.OnPrem

prodVer Product version 2402

user
Unique ID to identify the admin
logged in.

{
“fullName”: “Username”,”
fullName”: “Username”,
“samName”: “User’s SAM
account name”,
“upn”: “User’s UPN name”,
“userSid”: “User’s SID”
}

Event payload:

Field Description Example

actualtemplatecode Payload template version.
Hardcoded:”
actualtemplatecode”: “1.0”

1.0

adminLoginType RBAC of admin type: enum
values:
fulladmin/readonly/helpdesk
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Field Description Example

clientType Fromwhere admin logged in.
Admin console/Director/Public
API etc. Others will be sent
when no User‑Agent is received
from client.

AdminConsole/CitrixMonitor/Others

tenantName Tenant name for multitenant
deployments (service
providers) or site name for
single tenant.

SPASite1

enabledFeatures Denotes the features that are
enabled for the session.

1

Config payload

Event header:

Field Description Example

ver Header version. Hardcoded:
“ver”: “1.0”

1.0

id Unique event Id (GUID) 1fced2a0‑52e7‑4c48‑bf4e‑
6f2e06136e11

type Event type name. Hardcoded config

“type”: “config”

st UTC formatted timestamp 2011‑08‑12T20:17:46.384Z

prod Product name. Hardcoded AccessSecurity.OnPrem

“prod”:
“AccessSecurity.OnPrem”

prodVer Product version 2405

Event payload:

Field Description Example

actualtemplatecode Payload template version.
Hardcoded.
“actualtemplatecode”: “1.0”

1.0
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Field Description Example

appsPublished

List of internal and external
applications published.
Includes Web/SaaS and
TCP/UDP apps.

[
{
“name”:”jira”,
“type”: “web”,
“internal”: true
},
{
“name”:”Office 365”,
“type”: “saas”,
“internal”: false
},
{
“name”:”eng_printer”,
“type”: “tcp”,
“internal”: true
}
]

User payload

Event header:

Field Description Example

ver Header version. Hardcoded:
“ver”: “1.0”

1.0

id Unique event Id (GUID) 1fced2a0‑52e7‑4c48‑bf4e‑
6f2e06136e11

type Event type name user

“type”: “user”
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Field Description Example

st UTC formatted timestamp 2011‑08‑12T20:17:46.384Z

prod Product name. Hardcoded
“prod”:
“AccessSecurity.OnPrem”

AccessSecurity.OnPrem

prodVer Product version 2402

user Unique ID to identify a user.
{
“fullName”: “Username”,
(optional)
“samName”: “User’s SAM
account name”,
“upn”: “User’s UPN name”,
“userSid”: “User’s SID”
}

dvc
PII data, if enabled these values
must be scrambled.
dvcId ‑ Unique device ID to
identify a device fromwhere
the application launch was
initiated.
dvcName ‑ Friendly name for
the device.

{
“dvcId”: “AE18C4D5”,
“dvcName”: “User’s PC”
}

Event payload:

Field Description Example

actualtemplatecode Payload template version.
Hardcoded:”
actualtemplatecode”: “1.5”

1.5

transportProtocolType Connection type: TCP or EDP or
0 (for Web\SaaS)

tcp

ngsRecordType Application type: websaas or
tcpudp

websaas

tenantName Tenant name for multitenant
deployments (service
providers) or site name for
single tenant.

SPAOPDEVSite

SPAOPDEVSite
List of apps which will be
accessed by the user for the
event.

{
“published”: {
“internal”: [“issues.citrite.net”
],
“external”:[
“citrixsys.splunk.com”,
“www.office365.com”]
},
“unpublished”: {
“internal”: [],
“external”: [“www.okta.com”,
“www.cloudcentral.com”]
}
}
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Field Description Example

clientInfo This field indicates if the client
is Citrix Enterprise Browser,
Citrix Secure Access, Citrix
Workspace App, RfWeb along
with version.

{“name”: “ceb”, “version”:
“21.4.0”}

platformType This field displays the agent OS
type.

Win/MacOS/iOS/Android

enabledFeatures Denotes the features that are
enabled for the session.

1

Licensing services

October 7, 2023

This article contains the following information:

• Web Services for Licensing
• Citrix Licensing
• Citrix licensing Windows Management Instrumentation (WMI)

Web Services for Licensing

Studio, Director, and the Licensing Administration PowerShell Snap‑in useWeb Services for Licensing
to do the following:

• Communicate with the License Server andmanage users
• Allocate and install licenses
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• Display License Server health, license usage, and other alert messages.

The Citrix Licensing Manager also uses it.

Citrix Licensing

The Citrix Licensing service is the Windows service responsible for core licensing functionality. Cit‑
rix Licensing services licenses to Citrix products and is responsible for managing the CITRIX vendor
daemon, license server port 27000 (by default).

Citrix Licensing WMI

TheWMIserviceprovidesaccess toCitrix LicensingWMIclasses. There’sanamespace (ROOT\CitrixLicensing)
with a few classes (notably, Citrix_GT_License_Pool) that gives license usage and availability counts.
Querying the License Server too often (more than every 15 minutes) might impact performance
negatively.

Citrix licensing technical overview

December 7, 2023

Before you can use your Citrix product, youmust install Citrix licensing. Citrix licensing is a system of
components that function together. This system includes:

License Server. A system that allows licenses to be shared across the network. Formore information,
see License Server.

License files. The files required to license your product. These files are stored on the License Server.
For more information, see License files.

Citrix LicensingManager. TheLicenseServermanagementmethod. Formore information, seeCitrix
Licensing Manager.

Web Services for Licensing. Enables Studio, Director, and the Licensing Administration PowerShell
Snap‑in to:

• Communicate with the License Server andmanage users.
• Allocate and install licenses.
• Display License Server health, license usage, and other alert messages.

For more information, see Licensing elements and Services.
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Licensing operations overview

Check out and Check in

Typically, the first time a user connects to a Citrix product, the product requests a license from the
License Server. When the License Server grants a license request, the Citrix product reserves a license
for its use. Reserving licenses for this purpose is known as checking out licenses. When the user
logs off from the product server, the product returns the license to the License Server. This process is
known as checking in licenses. Some Citrix products check out the license when a user connects to
the product. The license remains checked out for a predetermined amount of time.

Each time a Citrix product starts, it opens a connection to the License Server by checking out the
startup license. The startup license is a Citrix system file that enables Citrix products to maintain a
continuous connection to the License Server. For more information, see Startup license.

For example, when a server running Citrix Virtual Desktops requests a license, the product retrieves
the License Server name and port number information from the data store. The product then estab‑
lishes a connection to acquire the licenses.

Note

When configuring the product‑side setting for the License Server name, do not use localhost.
Though you can use the host name, IP address, or FQDN instead, Citrix recommends that you
use the FQDN.

There are three stages of the license checkout process.

A Citrix product goes through a three‑step process to check out licenses:

1. At startup, a computer running a Citrix product checks out a startup license.
2. A client device connects to the product server.
3. The product requests a license from the License Server.

Citrix products, such asCitrix Virtual Desktops, stores a replica of the licensing information from the Li‑
cense Server, including the number and type of licenses. If a Citrix product server loses its connection
to the License Server, or the License Server does not respond in a timely manner, the product enters
a grace period. During the grace period, the product uses its local record of the licenses to continue
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licensing the product. After communication is re‑established between the product and the License
Server, the grace period is reset.

Scalability

This section provides guidance to ensure successful License Server usage by examining the impact of
license usage scalability in a Citrix environment. We performed this scalability testing:

Virtual Machine Hardware/Configuration:
Intel Xeon E5‑2650 v3@ 2.30 GHz
4 Virtual CPUs
8 GB RAM
Windows Server 2016

6.5 and earlier Concurrent:

• 3000 connected Citrix Virtual Apps servers
• 53,000 concurrent licenses
• 50–60 connections per second

Efforts to scalemore than 53,000 licenses result in servers going into a grace period. Also, there are is‑
sues withWMI and lmstat. We recommend that youmaintain 50,000 or fewer concurrent connections
per License Server.

7.x Concurrent:

• 16 Delivery Controllers
• 70,000 concurrent licenses
• 50–60 checkouts per second

7.x User/Device:

• 16 Delivery Controllers
• 150,000 user/device licenses
• 50/60 checkouts per second

CITRIX.exe is a single threaded process. While it’s serving Concurrent connections, the maximum
connection limit is based on the single core processor speed. During peak activity, CITRIX.exe uses
100% of a single core and eventually starts timing out. This usage might cause Citrix products to go
into a grace period or errors in the License Server utilities. After the License Server has processed
backlog connections, it returns to normal. Monitor the CITRIX.exe processor usage to determine if a
faster processor is required. We recommend if you experience issues in high scalability environments,
you deploy more License Servers.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 68



Licensing 11.17.2 build 48000

User/Device technology ismulti‑threaded and scales better thanConcurrent. During license optimiza‑
tions, you might see that periods were licensing activity takes 100% of a single core. This usage is
normal and doesn’t impact the CITRIX.exe processor usage or functionality. We recommend that you
monitor License Server resource usage and addmore License Servers tomaintain a properly function‑
ing environment.

Note

Running WMI, lmstat, lmutil, or other inventory actions can negatively impact the License
Server performance. We recommend that you minimize these activities. If you require usage
data, export the data from the Citrix Licensing Manager. For more information, see Historical
Use.

License Server using different product editions

One License Server can contain licenses for multiple editions of a Citrix product. For more informa‑
tion about product editions, see Citrix Products and License Models. The type of license checked out
corresponds to the edition that is configured on the product server. A product server is configured to
consume a specific edition of a license and checks out that license edition.

For example, ProductServerA is configured to check out Advanced licenses. ProductServerB is
configured to check out Premium licenses. LicenseServer1 contains both Advanced and Premium
licenses.

• Users who connect to ProductServerA, which is configured to use licenses installed on Licens‑
eServer1 checkout Advanced licenses only. After the number of Advanced licenses on Licens‑
eServer1 is exceeded, new requests from ProductServerA users are denied until existing Ad‑
vanced connection licenses are released.

• Users who connect to ProductServerB, which is configured to use licenses installed on
LicenseServer1 checkout Premium licenses only. If the number of Premium licenses on Li‑
censeServer1 is exceeded, new requests from ProductServerB users are denied until Premium
connection licenses are released.

Note:

License checkout timesmight increase ifmanyproduct servers that havemanyusers are contact‑
ing the same License Server simultaneously. One License Server can accept only 10,000 inbound
TCP/IP requests at one time. If you are planning to havemore than 10,000 Citrix product servers
connecting at the same time, we recommend that you use several License Servers. These prod‑
uct servers can include Citrix Virtual Apps and Desktops, Delivery Controllers, and Appliances.
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Deployment examples

Scenario 1: Two sites

• SiteA contains product servers configured for the Advanced edition.
• SiteB contains product servers configured for the Premium edition.
• One License Server (shared).
• User1, User2, User3, User4…User5000 connects only to SiteA.
• User5001, User5002, User5003…User10000 connects only to SiteB.

Scenario 2: One site

• The site has two sets of published applications.
• The site is configured as Citrix Virtual Apps and Desktops Premium concurrent and Delivery
Groups 2 as Citrix Virtual Apps and Desktops user/device

• One License Server (shared).
• User1, User2, User3, User4…User5000 connects only to the concurrent licenses.
• User5001, User5002, User5003…User10000 connects only to Delivery Group 2 user/device li‑
censes.

Licensing concepts

Grace period

Note:

The grace period and supplemental grace period are two different features. For more informa‑
tion about the supplemental grace period, see Supplemental grace period.

If product servers lose communication with the License Server, the users and the products are pro‑
tected by a grace period. The grace period allows the product servers to continue operations as if
they were still communicating with the License Server. After the Citrix product checks out a startup
license, the product and the License Server exchange the heartbeatmessages for every fiveminutes.
Theheartbeat indicates toeach that theyare still upand running. If theproduct and theLicenseServer
don’t send or receive heartbeats, the product lapses into the licensing grace period and licenses itself
through the cached information.

Citrix sets the grace period. It is typically 30 days but can vary depending upon the product. The
Windows Event Log, and other in‑product messages, indicate if the product has entered the grace
period, the number of hours remaining in the grace period. If the grace period runs out, the product
stops accepting connections. After communication is re‑established between the product and the
License Server, the grace period is reset.
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The grace period takes place only if the product has successfully communicated with the License
Server at least once.

For concurrent licenses, they can connect up to the maximum concurrent licenses installed. For
user/device licenses, they have unlimited connections.

Grace period example ‑ two sites, both using the same License Server

• The connection between Site 1 and the License Server goes down causing Site 1 to go into the
grace period, continuing operation andmaking connections.

• When Site 1 reestablishes communication with the License Server, connections are reconciled
and no new connections are allowed until they are within normal license limits.

• Site 2 is unaffected and operates as normal.
• If the License Server goes down, both sites go into the grace period. Each site allows up to the
maximum number of licenses installed. As above, the user/device licenses have no limit.

New licenses

• New licenses are the licenses you purchased from Citrix within the last 30 days.
• The new licenses section displays the top five recent purchases.
• New licenses are indicated with a green bar and the word (New) in green.

• YoucanAllocate licenses fromthe landingpageonly fornew licenses. Select the required license
and start the allocation process by clicking Allocate licenses.

Expiring term licenses

• Expiring licenses are term licenses that are expiring within 90 days.
• Licenses expiringwithin 0 through 30days are displayedwith a redbar. Licenses expiringwithin
31 through 90 days are displayed with an orange bar.
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• The Expires column shows the number of days until the license expiry date.
• The Allocated column shows the allocated quantity and total purchased quantity.
• The expiring licenses section shows the 5 most recent purchases.

Glossary

Allocate licenses: When you allocate licenses, you apportion purchased licenses by product and Li‑
cense Server so you can split them among multiple environments or use cases. For example, your
organization might own 1,000 licenses for the same product. You might want to use 800 in 1 location
and 200 in another location. You can allocate 800 licenses to a License Server in the first location
today, and allocate the remaining 200 later to a different License Server.

Asset components: Asset components are the license details.

CSV files: The Excel CSV file provides daily usage information, including the number of licenses in
overdraft.

Modify licenses: Choosing to modify licenses, returns the license file and allocates it to another Li‑
cense Server.

Return allocations: When you Return licenses, you put the licenses back in the licensing pool. You
can then allocate these licenses in any quantity at any time. After you return a license, remove the old
license file from the License Server.

Term licenses: Term licenses are purchased for a specified amount of time and have an expiration
date.

License files

October 7, 2023
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Before you start installing product licenses, see the prerequisites to obtain your license files.

When you install the License Server, a Citrix start‑up license (citrix_startup.lic) and an options file (CIT‑
RIX.opt) are installed by default. To license your Citrix products, you add one ormore license files. For
information about adding your product licenses, see Install licenses.

You cannot change the location of license files on the License Server. License filesmust reside in their
default location.

Citrix Start‑up license

The start‑up license file (citrix_startup.lic) is a text file that Citrix products use to communicate to
the License Server using a continuous open connection. Every five minutes the License Server and
the product send a heartbeat message to each other to verify that they are mutually communicating.
When the product and License Server exchange heartbeat messages and there is an interruption in
the exchange, the product goes into a grace period. A power failure is an example of an interruption.
The startup license file does not affect your license count.

Citrix License Server Diagnostics License

The License Server uses Citrix License Server Diagnostics License for internal diagnostics and alert
message notifications displayed in Citrix Studio andDirector. It is available by defaultwith the startup
license in the citrix\\_startup.lic file.

Warning

Do not edit the startup license file, or any other license files.

License file

The license file is a text file containing the following:

• Product licensing information

• License Server name (or other binding identifier)

• Customer Success Services membership renewal date (also known as the Customer Success
Services expiration date)

• License expiration date (if applicable) and other system information

• SaaS attribute, only if it’s a Hybrid Rights license
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All this information is encrypted using a digital signature. When you purchase a Citrix product, go to
the citrix.comwebsite to download a license file. For more information, see Manage licenses on
Citrix.com. You canhavemore than one license file per License Server. The license file resides in these
directories, where the License Server references it.

• C:\Program Files\Citrix\Licensing\MyFiles directory on a 32‑bit server
• C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64‑bit server

The License Server uses this file to determine whether to grant a license to a Citrix product.

A license overdraft is included in all user/device, per user, and per device licenses. For more informa‑
tion on the license overdraft, see License overdraft.

Move licenses to a different host

The license file you downloaded for the old License Server cannot bemoved to a server that has a dif‑
ferent host nameorMACaddress. Create license files that reference the new server nameby returning
them and then allocating them.

For more information, see Modify licenses.

License file format

Important

Any changes to the license file can make license files unusable. If using Citrix Licensing for Win‑
dows 11.6.1 or later, editing license files is not necessary. You can manage licenses through the
Citrix Licensing Manager and the My Account site at citrix.com. For more information, see
Manage licenses in MyAccount on citrix.com.

You can change the name of the license file, but it must have a .lic (lower case) extension.

Citrix license files use the following naming convention:

FID_fulfillmentID.lic

For example: FID_30d0000_0000_xxxx_c800_00xxyy000zz7.lic

License files are composed of lines listing specific information, such as the server name (SERVER) or
quantity of licenses (INCREMENT). These lines begin by using words denoting their purpose in upper‑
case letters, such as VENDOR, SERVER, INCREMENT, USE_SERVER.
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The following sections provide in‑depth information about the following elements of license file syn‑
tax: the SERVER line, VENDOR line, USE_SERVER line, and INCREMENT line.

The following image is an example license file:

1. SERVER line shows an identifier required for binding licenses to the License Server.

2. VENDOR line specifies the Citrix vendor daemon name.

• SaaS attribute, only if it’s a Hybrid Rights license

3. INCREMENT lines specifies the license required to use a product.

4. Commentsusedby theLicenseServer to translate licenseFEATURES (PRODUCT_EDITION_LICENSEMODEL)
to Citrix product names.

SERVER Line

TheSERVER line specifies thebinding identifier (also knownas thehost name) of the License Server.

Caution:

Do not change the binding identifier on the SERVER line otherwise, the license file doesn’t work.

Syntax:

SERVER this_host ether

Or

SERVER this_host HOSTNAME=hostname
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Parameters Description

ether The MAC address of the appliance on which the
License Server is running. Do not edit this text
string.

hostname The name of the computer on which the License
Server is running. Do not edit this text string.

Example

1 SERVER this_host HOSTNAME=license_server1

VENDOR Line

The VENDOR line specifies the Citrix vendor daemon name.

Syntax:

VENDOR CITRIX [vendor_daemon_path]

Field Description

VENDOR CITRIX Name of the Citrix vendor daemon. Do not edit
this name.

vendor_daemon_path Path to the executable for the Citrix vendor
daemon. Citrix recommends that you do not
change this path.

INCREMENT Lines

An INCREMENT line describes the license required to use a product. License files (*.lic) contain one or
more INCREMENT lines. Each INCREMENT line makes up a user‑specified allocation of product and
license (users, connections) counts.

Each increment line contains:

• A signature based on the data in that line
• The hostids specified in one or more SERVER lines
• Data selected by Citrix

INCREMENT lines use a backslash () to wrap long lines of text.
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Syntax:

INCREMENT feature vendor css_expiry_date exp_date num_lic
SIGN=sign [optional_attributes]

Caution:

Do not change the six fields after the INCREMENT line keyword. The fields are required and have
a fixed order.

The following table explains these fields in the order they appear:

Field Description

feature The product license. Do not edit this line.

vendor Indicates that this license is for a Citrix vendor
daemon. Do not edit this line.

CSS_expiry_date
exp_date

Indicates the date until which you are entitled to
product version upgrades. If you don’t have a
Customer Success Services membership, or this
license isn’t a Customer Success Services license,
the date indicates when you ordered or
redeemed the license. Do not edit this line.
Note: If you renewed your Customer Success
Services membership and received an upgrade
license, the CSS_expiry_date is listed. For
example: INCREMENT MPS_ENT_CCU CITRIX
2019.0311 permanent 1000
Expiration date of license in the format
dd‑mmm‑yyyy, that is, 07‑may‑2006. Do not edit
this line. Note: If the exp_date field contains the
text string permanent, the license never expires.

num_lic Number of concurrent licenses for this product
license. Do not edit this line.

SIGN=sign SIGN=signature to authenticate this INCREMENT
line. Do not edit this line.
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Field Description

SUPERSEDE_SIGN=sign Strategically turns off specific licenses based on
license feature and signature or INCREMENT line
to be disabled. Customer Success Services or
maintenance upgrade licenses include
SUPERSEDE_SIGN. Example:
SUPERSEDE_SIGN={“CBR_100_SSERVER:0F76
2946 4790 6B67 08E0 65BC 302B E1B6 6ECE 41D6
8AB6 E9C6 FE44 4EB3 9A83 01E4 D405 3E95 74B8
9BC8 7791 BDD3 1385 33F8 9533 95FF A3E4 F461
35B4 251E”}

INCREMENT lines also determine the grouping of licenses in themanagement console. These groups
are known as license pools. The Citrix vendor daemon creates the license pools based on common
attributes, such as product license or version. The console displays and tracks a newly created pool
independently from other license pools. The Citrix vendor daemon creates a license pool when two
or more attributes are different.

Citrix Attributes in INCREMENT Lines:

INCREMENT lines can also include more attributes from Citrix. These attributes provide information
about the license, such as the date of issue or if the license is an upgrade license.

Caution:

Do not change or remove these attributes.

Example:

Important items are highlighted in the preceding example:

• The Product (license feature) appears in blue
• The Customer Success Services expiration date appears in red (Format: YYYY.MMDD)
• The License (user, connection) count appears in GREEN

Syntax:

keyword=value
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The following tabledescribes theCitrix attributes. Theuppercase letters of the attributes indicate that
this attribute is not editable.

Attribute Description

DUP_GROUP=V This attribute allows license sharing for the same
client device.

ISSUED=dd‑mmm‑yyyy Date issued.

ISSUER=”…” Issuer of the license.

NOTICE=”…” Your company name.

SN=serial_num Serial number is the License Access Code and
the fulfillment ID of that license.

START= dd‑mmm‑yyyy The date fromwhich you can start using a
license. The License Server cannot use licenses
before their start date. You can install licenses
before the START date but there are not visible in
your License Server inventory until the actual
START date.

SUPERSEDE=”MPS_ADV_CCUMPS_STD_CCU…” This attribute appears in the upgrade license file
when youmove to a higher product edition. If
this attribute appears, this line supersedes all
licenses issued before the date specified in
ISSUED= and they become ineffective.

VENDOR_STRING=”…” Text string defined by Citrix.

Example of a base license:

1 INCREMENT CBR\_100\_SSERVER CITRIX 2016.1201 permanent 10 \\
2
3 VENDOR\_STRING=;LT=Retail;GP=720;MAXBW=1;MLC=0;HA=0;CL=BRSE;SA=1;ODP

=0 \\
4
5 DUP\_GROUP=V ISSUED=18-dec-2005 NOTICE="Citrix" \\
6
7 SN=100se200seB SIGN="1B19 C213 7517 CC62 756F 864C 9C93 06FC \\
8
9 E1DE B5D5 D793"

10 <!--NeedCopy-->

Example of a Customer Success Services renewal license containing SUPERSEDE_SIGN:

1 INCREMENT CBR\_100\_SSERVER CITRIX 2017.1201 permanent 10 \\
2
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3 VENDOR\_STRING=;LT=Retail;GP=720;MAXBW=2;MLC=0;HA=0;CL=BRSE;SA=1;ODP
=0 \\

4
5 DUP\_GROUP=V ISSUED=18-dec-2007 NOTICE="Citrix" \\
6
7 SN=100se200seU SUPERSEDE\_SIGN={
8 "CBR\_100\_SSERVER:1B19 C213 7517 \\
9

10 CC62 756F 864C 9C93 06FC E1DE B5D5 D793" }
11 SIGN="1D5D 869A 40BE \\
12
13 D4DB 361D 7897 AFA5 FF8B E52A 20BA 5525 01AA F241 6919
14 <!--NeedCopy-->

License types

May 30, 2024

Your Citrix product uses one of the license types described in this document. Some products allow
you to select more than one type of license. Ensure that you are aware of the licenses that are pur‑
chased and how they are consumed. Some license types offer license overdraft and supplemental
grace period as a feature.

The Citrix License Server supports any Citrix products that require Citrix licenses. For more informa‑
tion, see Products and license models.

User/device license

Overview

In user/device type licensing the License Server dynamically assigns a license to a user or a device
based on the usage andmonitors license consumption. The default assignment is a user license. The
license server considers each connection and its optimization engine. It ensures that the smallest
number of licenses are used based on the userID and deviceID.

The license server truncates domains by default so that abc@eng.com and abc@citrite.com
are treated as a same user. For more information, see Disable the domain name truncation.

Note:

Domain membership doesn’t play a role in how licenses are served. A license server can host
licenses for any product that can connect to it across the network. Workgroup or Domain mem‑
bership primarily controls who can be configured as License Server Administrators to access the
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Citrix Licensing Manager.

Scenarios

• Whena license is assigned to auser. Auser license allows the user to access fromanunlimited
number of devices. A licensed user requires a unique user ID, such as an Active Directory entry.

For example, the user can connect to their desktops and applications using multiple devices such as
desktop, laptop, smartphone, or thin client. A licensed user can connect tomultiple instances of Citrix
Virtual Desktops concurrently.

• When a license is assigned to a device. A device license is assigned to a device when two or
more users connect to an exclusively shared endpoint device.

For example, single shared devices such as a kiosk or a workstation in a call center environment used
bymultiple users.

The following table illustrates howuser/device licenses are assigned to non‑shared devices and exclu‑
sively shared devices. Blue color cells display user licenses, where the devices are not shared. Green
color cells display device licenses, where the devices are exclusively shared.

License assignment period

When users or devices connect to an application or desktop, they consume a license for a 90 day as‑
signment period. The license assignment period beginswhen a connection is established. The period
is renewed to a full 90 days during the life of the connection. The user/device lease for the license as‑
signment will expire in 90 days after the last connected user or device disconnects.
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Release licenses for users or devices

You can release a license for a user only when:

• The employee is no longer associated with the company.
• The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

License optimization

The License Server uses the optimization process to determine how tominimize license consumption.
Thisoptimization isbasedon licenses inuseandconnections to theLicenseServer. TheLicenseServer
optimizes every five seconds until there are 5000 unique connections. Connections at 5000 and above
optimization occurs every five minutes. Optimization might delay status information until the next
optimization, impacting when license usage statistics are updated in various consoles.

Optimization occurs every five seconds for 1‑4999 users and every five minutes for 5000 or more
users.

Optimization is not consumption. The following table is the example of connections and optimization
time when optimization occurs.

Device and user connection Optimization time

700 users * 1 device each 700 (optimize every 5 seconds)

5000 users * 1 device each 5000 (optimize every five minutes)

5000 devices * 1 user each 5000 (optimize every five minutes)

2500 users * 2 devices each 5000 (optimize every five minutes)

Note:

• If you have a large deployment, optimization can be CPU intensive depending on the num‑
ber of unique connections. We recommend using machines with multiple cores.

• Customers hosting many license servers or shared disk systems see high read and write
operations. Even if all the license servershave less than5000users, eachcanoptimizeevery
5 seconds and write cache data to disk. You cannot disable the optimization or change its
frequency.
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Concurrent license

Overview

Concurrent license is not tied to a specific userID, Active Directory account, or a domain. Concurrent
licensing is based on the originating endpoint deviceID. A user or endpoint device could connect to
multiple sessions and use a single license.

You start a product that requests a license and it is checked out to a unique endpoint deviceID. If you
log off or disconnect from the session, the license is checked in and made available for a new user.
Note, we don’t license per session.

Scenarios

• Multiple sessions at different computers use multiple licenses. Each time you start a Citrix
session from various devices, a license is checked out until you close that session. At that point,
the license is checked back in.

For example, a user starts a session fromone computer and then starts another from a different
computer before closing the first session. Two licenses are checked out.

• License Servers do not communicate with each other. If you run multiple License Servers,
you might consumemore than one license (for example, with load balancing). If you are using
load balancing, we recommend that the product servers point to the same License Server.

• Different editions consume different licenses. Two licenses are consumed, if you use the
same client to connect to applications running on an Advanced edition and Premium edition
each.

• Same product, edition, and license model consume single license. If you make multiple
connections from a single device to different product servers configured with the same edition
and license model and pointing to the same License Server. Only one license is consumed.

• For license sharing, pass‑through connections on Citrix Virtual Apps and Desktops pass
theendpointclientdevice IDto theproductserver. If youconnect toasingleproduct, edition,
and license model with a shared License Server, all connections share a single license.

• A user connects from a single device to two product servers that are the same edition but dif‑
ferent versions. One or two licenses might be consumed based on the order in which the user
makes the connections.

For example, the two servers are Citrix Virtual Apps and Desktops 7 1811 and Citrix Virtual Apps
and Desktops 7 1903:
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– The user connects to Citrix Virtual Apps and Desktops 7 1811 first. Two licensesmight
be consumed. An older license first, for the older product, and then a newer license be‑
cause version 1903 requires a newer Customer Success Services date. For more informa‑
tion, see Customer Success Services.

– The user connects to Citrix Virtual Apps and Desktops 7 1903 first. Only one license is
consumed because the Customer Success Services date required by version 1903 is com‑
patible with all older product versions.

– If the Customer Success Service date of all the installed licenses are compatible with all
the product versions then a single license is required for each connecting device.

• RDP connections consumea licensebut RDP connections to a console donot consumea license.

• If the number of connections exceed the purchased and available standalone concurrent li‑
censes, users are denied access unless the supplemental grace period is enabled. For more
information, see Supplemental grace period.

Per user license

Overview

A licensed user requires a unique user ID, such as an Active Directory entry. When a license is assigned
to a user, the license allows the user to connect to their desktops and applications using multiple
devices. A User license is assigned to the User and not to the User’s devices.

Note:

These licenses are only user licenses and are not the same as user/device licenses.

Scenario

• A user can connect to multiple devices such as a desktop computer, laptop, netbook, smart‑
phone, or thin client. A licenseduser can connect tomultiple instances of Citrix Virtual Desktops
concurrently.

License assignment period

Whenauser connects tomultipledevices, auser license is consumed for the90dayassignmentperiod.
The license assignment period begins when a connection is made. The period is renewed to the full
90 days during the life of the connection. The device lease for the license assignment will expire in 90
days after the last connected user or device disconnects.
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Release licenses for users or devices

You can release a license for a user only when:

• The employee is no longer associated with the company.
• The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

Per device license

Overview

A licensed device requires a unique device ID and any individual can access instances of a product. It
allows an unlimited number of users per device. A single Device license can support multiple users
from the same device.

Note:

These licenses are only device licenses and are not the same as user/device licenses.

Scenarios

• A classroomworkstation, used bymany students.
• A clinical workstation in a hospital, used by hospital staff.

License assignment period

Whena single device is usedbymultiple users, a device license is consumed for the 90day assignment
period. The license assignment period begins when a connection is made. The device lease for the
license assignment will expire in 90 days after the last connected user or device disconnects.

Release licenses for users or devices

You can release a license for a user only when:

• The employee is no longer associated with the company.
• The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.
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Per socket license

Per socket licenses are consumed based on the number of CPU sockets. Cores are not counted. For
example:

• If a computer with two CPU sockets has only one CPU then only one license is consumed.
• If a computerwith two sockets has twoCPUs, eachwith a quad core, then two licenses are used.

Citrix Hypervisor uses per socket licenses.

Named user license (legacy)

In a product when you request a license, a named user license is checked out until a preconfigured
period expires. This type of license check‑out is not tied to a computer or a device. After the license
is checked out, the user can runmultiple sessions on different computers without checking outmore
licenses.

Evaluation licenses

Citrix aims to provide the best customer experience possible, many of Citrix’s products offer a demo
experience. You can set up this demo experience directly through citrix.com or by contacting Citrix
sales team. These demos allow for a customized experience to fit your needs, use cases and active
projects; get real‑time answers and advice from a Citrix expert.

IMPORTANT:

The allotment is one evaluation license per product, per account, per year.

See How to obtain a Citrix Evaluation license using My Account for more information.

License overdraft

On‑premises products that support user/device, user, or device licensemodels include a license over‑
draft feature. This feature enables you to use an additional 10% of extra licenses beyond the pur‑
chased quantity to prevent access denial. The license overdraft count is displayed in a separate col‑
umn within the License Administration Console. The installed column displays both the purchased
license total plus the associated overdraft total. Overdraft usage is also visible in Studio.

The license overdraft feature is offered as a convenience, not as a license entitlement. Any overdraft
licenses usedmust be purchased within 30 days of first use.

Concurrent licenses and server licenses do not contain the overdraft feature. Citrix reserves the right
to remove any overdraft features in new product releases.
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Supplemental grace period

The supplemental grace period enables unlimited connections to a product for 15 consecutive days.
This feature is available to Citrix Virtual Apps and Desktops licenses. You can use this feature with a
XenApp 7.6 or XenDesktop 7.6 version and above.

If all licenses are in use, including the license overdraft where applicable, the supplemental grace
period gives you time to determine why you exceeded the maximum license count and to purchase
more licenses without disrupting your users.

After the supplemental grace period expires, normal connection limits are enforced. Users are not
disconnected during active sessions. As they disconnect, however, no new connections can occur
until the license levels return to normal.

The supplemental grace period is not automatically re‑enabled once it completes. To re‑enable the
supplemental grace period, youmust install another retail license. This retail license grants a new 15‑
day supplemental grace period if and when you exceed the subsequent maximum installed license
limit.

We recommend that you allow the supplemental grace period to run out after it starts. To clear the
warning condition do not add licenses immediately. Doing so gives you time to fully assess the situa‑
tion and correctly address any issues.

Note:

If you install licenseswhile the supplemental grace period is in force, the License Server exits the
supplemental grace period. Reenabling the supplemental grace period before fully determining
the reason for the supplemental grace period, and howmany licenses you require, might cause
you to reenter the period after installing new licenses.

Supplemental grace periods are granted per product version and edition and only for retail li‑
censes. The supplemental grace period is enabled by default when you first install the license. To
disable the supplemental grace period feature, use the Citrix Licensing Manager.

There isnoway to track the total numberof licenses consumedwhile in the supplemental graceperiod.
You canuselmstatudadminandconnection information fromtheproduct todeterminehowmany
more licenses are required.

Note:

The grace period and supplemental grace period are two different features.

The grace period and supplemental grace period features do not apply when licenses expire.

For more information about grace periods, see Grace period.

Citrix Virtual Apps and Desktops Director displays the grace period states. For more information, see
Panels on the Director Dashboard.
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The supplemental grace period feature is offered as a convenience, not as a license entitlement. Citrix
reserves the right to remove any such feature in new product releases.

Overdraft and Supplemental grace period examples

Example 1: Citrix Virtual Apps and Desktops user/device, user, or device licenses using the overdraft
and supplemental grace period features

You initially purchase and install 1000 licenses from Citrix (I) which includes a 10% license overdraft
allowance (OD).When licenses are allocated, you have 1100 licenses in total. At the time it is sufficient
for the number of users connecting.

d0 At a later date (day 0) you are using 1050 licenses. When the 1001st license was used, the overdraft
featurewas activated. Your users can continue to connect without any disruption of service. You start
evaluating your licensing needs now. Do not wait until you exceed the OD. Think about buying more
licenses in addition to the 1000 you bought initially.

d10 10 days later (day 10) more users connect and 1150 licenses are being used, which exceeds the
1100 total licenses you have available (!). When the 1101st licensewas used, the 15 day supplemental
grace period (SPG) started, to allow you time to evaluate your license needs. Your users can continue
to connect without any disruption of service.

d25 15 days later after d10 (day 25) the supplemental grace period runs out because you chose not
to purchase and install more licenses. Users cannot make new connections if doing so requires more
than 1100 licenses to be checked out. You cannot re‑enable the supplemental grace period until you
purchase and install more licenses.

Example 2: Citrix Virtual Apps and Desktops concurrent licenses using supplemental grace period
feature
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You initially purchase and install 1000 concurrent licenses (I). There is no overdraft allowance with
concurrent licenses. At the time these licenses are sufficient for the number of users connecting.

d0 At a later date (day 0) you are using 1050 licenses. When the 1001st license was used, the 15 day
supplemental grace period (SPG) started, to allow you time to evaluate your license needs. Your users
can continue to connect without any disruption of service. You start evaluating your licensing needs
now. Do not wait until the supplemental grace period runs out. Think about buying more licenses in
addition to the 1000 you bought initially.

d15 15 days later (day 15) the supplemental grace period runs out because you chose not to purchase
and install more licenses. Users cannot make new connections if doing so requires more than 1000
licenses to be checked out. You cannot re‑enable the supplemental grace period until you purchase
and install more licenses.

Overdraft and supplemental grace period availability

The following table lists the support for licenseoverdraftandsupplemental graceperiod for eachprod‑
uct. For more information, see Products and license models.

On‑premises product License type 10% Overdraft
Supplemental Grace
Period (15 days)

Citrix Virtual Apps and
Desktops

User/device, User,
Device

Yes Yes

Citrix Virtual Apps and
Desktops

Concurrent No Yes

XenMobile Server User, Device Yes No

Citrix on‑premises subscription for annual and term‑based retail licenses

On‑premises subscription licensing allows customers to host a Citrix environment within their infra‑
structure for a set period. The on‑premises subscription license is time‑bound for 1‑5 years and ex‑
pires on a specific date. The license ceases to operate following the expiration date. The products
offer everything that is available today with perpetual licenses.

Your purchase includes both an on‑premises subscription license and Customer Success Services Se‑
lect service. Customer Success Select service is included for the entire term of the subscription.

Note:

Mixing permanent (perpetual) and subscription licenses is supported. They can be used to
expand existing environments provided customers use the same product, edition, and license
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model. There are no performance impacts to using perpetual vs. subscription licenses. The
only difference between them is one expires.

Before license expiration

Citrix notifies you at certain intervals when your existing subscription approaches expiration. These
notifications alert you to extend the subscription and avoid service interruption.

When your on‑premises subscription expires, as per the date listed in the Citrix LicensingManager, no
new connections are allowed. Existing users are not impacted, however, if users log off or disconnect
they are not allowed to reconnect.

Extend on‑premises subscription licenses

To extend your on‑premises license subscription, visit https://www.citrix.com/buy/.

Note:

Licenseswith a future start date are not displayed in the License Server inventory until the actual
start date mentioned in the license file.

FAQs

• Will on‑premises subscription licenses workwith existing perpetual licenses on the same
server?

Yes, within the guidelines of existing license server operation. Customers must add a new term
license file to the license server.

Term or subscription licensing does not have a negative impact on delivering the on‑premises
subscription licenses to a customer’s existing environment, provided the product version
(Virtual Apps / Virtual Apps and Desktops), edition (Standard, Advanced, Premium), and type
(User/Device, Concurrent) are the same. For example:

– Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Premium Concurrent term have no issues.

– Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Premium User/Device term. This license combination is non‑standard and requires con‑
sideration andmore configuration. This combinationmight not be optimal for license uti‑
lization.
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– Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Advanced User/Device term. This license combination is non‑standard and not advisable.
Requires customer to have multiple sites or farms to use all purchased licenses.

• Will the XenApp farm, Citrix Virtual Apps, Citrix Virtual Apps & Desktops stop accepting
connections?

Yes. No new connections are allowed after the license expires. Existing connections are not
impacted until users disconnect, logoff, or reset.

• Will there be a supplemental grace period (SGP) of 15 days or does that only apply to per‑
petual licenses?

No. There is no grace period for license expiration. An extra month is added into the expiration
date for customers to install repurchased licenses.

Transition and Trade‑Up (TTU) with Citrix Universal Subscription

January 23, 2024

Transition and Trade‑Up

• Transition is when you move your current on‑premises licenses to the cloud or Universal ver‑
sion of the same product or edition. For example, you move from Citrix Virtual Apps and Desk‑
tops Advanced on‑premises to Citrix Universal Advanced Plus.

• Trade Up is when you exchange your current on‑premises licenses or cloud subscriptions to a
new product or a higher‑level product edition. For example, you move from Citrix Virtual Apps
and Desktops Advanced on‑premises to Citrix Universal Advanced Plus.

Note:

The main difference between Transition and Trade Up regarding Citrix licensing is that
Transition allows you to move your current on‑premises licenses to the cloud or Univer‑
sal version of the same product or edition, while Trade Up allows you to exchange your
current on‑premises licenses or cloud subscriptions to a new product or a higher‑level
product edition.

For example:

– Transition: Consider that you are currently running Citrix Virtual Apps and Desktops
on‑premises and you want to move to Citrix Virtual Apps and Desktops on Azure. You
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can use Transitionto move your existing licenses to the cloud without having to pur‑
chase new licenses.

– Trade Up: You are currently running Citrix Virtual Apps and Desktops Advanced on‑
premises and you want to upgrade to Citrix Virtual Apps and Desktops Premium. You
can use Trade Up to exchange your existing licenses for new licenses at a discounted
price.

• Transition and Trade‑Up (TTU) is a combination of both Transition and Trade‑up where you
move your current on‑premises licenses to the cloud and exchange these licenses for a higher‑
level product edition. For example, you move from Citrix Virtual Apps and Desktops Advanced
on‑premises to Citrix Universal Premium Plus.

An on‑premises customer can move their existing deployments of eligible Citrix products to Citrix
DaaS or Citrix Universal subscriptions through the Transition and Trade‑Up (TTU).

Transition and Trade‑Up terms and limitations

• Youmust have a minimum of 250 U/D or 100 CCU licenses in your account.
• You must have an active Customer Success Services entitlement in effect at the time of your
Transition, Trade Up, or TTU transaction.

• The on‑premises licenses which are the subject of the Transition, Trade‑Up, or TTU are re‑
scinded upon the purchase. The rescinded licenses are replaced with term‑based on‑premises
licenses corresponding to the product, edition, and license model of the cloud or Universal
license (destination).

• For offerings specific to Transition and Trade‑Up, check with your Citrix sales representative or
partner for more information.

• Formore information about how to start your transition fromon‑premises to cloudorUniversal,
contact your account Customer Support Manager.

Citrix Universal Subscription Licenses

Universal Subscription licenses give you the ability to be licensed and supported on your traditional
on‑premises Citrix software and Citrix Cloud services at the same time. With the Citrix Universal Sub‑
scription, you can transit to Cloud gradually or configure a hybrid deployment while running your
on‑premises deployment in parallel without the on‑premises infrastructure.

If you have Citrix perpetual licenses and you transition or trade‑up to Citrix Universal subscription
licenses, Citrix rescinds your on‑premises perpetual licenses. The on‑premises perpetual licenses
are replacedwith the term‑based on‑premises licenses corresponding to the product, edition, license
model, and termduration of the Citrix DaaS service. Rescinded licensesmust be deleted fromLicense
Servers. For more information, see Deleting license files.
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Users or devices covered by your Citrix Universal license subscription might use both their on‑
premises term licenses and their Citrix Cloud subscription licenses at the same time. For example,
if you have Citrix Virtual Apps and Desktops Advanced (CCU) on‑premises licenses and you trade
up to Citrix Universal Premium (User/Device), you get on‑premises Citrix Virtual Apps and Desktops
Advanced entitlements (User/Device) along with Citrix DaaS Premium subscription licenses for each
user.

Universal Subscription licenses do not require you to transition your environment from on‑premises
to cloud by the end of their term. You might operate in a hybrid capacity throughout the duration of
the subscription. Customer Success Services (support and maintenance) is included in the subscrip‑
tion during the term.

Hybrid Rights Renewals

Before Citrix Universal licenses were available, customers were able to purchase hybrid rights
to enable access to both on‑premises and Citrix Cloud licenses. Hybrid Rights were term‑based
on‑premises subscription licenses. These licenses were provided in addition to the cloud service
subscription when an on‑premises customer transitioned or traded up from an on‑premises license
to a cloud service subscription. Citrix rescinded your on‑premises perpetual licenses and replaced
themwith term‑based on‑premises licenses. This replacement is done corresponding to the product,
edition, licensemodel of the cloud service. It is for the duration defined under the applicable Cloud or
Hybrid Rights SKUs. Hybrid Rights subscriptions provided access to both your on‑premises andCloud
resources at the same time. Only those users or devices covered by your Citrix Cloud subscription
are able to use the Hybrid Rights on‑premises term licenses to connect to the Citrix Cloud Services.

Note:

Citrix Virtual Apps and Desktops do not support mixed editions in a single site but do support
mixed products andmodels. For more information, see Multi‑type licensing.

System requirements for Citrix Licensing

December 17, 2023

Requirements for Licensing

Citrix Licensing is compatible with the same hardware required to support the compatible operating
systems. Extra hardware is not required.
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Notes:

• We do not support running third party vendor daemons on the Citrix License Server, or the
Citrix vendor daemon on third party license servers.

• TheLicenseServerdoesnot supportmulti‑homing (twonetworkcardsplugged intodistinct
networks).

• TheCitrix LicensingManager installs licenses only on the LicenseServerwhere it is installed.

• License Servers don’t communicate with each other.

Operating system:

You can install the License Server on servers running the following Microsoft operating systems. We
recommend that you install the latest Microsoft Service Pack and updates.

• Windows Server 2022 Family
• Windows Server 2019 Family
• Windows Server 2016 Family

Server Core installations are not supported.

Disk space requirement:

• Minimum 8 GB RAM
• 500 MB for the licensing components
• 2 GB for user/device licensing
• More disk space might be required based on the retention period of historical data that config‑
ured in the Citrix Licensing Manager. For more information, see Historical use.

• More disk space might be required if you choose to manually upload the compliance data with
Citrix. For more information, see Citrix Licensing Telemetry.

Microsoft .NET Frameworkminimum requirements:

• Microsoft .NET Framework 4.7.2

Cluster platforms:

• Windows Server 2022 Family
• Windows Server 2019 Family
• Windows Server 2016 Family

Browsers:

We tested the following browsers. Other browsersmightwork, but all functionalitymight not be avail‑
able.
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• Microsoft Edge
• Mozilla Firefox
• Google Chrome
• Safari

What’s next

• Get started, install, and configure the License Server

Get started, install, and configure the License Server

December 18, 2023

Important:

• We do not support running third party vendor daemons on the Citrix License Server, or the
Citrix vendor daemon on third party license servers.

• We recommend that you run the latest version of the License Server. We do not provide hot‑
fixes for License Server components and don’t support older License Servers with newer
products. The latest version of the License Server often contains resolutions to issues ap‑
pearing in earlier versions. When you upgrade or install new Citrix products, upgrade the
licensing components as well. New License Servers are backward compatible and support
older products and license files. However, new products often require the newest License
Server to check out licenses correctly. You can find the latest version from the Citrix Down‑
loads site.

To see the new features in this release, go to What’s new.

• We don’t support installing the License Server from a UNC path (\\\\server\share).
Install the License Server from a local copy.

Step 1 Review your prerequisites

Ensure you review the system requirements before you install and configure your License Server.

Step 2 License your product

Licensing your product includes the following steps:
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1. Ensure that you have the latest License Server version.
2. Verify the system requirements.
3. Install licensing.
4. Obtain license files fromMy Account or if you have a license code, use the Citrix Licensing Man‑

ager.
5. Install your Citrix product (or, if already installed, restart the Citrix products for the new licenses

to be recognized).
6. Configure product‑side licensing communication settings that were not set during the product

installation, if applicable. This configuration includes setting the correct product‑edition in the
product. For more information, see Licensing elements and Services.

Ensure that the product‑side edition setting correctly matches the licenses you have purchased. For
example, if you purchased Premium edition licenses, ensure that the edition setting in the product
indicates Premium and not Advanced.

For an overview of the licensing components and process, see Technical overview and Licensing ele‑
ments.

Important:

The License Server does not require domain membership. You can install the License Server in
a workgroup and still perform all licensing functions on behalf of Citrix products. To manage
Citrix LicensingManager users having Active Directory users or groups, the usersmust be part of
a domain. Otherwise, use local Windows users and groups.

Step 3 Check your security and firewall

Security considerations

We recommend that you upgrade the License Server to the latest version when you upgrade or install
new Citrix products. The new License Servers are backward compatible and support older products
and license files. Each time a new License Server is released, it might contain better security features
than in previous versions. We also recommend the following security considerations when you con‑
figure your environment.

• Configure the License Server environment so that only authorized administrators on a trusted
network can access the Citrix Licensing Manager. You achieve this outcome by using an appro‑
priately configured network or host‑based firewall.

• Whenusing theCitrix LicensingManager, avoid visiting untrustedwebsites or clicking untrusted
URLs.
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Important:

Citrix License Server uses Microsoft Active Directory for authentication. Citrix strongly recom‑
mends that you implement good security practices in Microsoft Active Directory (like account
lockout and password management) to securely deploy Citrix License Server. For more infor‑
mation, see the Account lockout threshold and Password must meet complexity requirements
articles.

Firewall considerations

Determine if you require a firewall between the License Server and any product servers before in‑
stalling licensing. Firewall considerations can impact where you install the License Server.

If you have hardware firewalls in your environment, youmust create the necessary rules manually.

If there is a firewall between your product and the License Server, configure port numbers. This con‑
figuration process entails:

• Determiningwhich port numbers to change. You can change port numbers during the instal‑
lation process or afterward.

• Opening up the firewall ports. Open any ports on the firewall that you changed so that traffic
can flow. Current releases configure the built‑in firewall automatically.

• Changing the product‑side settings. Configure your Citrix product to use the same port num‑
bers as in the Citrix Licensing Manager. If you do not change the port number referenced in
the product, the product cannot contact the License Server. You can change the product‑side
settings during and after installation of the product. See your product documentation for infor‑
mation about these settings.

For more information about allowing required URLs and ports through the firewall and a list of open
URLs, see Register and remove registration with Citrix Cloud.

For more information about allowing telemetry data upload, see Reporting options.

Step 4 Install licensing components, server, and certificate

Note:

During installation, localized characters in the installation path can cause the installation to fail.
Accept the default installation path or type only ASCII alphabetic letter characters for the instal‑
lation directory.

You can install licensing components on a separate, dedicated server or on a server they share with
another application. Alternatively, you can use a web or application server. However, the locations
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mentioned later in this article are less resource intensive. If you are running fewer than 50 servers or
10,000 licenses, you can install the License Server on the same server as your product. To determine
if relocation of the License Server to another system is necessary, monitor CPU and memory load
(lmgrd.exe and CITRIX.exe).

Important:

Use the CitrixLicensing.exe file for all future installations, except for Active Directory de‑
ployments. In that case, use the .msi. Ensure that both .exe and .msi files are present for the
installation.

Install the License Server and console using the graphical interface

1. Download the License Server from Citrix downloads and start the License Server installer,
CitrixLicensing.exe, as an administrator or a member of the administrators group.

2. Follow the installer on the GUI to accept the destination folder.
Licensing components are installed in C:\Program Files\Citrix\Licensing on
a 32‑bit computer and C:\Program Files (x86)\Citrix\Licensing on a 64‑bit
computer.

3. On the Configure page, accept, or change the default port numbers used by licensing com‑
ponents. Choose whether to allow the installer to configure the Windows Firewall exception.
If needed, you can change the port numbers after the installation. If you choose to finish the
installation without configuring the License Server, restart the CitrixLicensing.exe
installer. You can also use the License Server Configuration tool to configure the settings after
the installation.
Open the configuration tool from: C:\Program Files\Citrix\Licensing\LS\
resource\Licensing.Configuration.Tool.exe.

• License Server port number is 27000
• Vendor daemon port number is 7279
• Citrix Web Services for Licensing port number is 8083

4. The License Server adds the default administrator for the Citrix Licensing Manager based on
how you are logged on. If you are in a domain, the License Server adds the installing user (do‑
main\user) as a default License Server or a Citrix Licensing Manager administrator. If you are a
local Windows user, the License Server adds the installing user (computer\user) as a default ad‑
ministrator account. The BUILTIN\administrator group, which allows any administrator toman‑
age licensing, is added by default. You can remove BUILTIN\administrators to restrict licensing
to specified users.

5. Choose to start the Citrix LicensingManager andwhether to join the Citrix Customer Experience
Improvement Program.
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Install licensing using the Windows command line

Important:

The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP)
and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home. Citrix
collects basic licensing data as necessary for its legitimate interests, including license compli‑
ance. For more information, see Citrix Licensing Compliance.

When using the CitrixLicensing.exe command to install licensing, set properties by adding
Property=value on the command line anywhere except between an option and its argument.

Ensure that you run the command line with administrator privileges. To start the command prompt
with elevated privileges, choose Start, right‑click Command Prompt, and choose Run as adminis‑
trator.
The following sample command line installs licensing in silent mode. Add the properties you want to
set.
Type the command in one line without returns. The following example is in multiple lines because of
space limitations.

CitrixLicensing.exe /quiet /l install.log INSTALLDIR=installdirectory
WSLPORT=port_number LSPORT=port_number VDPORT=*port_number CEIPOPTIN

=value

Where:

• /quiet specifies a silent (quiet) installation.

• /l specifies the log file location

• INSTALLDIR is the location where the License Server executable is stored. Optional parame‑
ter. The default is c:\program files\citrix\licensing or c:\program files
(x86)\citrix\licensing.

• WSLPORT is the port number used for Citrix Web Services for Licensing. Optional parameter.
The default is 8083.

• LSPORT is the port number used for the License Server. Optional parameter. The default is
27000.

• VDPORT is the port number used for the vendor daemon. Optional parameter. The default is
7279.

• CEIPOPTIN specifies whether, or how, to opt in to the Citrix Customer Experience Improvement
Program (CEIP) or Call Home. Optional parameter. The default is NONE.

– DIAGNOSTIC ‑ Call Home
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– Unidentified ‑ CEIP
– NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Using the command line to install licensing for an Active Directory deployment

When using the msiexec command to install licensing, set properties by adding Property=”value”on
the command line anywhere except between an option and its argument. Clustering is not supported
in the .msi.

Note:

Ensure that you run the command line with administrator privileges. To start the command
prompt with elevated privileges, choose Start, right‑click Command Prompt, and choose Run
as administrator.

The following sample command line installs licensing in silent mode and creates a log file to capture
any information about this operation. Add the properties you want to set after the switches.

Type the command in one line without returns. The following example is in multiple lines because of
space limitations.

msiexec /I ctx_licensing.msi /l*v install.log /qn INSTALLDIR=installdirectory
LICSERVERPORT=port_number VENDORDAEMONPORT=port_number MNGMTCONSOLEWEBPORT

=port_number WEBSERVICESLICENSINGPORT=port_number CEIPOPTIN=value

Where:

• /l*v is the location of the setup log. Optional parameter.

• /qn specifies a silent (quiet) installation.

• INSTALLDIR is the location where the License Server executable is stored. Optional parame‑
ter. The default is c:\program files\citrix\licensing or c:\program files
(x86)\citrix\licensing.

• LICSERVERPORT is the port number used for the License Server. Optional parameter. The de‑
fault is 27000.

• VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter.
The default is 7279.

• WEBSERVICESLICENSINGPORT is the port number used for the CitrixWebServices for Licensing.
Optional parameter. The default is 8083.

• CEIPOPTIN specifies whether, or how, to opt in to the Citrix Customer Experience Improvement
Program (CEIP) or Call Home. Optional parameter. The default is NONE.
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– DIAGNOSTIC ‑ Call Home
– Unidentified ‑ CEIP
– NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Using the command line to enable or disable the License Management Service

TheLicenseManagementServiceoperatesautomaticallywithin theLicenseServer andallows for elec‑
tronic reportingofbasic licensingdata. Youcanopt formanual reportingafter installationbydisabling
License Management Service. For information onmanual reporting, see Reporting options.

Syntax:

ctx_license_management_service.exe (-enable | -disable | -query)

Where:

• ‑enable enables electronic reporting of basic licensing data. The first upload to Citrix occurs
seven days after you install the License Server.

• ‑disable disables electronic license reporting of basic licensing data. If you disable electronic
license reporting, you agree to manual reporting.

• ‑query displays the current configuration.

Manually install a certificate used by the Citrix Licensing Manager andWeb Services
for Licensing

Note:

Use this procedure if you don’t want to use the self‑signed certificate that is generated during
installation.

To install a certificate, there are three steps:

1. Obtain a .pfx file, which contains the certificate andprivate key. You canuseoneof twomethods
to obtain the .pfx file.

2. Extract the certificate and private key from the .pfx file.
3. Install the certificate and private key on to the License Server.

How to obtain the .pfx file using a domain certificate ‑ Method 1

Log on to a server in the domain, open theMMC, and follow these steps:

1. Create a directory c:\ls_cert to hold the exported .pfx file.
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2. Add theCertificate snap‑in by selectingFile >Add/RemoveSnap‑in >Certificates >Computer
account > Local computer.

3. In the left pane under Certificates, right‑click Personal and choose All Tasks > Request New
Certificate, and thenNext.

4. In the Certificate Enrollment Policywizard, choose Active Directory Enrollment Policy, and
thenNext. Select the check box next to Computer, and select Details to the right.

5. Select Properties and on the General tab, type a friendly name and description.
6. On the Subject tab, under Subject Type, choose Common name from the Typemenu. Type a

friendly name in the text box, choose Add, and then Apply.
7. On the Extensions tab, choose Key usage from the menu. Add Digital signature and Key en‑

cipherment to the Selected options box.
8. On the Extended Key Usagemenu, add Server Authentication and Client Authentication to

the Selected options box.
9. On thePrivateKey tab andunder theKey optionsmenu, ensure that theKey size is 4096. Select

the Key Exportable check box, and then Apply.
10. On the Certification Authority tab, ensure that the CA check box is selected, and then OK >

Enroll > Finish.
11. In the Certificates console, select Personal > Certificates, choose the certificate you built. Se‑

lect All Tasks > Export > Next, and select the Yes, Export the Private Key radio button, and
thenNext.

12. Under Personal Information Exchange ‑ PKCS #12(.PFX), select the check box to include all
certificates, chooseNext, create a password, and choose Next.

13. ClickBrowse, navigate toC:\ls_cert and typeserver.PFX, and then follow thewizard to
finish.

How to obtain the .pfx file sending a request to a certificate authority (CA) –Method 2

These steps might vary based on your Certificate Authority.

1. Log on to the License Server, open the MMC, and follow these steps:

a) Add theCertificate snap‑in by selectingFile >Add/RemoveSnap‑in>Certificates >Com‑
puter account > Local computer.

b) In the left pane under Certificates, right‑click Personal and choose All Tasks > Advance
Operations > Create Custom Request, and thenNext.

c) In theCertificateEnrollmentPolicywizard, chooseProceedwithoutenrollmentpolicy
under Custom Request, and then Next.

d) On the Custom request screen, choose (No template) CNG key from the menu and
PKCS#10 for the Request format, and thenNext.

e) On the Certificate Information screen, choose Details and then Properties.
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f) On the General tab, type a friendly name and description.
g) On the Subject tab, under Subject name, choose Common name, and type a value in the

text box.
h) On the Extensions tab, choose Key usage from themenu, addDigital signature and Key

encipherment.
i) On the Extensions tab, choose Extended Key usage from themenu, add Server Authen‑

tication and Client Authentication.
j) On the Private Key tab, under Cryptographic Service Provider, choose RSA, Microsoft

Software Key Storage Provider (the default). From the Key options menu, ensure that
the key size is 4096, select the Key Exportable check box, and then Apply.

k) Save the file to a .req file, submit the .req file to a Certificate Authority (CA), and save the
.cer file.

2. In theMMC, under Certificates, right‑click Personal and choose All Tasks > Import. In the Im‑
port wizard, select the .cer file.

3. Create a directory c:\ls_cert to hold the exported .pfx file.

4. In the Certificates console, choose Personal > Certificates, and choose the certificate you im‑
ported. Select All Tasks > Export > Next, and select the Yes, Export the Private Key radio
button andNext.

5. Under Personal Information Exchange ‑ PKCS #12(.PFX), select the check box to include all
certificates, chooseNext, create a password, and then choose Next.

6. Choose Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to fin‑
ish.

How to extract the certificate and private key

This step requires OpenSSL or another tool that allows you to extract the certificate and private key
from a .pfx file. The version of OpenSSL shipped with the License Server does not support extracting
certificates and private keys. For information about downloading OpenSSL, go to www.openssl.org.
Citrix recommends installing OpenSSL on a separate workstation to perform these steps:

1. Navigate to the <openssl directory>\bin folder.

2. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.crt -
nokeys

Note:

The License Server uses only the .crt certificate format.

3. Type the password created during the export process (password).

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 103

https://www.openssl.org/


Licensing 11.17.2 build 48000

4. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.key -
nocerts -nodes

5. Type the password created during the export process (password).

How to install the .crt and .key files on the License Server

Windows ‑ Web Services for Licensing:

1. Stop the Citrix Web Services for Licensing service.
2. Copy the server.crt and server.key created earlier in this procedure to c:\program files

(x86)\citrix\licensing\WebServicesForLicensing\Apache\conf\.
3. Start the Citrix Web Services for Licensing service.

Windows ‑ License Administration Console:

Note:

• License Administration Console was removed from Windows License Server v11.16.6.0
build 31000 and onwards. For more information, see What’s new.

• License Server VPX still uses the License Administration Console.

1. Stop the Citrix licensing service.
2. Copy the server.crt and server.key created earlier in this procedure to c:\Program Files

(x86)\Citrix\Licensing\LS\conf.
3. Start the Citrix licensing service.

Step 5 Configure a proxy server

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you configure
a proxy server, requests to download licenses and upload telemetry data are sent through a proxy
server. If the automatic upload of data fails, check the firewall setting or configure a proxy. For more
information, see Citrix Licensing Telemetry documentation.

StartingwithLicenseServer version11.17.2.0build43000, youcanviewandconfigureproxy server set‑
tings from the Citrix Licensing Manager UI. For more information, see Configure a proxy server within
Citrix Licensing Manager.

Important:

Citrix Licensing components requiring outwardboundwebcommunications can inherit network
proxy settings usingWindows automatic proxy detection. Wedonot support authenticatedprox‑
ies. For more information about Windows automatic proxy detection, see WinHTTP AutoProxy
Functions.
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How to configure a proxy server manually

1. Edit the SimpleLicenseServiceConfig.xml file, which is in the <Citrix Licensing>\
WebServicesForLicensing directory.

2. Add a line of xml to the file in the format <Proxy>proxy server name:port number
</Proxy>

Important:

The .xml tags are case‑sensitive.

1 <Configurations>
2 <EncoreConfiguration>
3 <SamplingPeriod>15</SamplingPeriod>
4 <RetentionTime>180</RetentionTime>
5 <Enabled>true</Enabled>
6 </EncoreConfiguration>
7 <Proxy>10.211.55.5:808</Proxy>
8 </Configurations>
9 <!--NeedCopy-->

Next steps

• Citrix Licensing Manager
• Product specific licensing guides

Prerequisites to obtain your license files

December 17, 2023

After you install the licensing components, you are ready to obtain your license files.

You can obtain your license files in several ways:

• Studio in Citrix Virtual Apps and Desktops. For more information, see Citrix Virtual Apps and
Desktops Licensing.

• Citrix Licensing Manager.
• MyAccount on citrix.com. For more information, see Manage Licenses on citrix.com.

Ensureyouhave the following information ready, beforegoing to theCitrixwebsite toget yourproduct
licenses:

• Your user ID and password forMy Account.
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• The license access code. You can get this code inMy Account on citrix.com or in an email you
receive from Citrix.

Note: If you cannot locate the license access code or license you purchased, contact the Citrix
Customer Service.

• Thehostnameof the License Server onwhich you installed the licensing components. The
License Server hostname is case‑sensitive, so ensure that you copy the name exactly as it ap‑
pears on the system.

Select the down arrow in the top bar of the Citrix Licensing Manager screen to find the License
Server hostname, Ethernet address, and IPv4 address. You can also run the hostname com‑
mand at a command prompt on the License Server.

• Howmany licenses you want to include in the license file. You do not have to download all
the licenses you are entitled to at once. For example, if your company purchases 100 licenses,
you can allocate and download only 50 now. Later, you can allocate the rest in another license
file. You can have more than one license file based on the number of licenses allocated.

Customer Success Services

December 17, 2023

Your purchase of a new Citrix product includes a one‑yearmembership in Customer Success Services.
This membership entitles you to all product updates, along with other benefits. These updates in‑
clude all releases during your membership period.

After your initial one‑year membership period expires, renew your Customer Success Services mem‑
bership by paying Citrix for your renewal. Use the Citrix Licensing Manager to install your renewal
licenses. You can go to citrix.com and download a license file that has your renewal license.

Important:

A Customer Success Services membership and its license are distinct from your license to run
the product. Your Citrix products don’t stop working if you don’t renew your Customer Success
Services membership. But you are not entitled to any software release after it expires.

Customer Success Services renewal licenses

Customer Success Services renewal license files contain licenses, known as renewal licenses that ex‑
tend your Customer Success Services membership for a one‑year period. These licenses are required
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to run all new product releases, excluding hotfixes, that are released during your membership pe‑
riod.

If you do not add the Customer Success Services renewal license immediately, your Citrix products
do not stopworking. However, you cannot run any new software released during your renewedmem‑
bership until you have the renewal license on your License Server.

If Citrix releases a product version after your Customer Success Servicemembership ends, renew your
CustomerSuccessServicesmembership. Obtaina renewal licensebeforeyoucanuse thenewproduct
version.

Example:

Before you upgrade to any of the Citrix Virtual Apps and Desktops releases, ensure that your current
Customer Success Services dates are valid and have not expired. Citrix Virtual Apps and Desktops
releases use a year‑month date format (YYMM). Ensure that the date in your license is equal or newer
than the product release date. For a comprehensive list of release dates, see Citrix Product Customer
Success Services Eligibility Dates.

When you renew your Customer Success Services membership, you can use the renewal license fea‑
tures of the Citrix Licensing Manager. For more information see, Update licenses.

Note:

When you download more license files, you can delete the expired Customer Success Services
licenses. However, it is not a requirement. You might want to keep them to make it easier to
identify the upgrade that is associated with each base license.

Find out your Customer Success Services dates by using Citrix Licensing Manager, or view the license
file in the text editor.

Check for and install Customer Success Services renewal licenses with the Citrix
Licensing Manager

Whenenabled, theCitrix LicensingManager contactsCitrix.comwebservicesweekly to check for avail‑
able Customer Success Services renewal licenses.

Based on your configuration, the Citrix LicensingManager automatically checks for Customer Success
Services renewal licenses, or allows you to checkmanually. It notifies you or installs the licensewhen
found.

1. In the Citrix Licensing Manager, click Settings in the upper right of the UI.
2. Choose how you want to be notified and if you want renewal licenses to be automatically in‑

stalled.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 107

https://support.citrix.com/article/CTX111618
https://support.citrix.com/article/CTX111618
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/update-licenses.html
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager.html


Licensing 11.17.2 build 48000

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting
or configure a proxy. For this feature to work, the License Server must be able to access https://citrix
services.citrix.com. For more information, see Configure a proxy server manually.

Note:

You can also configure the ports, the supplemental grace period, and the language on this page.

• Automatically check for Customer Success Services renewal licenses and notify when
available: Citrix Licensing Manager displays a notification. Click the link to download and
install the available renewals. This same notification appears in Studio and Director if they are
configured to manage the License Server.

• Automatically check for and install Customer Success Services renewal licenses when
available: Citrix Licensing Manager checks weekly and automatically installs renewal licenses
when available. A notification displays for a few days stating that renewals have been installed.

• Manually check for Customer Success Services renewal licenses: Select the Update
Licenses tab and Check for Available Renewals. You can check the Update Licenses tab at
any time to see a list of licenses installed in the last 30 days.

Citrix Licensing Manager

December 6, 2023

The Citrix Licensing Manager is a web‑basedmanagement console for Citrix Licensing. It enables the
License Server features using a simple web interface. For more information on the functions you can
perform using the Citrix Licensing Manager, see the Citrix licensing technical overview.

The Citrix Licensing Manager is installed on the license server. You can only use it to manage the
license server onwhich it is installed. The CitrixWeb Services provide the functionality for the Licens‑
ingwindows service.

Access the Citrix Licensing Manager using the link https://*LicenseServerName:WSLPort*.
The default WSL Port is 8083.
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The Citrix Licensing Manager screen displays the following details:

• The License Server version in the top bar of the screen. You can also view the host name, Ether‑
net address, and IPv4 address, from the drop‑down list in the titlebar.
by selecting the down arrow at the top right of the Citrix Licensing Manager screen.

• Important notifications of license availability, expiration, and other conditions. You can view
these notifications by selecting the bell icon at the top of the Citrix Licensing Manager screen.

The Citrix Licensing Manager also allows you to perform the following actions:

• Configure Customer Success Services renewal license actions. You can specify the following
actions:

– Download and install licenses automatically,
– Check for the available renewals and notify, or
– Manually install the licenses.
For more information on configuring this feature, see Check for and install Customer Suc‑
cess Services renewal licenses with the Citrix Licensing Manager.

• Store and export historical usage reports from the License Server. You can specify a date range
for the historical usagedata and export it to aCSV file. TheCSV file provides daily usage informa‑
tion including the number of licenses in overdraft. For information about exporting historical
usage data, see Historical Use.

Awhat’s newmodal window

From version 11.17.2 build 37000, when you launch the Citrix Licensing Manager, a modal window
appears that provides information about:

• New features that are available on your Citrix Licensing Manager

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 109

https://docs.citrix.com/en-us/licensing/current-release/customer-success-services.html#check-for-and-install-customer-success-services-renewal-licenses-with-the-citrix-licensing-manager
https://docs.citrix.com/en-us/licensing/current-release/customer-success-services.html#check-for-and-install-customer-success-services-renewal-licenses-with-the-citrix-licensing-manager
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/dashboard-historical-use.html#historical-use


Licensing 11.17.2 build 48000

• Features that are alreadyavailable, but currently disabledonyourCitrix LicensingManager. You
can enable these features directly from themodal window.

For example, the Citrix Licensing Manager automatically detects that your License Server isn’t regis‑
tered with Citrix Cloud and prompts you to register.

Citrix recommends that you enable features that are disabled when prompted. Doing so enhances
your user experience and improves the way youmonitor your license usage.

TheCitrix LicensingManageralsodisplaysalertmessages fornetwork‑related issuesand recommends
steps to mitigate them.
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Where to go next

• Dashboard: View details about the installed, in‑use, available licenses, expiration date of li‑
censes, and Customer Success Services dates.
For more information, see the Dashboard.

• Historical use: Review and export data related to products, licensemodels, and Customer Suc‑
cess Services (Subscription Advantage) dates.
For more information, see Historical Use.

• Install licenses: Install license files on the License Server using a license access code or down‑
loaded file. View details of licenses after they are installed.
For more information, see Install licenses.

• Update licenses: Check for, download, install, andupdate available Customer Success Services
renewal licenses.
For more information, see Update licenses.

• Settings: Modify settings related to user and group accounts, server configuration, and usage
and statistics data. For more information, see Settings.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 111

https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/dashboard-historical-use.html#dashboard
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/dashboard-historical-use.html#historical-use
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/install.html
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/update-licenses.html
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/settings.html


Licensing 11.17.2 build 48000

Dashboard and Historical Use

December 5, 2023

Dashboard

The Dashboard in Citrix Licensing Manager provides information about the product edition, model,
installed/in‑use status, and availability of your licenses.

To view detailed information about the licenses, click > for a particular license. The Citrix Licensing
Manager displays a table containing the following details of the license:

• Customer Success Services date
• Total installed licenses
• Overdraft
• Licenses in use
• Available licenses
• Expiration date
• Type
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Historical Use

The Historical Use feature in the Citrix Licensing Manager allows you to store and export historical
usage reports from the Licensing Server. The default retention period is one year. You can view and
specify the data retention period by selecting Change. Use the filters to export a License Server Prod‑
uct usage report as a CSV file.
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Export historical usage data

You can view and export the historical usage by performing the following steps:

1. Logon to theCitrix LicensingManager hostedon the LicenseServer. Type the followingURL into
abrowser installedona systemhaving access to the LicenseServer. Replace thehost namewith
your actual License Server host name in the URL.
http://License-Server-Hostname:8083/

2. Select Product & Edition,Model, and Customer Success Service Date. Enter a date range for
which you want to gather the history.

Note:

SelectingCustomerSuccess Servicesdate limits exporteddata to a specific pool of licenses
and does not accurately reflect the total number of licenses in use.

3. Select Export.
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4. Select Save > Save As on the browser download dialog to save the exported CSV file. The CSV
file provides daily usage information, including the number of licenses in overdraft.

Note:

Database usage snapshots are saved every 15 minutes.

Install licenses

December 5, 2023

The Citrix Licensing Manager gives you the following options to obtain your licenses:

• Use license access code
• Use downloaded license file

In theStartmenu, selectAllPrograms>Citrix>CitrixLicensingManager, or fromaremotemachine
use the https://licenseservername:8083 URL with your License Server name.

Use license access code

1. ChooseUse license access code, and enter the license access code provided by Citrix.

2. Click Display Licenses to see your license entitlements.

Select the license and the quantity to install.
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3. Select a product from the displayed list, type the number of licenses to install, and click In‑
stall. To select multiple products, click Install every time you select a product. The products
are processed in order of selection.

4. To display the newly downloaded licenses, click Dashboard.
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Use a downloaded license file

1. ChooseUse downloaded license file.

2. Choose a file.

3. Choose the check box to replace an older file with the same name.

4. Click Import.

The Citrix Licensing Manager displays information about the licenses.

5. After your license file is successfully uploaded to the License Server, a message displays. To
display the newly downloaded licenses, click Dashboard.

Note:

Avoid issues while uploading a license file by removing special characters in the file name.
Ensure that the file has an .lic extension (all lower case).

Allocating and downloading licenses

Consider the following points while using the Citrix Licensing Manager to allocate and download li‑
censes:

• As a prerequisite, ensure that you have internet access or a configuration with a proxy server.
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• Once you click Allocate > Download, you cannot cancel it. If this action fails, useMy Account
at citrix.com.

• TheCitrix LicensingManagerdoesn’t support redownloadingor reallocatingof license files. You
can return licenses on citrix.com and use the Citrix Licensing Manager to allocate them again.
For redownloading, useMy Account.

• If you rename the License Server, you must reallocate any license files allocated under the old
License Server name.

Update licenses

December 5, 2023

Install your Customer Success Services renewal licenses from theUpdate Licenses tab in the Citrix Li‑
censingManager. You can also see a record of the recently installed renewal licenses in the Customer
Success Services renewal licenses renewed in the last 30 days section.

To update the licenses

1. In the Customer Success Services renewal licenses available section, click Check for Avail‑
able Renewals.

2. Click Download and Install to install the license. For more information see the Use down‑
loaded license file section in Install licenses.
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Product information

December 5, 2023

In this release of Citrix Licensing Manager, a new section about product information is added.

In the Citrix Licensing Manager UI, click the Product Information tab. The following page
appears:

The Product Information page has the following two sections:

• License Server updates

– the most recent updates
– the last successful attempt for updates
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Note:

The License Server Updates section requires internet access to view the latest product
information.

• About this release

– the latest version of License Server available for download
– updates to open‑source software such as OpenSSL and Apache versions for a particular
release

– link to product documentation

Note:

The About this release section provides static text and doesn’t require internet access to
view the latest product information.

Settings

December 18, 2023

Modify and configure the following settings in the Citrix Licensing Manager:

• Account: Configure user and group accounts.
• Server configuration: Configure ports and Customer Success Services renewal license actions.
• Usageand statistics: Register your License ServerwithCitrix Cloudand configure thehistorical
data retention by selecting a retention period.

To configure these settings, click the settings icon on the top right corner of the title bar.
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Account

On the Account tab, configure users and group access for both local Windows users and groups and
Active Directory users and groups.

Note:

Active Directory users and groups are part of an Active Directory or network authentication sys‑
tem. To support them, ensure that theWindows License Server is amember of aMicrosoft Active
Directory domain.

Administrator and User roles

You can add theUser andGroup accounts with specific roles. User andGroup accounts createdwith
an Administrator role can:

• Choose a console display language.
• View system information.
• Add and remove users.
• Configure the License Server port.
• Configure the vendor daemon port.
• Configure the Web Services for Licensing port.
• Configure and add licenses.
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User and Group accounts created with a User role cannot log into Citrix Licensing Manger. These
accounts have only read‑only access to Licensing through Citrix Studio.

Note:

User as an account (red color) is different from User as a role (green color) as indicated in the
preceding image.

To add and remove users and groups

To add a user or a group, click Add, choose User or Group, enter Domain\Username, and then click
Finish.

To remove a user or a group, clickUser or Group from the list and then click Remove.

To edit the role of an existing user or group, click the edit button, choose the role, and clickUpdate.
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Server configuration

Use the Server Configuration setting to make the following changes:

• Configure the License Server, Citrix vendor daemon, and Web Services for Licensing ports.
• Configure a proxy server.
• Configure Customer Success Services renewal license actions.
• Enable and disable the Supplemental Grace Period.
• Choose the console display language.
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Configure port numbers

You can edit the following default ports:

• License Server. This port number is used by the Citrix Licensing Manager. License Server Man‑
ager handles the initial communication among the products, starts the Citrix vendor daemon,
and relays check out and check in requests to the vendor daemon. By default, this port number
is 27000.

• Citrix vendor daemon. This port number is used by the Citrix vendor daemon. The vendor
daemon is responsible for the coreoperationsof the LicenseServer, including licenseallocation.
By default, this port number is 7279. However, if you have a firewall or if the number is already
in use, youmust change the port number.

• Web Services for Licensing. Port used by the Web Services for Licensing. TheWeb Services
for Licensing hosts the Citrix Licensing Manager, so users connecting to the Citrix Licensing
Manageruse this port. Director andStudiouse this port to communicatewith theLicenseServer
usingWeb Services for Licensing. By default, this port number is 8083.

Configure a proxy server within Citrix Licensing Manager

Starting with License Server version 11.17.2.0 build 43000, you can view and configure proxy server
settings from the Citrix Licensing Manager UI. You can edit the settings to add, modify, or remove a
proxy server as needed.

Do the following to configure a proxy server:

1. In the Citrix Licensing Manager, click the Settings in the upper right of the UI.

2. Click Server Configuration.

3. Navigate to Configure a Proxy Server section.
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4. Click the Edit to configure a new proxy server or to update an existing proxy server.

5. Enter the proxy server name and proxy port number in the following format:

proxy server name:port number

For example: 10.211.55.5:808. (This port can be IPAddress:Port or Hostname:Port.)
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6. Click Save. The proxy server configuration is saved successfully.

Customer Success Services Renewals

This feature checks for alreadyavailable renewed licenses, andnotifies theyareavailable for renewals,
or automatically installs them. When enabled, the Citrix Licensing Manager contacts Citrix.com web
services weekly to check for available Customer Success Services renewal licenses.

You have the following options to renew Customer Success Services licenses:

• Automatically check for Customer Success Services renewal licenses and notify when
available

• Automatically check for and install Customer Success Services renewal licenses when
available

• Manually check for Customer Success Services renewal licenses

The check for available renewals is performedweekly. Tomanually update your license, clickUpdate
License > Check for Available Renewals. Check the Update License tab at any time to see a list of
licenses installed in the last 30 days.

Based on your configuration, the Citrix Licensing Manager does one of the following:

• Checks for Customer Success Services renewal licenses, notifies you, and installs the licenses
when found.

• Checks for Customer Success Services renewal licenses, and notifies you they are available to
be installed.

• Allows you to check manually.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting
or configure a proxy. For this feature to work, the License Server must be able to access https://citrix
services.citrix.com.

Supplemental grace period

You can use the Supplemental grace period feature to start the 15‑day supplemental grace period,
when you reach the regular license consumption limit. During the supplemental grace period, the
product allowsunlimited connections for 15days, enabling you to fix the issue. Ensure you check your
product documentation to determine if your product supports the supplemental grace period.

Language

You can change the default language of the Citrix Licensing Manager display, which applies to all the
console users. The following languages are available:
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• Chinese (Simplified)
• English
• French
• German
• Japanese
• Spanish

Support Bundle

A support bundle is a .zip file that contains information that required to troubleshoot and debug any
License Server issues by the Citrix support team. You can use this file to initiate a Citrix support call or
to provide documentation to Citrix or its agents for license compliance purposes. The .zip file gener‑
ated includes license activity and historical usage information, configuration information, a copy of
the licensing directory, license files, server logs, and usage and analytics data from Call Home, CEIP,
or Citrix License Management Service or both (in each case, if applicable).

To generate and download a support bundle, go to the Citrix Licensing Manager > Settings >
Server Configuration > Support Bundle. Click Generate and Download to download the bundle
(.zip file).

The support bundle contains various files. See the following table for a list of files that are of high
importance in the bundle:

File name Description

LS\conf Includes server configuration and certificates.

LS\logs Contains license server logs.

LS\resource\cache Contains user/device data, renewal database,
and vendor daemon extension data. There are
also upload result files that contain the status of
the last telemetry transfer.

LS\resource\Historical Contains Web Services for Licensing/Citrix
Licensing Manager analytics and historical use
databases.

LS\resource\usage Contains files included in the last compliance
and/or CEIP/Call Home upload bundle along
with corresponding .zip files for each program.

LS\MyFiles Contains all installed customer license files and
the CITRIX.opt (options file –contains LS
configuration).
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File name Description

WebServicesForLicensing SimpleLicenseServiceConfig.xmlWeb
Services for Licensing Configuration file.

WebServicesForLicensing\Apache\conf Contains Web Services for Licensing web server
configuration and certificates.

WebServicesForLicensing\Logs Contains Web Services for Licensing web server
logs.

Usage and statistics

Use theUsage and Statistics setting to do the following:

• Configure how you share usage statistics with Citrix Cloud. For more information see Share
usage statistics.

• Find out if your License Server is registered, or register your License Server with Citrix Cloud.

• Know the status of your uploads, and fix failed uploads.

• Force data upload to Citrix.

• Set the period to retain the historical usage information.
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Share usage statistics

The Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home usage and an‑
alytics programs are voluntary data collection programs that are designed to improve your product
experience. Call Home and CEIP are voluntary programs.

For more information about the statistics that are collected, see Citrix data collection programs.

Register your Citrix License Server

Use theRegister option in theUsage and Statistics section to register your Citrix License Server with
Citrix Cloud. Once registered, the screen indicates that you are registered. Use theRemove Registra‑
tion option if you want to remove the License Server registration. For more information, see Register
Citrix License Server with Citrix Cloud.
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Remove registration

There are reasons that youmight want to remove the License Server registrationwith the Citrix Cloud.
For example, you’ve registered your License Server to CompanyA, which is nowmerged into another
organization. You want to consolidate your license usage data into one Citrix customer account. To
do that, remove your registration, and then register with a new Citrix Cloud account. For more infor‑
mation, see Remove registration of your License Server.

Collect License Server event data

After you register your License Server with Citrix Cloud, you can choose to send your License Server’
s event data to Citrix. This option is enabled by default and is available only after registration. This
data is used todisplay information in customer‑facingdashboards. It’s also used toprovide alerts and
notifications about license expiry, license renewals, and supplemental grace period. For information
about the data elements that are sent to Citrix Cloud, see License Server event data.
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Upload Information
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This Upload information feature provides the status for the last CEIP, Call Home, or Citrix Service
Provider upload. You can force a data upload to Citrix without waiting for the daily upload. Click
Upload now to force a data upload to Citrix, when CEIP is enabled. For successful uploads, allow five
minutes between uploads.

If the upload fails, the Citrix Licensing Manager displays the troubleshooting information.

Historical Use

Use the Historical Use feature to choose the retention period to retain your License Server usage
information. The default historical use retention period is one year.

If there is an in‑place License Server upgrade, the historical data is backed up.

Register and remove registration of your Citrix License Server

December 20, 2023

Register your Citrix License Server

Register your Citrix License Server with Citrix Cloud, by using a short‑code activation process, using
the Register option in theUsage and Statistics section of the Settings.

Once registered, the screen indicates that you are registered, and you can use the Remove Registra‑
tion option to remove the License Server registration.

By registering the License Server with Citrix Cloud, you allow the License Server to collect and store
theCall Home licenseusage information. Youalso allow to regularly transmit this information toCitrix
Cloud.

For steps to register an on‑premises License Server, see Register on‑premises products with Citrix
Cloud.
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View the status of your Citrix License Servers to understand which ones are successfully reporting
usage and when they last reported usage to Citrix Cloud. For more information, see Monitor licenses
and usage for on‑premises deployments.

After your License Server is registered successfully in Citrix Cloud, you can view the details in the Citrix
Cloud UI.

Important:

Before registering your License Server with Citrix Cloud, use the firewall rules to open the follow‑
ing URLs:

https://trust.citrixnetworkapi.net:443

https://trust.citrixworkspacesapi.net:443

https://cis.citrix.com:443

https://core.citrixworkspacesapi.net:443

https://core-eastus-release-a.citrixworkspacesapi.net:443

http://ocsp.digicert.com:80

http://crl3.digicert.com:80

http://crl4.digicert.com:80

http://ocsp.entrust.net:80

http://crl.entrust.net:80

Ensure that the License Server can access the Certificate Revocation List server for DigiCert and
Entrust. The License Server checks the server to see if the required certificates are valid or re‑
voked.

Steps to register your License Server

To register your License Server by performing the following steps:

1. Navigate to Settings > Usage and Statistics.

2. Click Register to generate an 8‑character alphanumeric code.
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3. Select View details to view your License Server version, MAC ID, host name, and IP address.

4. Click Register. You’re navigated to the Citrix Cloud sign‑in page.

5. Enter your Citrix Cloud account credentials and navigate to Product Registration > Register.
Enter the 8‑character alphanumeric code, and click Continue.

6. Review the registration details and click Register. For more information, see Register
on‑premises products with Citrix Cloud.

Note:

If you’re not redirected to the Product Registration experience, do the following:

1. Go to citrix.cloud.com and sign in to Citrix Cloud.
2. Select your company, select Identity andAccessManagement>APIAccess tab>Product

Registrations from the select menu.

Remove registration of your License Server

If you want to register your license server with a different or new Citrix Cloud account, remove the
registration and re‑register the license server.

To remove your license server registration navigate to Settings > Usage and Statistics, and click Re‑
move Registration. Review and confirm the confirmation message.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 135

https://docs.citrix.com/en-us/citrix-cloud/citrix-cloud-management/citrix-cloud-on-premises-registration.html
https://docs.citrix.com/en-us/citrix-cloud/citrix-cloud-management/citrix-cloud-on-premises-registration.html


Licensing 11.17.2 build 48000

The registration of your License Server is removed from Citrix Cloud. You can now follow the steps to
register your license server and register with a new Citrix Cloud account.

Additional information

• How to enable License usage insight LUI

Manage Licenses on citrix.com

December 18, 2023

This article describes how tomanage licenses from the citrix.com site. You can useManage Licenses
on citrix.com to easily find, allocate, download, modify, return, hide, and unhide licenses.

Note:

You can perform several licensing actions from Citrix Studio and Citrix Licensing Manager.

To access Manage Licenses on citrix.com

1. From a web browser, go to http://www.citrix.com.
2. Select Sign In > My Account and type your user ID and password.
3. SelectManage Licenses.
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Note:

TheManage Licenses tab is visible only if you have the required permissions to access it.

Search for licenses

In the Find a license by…menu, choose the search criterion, type the search text, and select Search.
You can select Show advanced search options to narrow down your search further.

Allocate licenses

1. Select the licenses that youwant to allocate. The landingpagedisplaysonly new licenseswithin
30daysandexpiring term licenses. Youcanuse theFinda licenseby… search to findall licenses
using one of the search criteria and then the Filter by menu to narrow the display down to
specific types of licenses or you can selectQuick find: All active to see all licenses.

2. From the Select an actionmenu, choose Allocate licenses.

3. Enter the Binding ID (for example: Host name or Ethernet address) and how many licenses to
allocate, and click Create license file.

4. Select Yes, create license file. If you want to change before creating the license file, selectNo,
modify the allocation, andmake your change. Then select Yes, create license file.

5. Select Download license file, and save the file to a temporary location. Remember the file
name and location where you downloaded the file. You need this location.

6. Install the license. See Install licenses.
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Download licenses

1. Select the licenses that you want to download. The landing page displays only new licenses
within 30 days and expiring term licenses. You can use the Find a license by… search to find
all licenses using one of the search criteria and then the Filter bymenu to narrow the display
down to specific types of licenses or you can selectQuick find: All active to see all licenses.

2. FromtheSelectanactionmenu, chooseDownloadall licensesandsave the file toa temporary
location (mostly the downloads folder).

3. Copy the downloaded license files to the MyFiles folder:

• C:\Program Files\Citrix\Licensing\MyFiles on a 32‑bit computer
• C:\Program Files (x86)\Citrix\Licensing\MyFilesona64‑bit computer

Ensure that the license file retains the lower case .lic file name extension. Some copy processes
don’t recognize a file type for that extension andadda “.txt”file nameextensionduring the copy.
You can’t import license files that have the wrong file name extension.

4. Atacommandprompt, navigate to theC:\Program Files (x86)\Citrix\Licensing
\LS or C:\Program Files\Citrix\Licensing\LS folder and type the following
command:

lmreread -c @localhost -all

For more information about the lmreread command, see Reread license and options files (lmr‑
eread).

Installing licenses

For information about installing licenses for specific solutions from Citrix, see the following:

• Licensing guide for Citrix Virtual Apps and Desktops
• Licensing guide for Citrix ADC
• Licensing guide for Citrix Gateway
• Licensing guide for Citrix Hypervisor
• Licensing guide for XenMobile Server
• Licensing guide for Citrix Provisioning
• Licensing guide for Citrix SD‑WAN
• Licensing guide for Citrix SD‑WAN Orchestrator

For information about installing licenses using the Citrix Licensing Manager, see Install licenses.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 138

https://docs.citrix.com/en-us/licensing/current-release/license-administration-commands.html#reread-license-and-options-files-lmreread
https://docs.citrix.com/en-us/licensing/current-release/license-administration-commands.html#reread-license-and-options-files-lmreread
https://docs.citrix.com/en-us/licensing/licensing-guide-for-citrix-virtual-apps-desktops.html
https://docs.citrix.com/en-us/licensing/licensing-guide-for-citrix-adc.html
https://docs.citrix.com/en-us/licensing/licensing-guide-for-citrix-gateway.html
https://docs.citrix.com/en-us/licensing/licensing-guide-for-citrix-hypervisor.html
https://docs.citrix.com/en-us/licensing/licensing-guide-for-xenmobile-server.html
https://docs.citrix.com/en-us/licensing/licensing-guide-for-citrix-provisioning.html
https://docs.citrix.com/en-us/licensing/licensing-guide-for-sd-wan.html
https://docs.citrix.com/en-us/citrix-sd-wan-orchestrator/licensing.html
https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager/install.html


Licensing 11.17.2 build 48000

Display asset components

To display asset components, click View my products at the top of the page. Choose a license and
click the down arrow to expand and view the details. You can toggle between the order number and
the license access code view.
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Return allocations

Returning allocations puts the licenses back in the licensing pool. You can then allocate these licenses
in any quantity at any time. For example, you’re decommissioning a License Server, but you’re not
ready to deploy existing licenses elsewhere.

1. Select the check box of the license that you want to return.
2. From the Select an actionmenu, choose Return allocations.
3. Select Yes, process return. If you choose this option, you cannot undo it.

Modify licenses

Modifying a license returns a single license file and allows for allocation to another server. For exam‑
ple, you have 5000 licenses installed on license server1. You want to move 1000 licenses to license
server2. Modify allocations and then allocate 4000 licenses to license server1 and 1000 licenses to
license server2.

1. To select a product, click the link, and view the product license details page.
2. Select the check box of the allocated license to modify.
3. From the Select an actionmenu, chooseModify allocations.
4. Type a new server host address.
5. SelectModify license file.
6. Select Yes, create license file. If you want to make a change before creating the license file,

selectNo, modify the allocation, andmake your change. Then select Yes, create license file.
7. Select Download license file, and save the file to a temporary location. Remember the file

name and location where you downloaded the file. You need this location.
8. Install the license. See Install licenses.

Upgrade licenses

If you are eligible for a version upgrade as a benefit of yourmaintenance, you can download your CSS
Renewal license and add it to the License Server.

1. At the bottom of the landing page, selectUpgrademy licenses.
2. Follow the site options and instructions for upgrading your product edition licenses.
3. Eitherdownloadorordernewmedia. Anemailmessageprovidesyouwith instructions to return

to citrix.com to allocate or receive more feature licenses.
4. Log on towww.citrix.com to allocate your licenses, generate a license file, download the license

file to your License Server, and reread the file.
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Hide and unhide licenses

Hiding licenses doesn’t remove them froman account. When you hide licenses, it removes them from
view. Youmight want to hide legacy product licenses. Hiding those licenses increases the visibility of
product licenses that you want to view.

1. Select the licenses that you want to hide.
2. From the Select an action menu, chooseHide licenses.
3. To unhide licenses, chooseQuick find: All hidden and select licenses.
4. From the Select an actionmenu, choose Unhide licenses.

Managemultiple licenses (bulk actions)

You can apply actions to multiple licenses at the same time. Select the check boxes of different li‑
censes and then select and action.

To apply actions to multiple licenses successfully, be aware of the following conditions:

• You can apply certain actions only to licenses with the same attributes. For example, you can
only allocate licenses that have the same binding type. An error message appears when you
select licenses that are not compatible for the bulk action. The first license that you select is
what subsequent selections are compared to for compatibility.

• If you select licenses that can’t have an action applied to all of them, some actions might be
disabled or not displayed, and amessagemight appear. For example, if you select two licenses,
one that has been allocated and one that has not, a message appears. Themessage states that
the action can apply only to allocated licenses.
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Filter licenses

Use the Filter bymenu to narrow your list to expired licenses, new licenses, available allocations, or
trial licenses. From the Filter bymenu, choose how you want to filter your output.

Create a product license report ‑ Export to Excel (CSV)

Select this option to export your full list of assets and data to Excel.

1. Select the licenses that you want in the report.
2. Choose the Export to Excel (.CSV) link. In the Viewmy product page, it’s above the list of prod‑

ucts. In theManagemy licenses page, it’s at the bottom of the list.
3. Save the file.

License Server administration without a console

December 18, 2023

There are several administration procedures that you can do without using the Citrix Licensing Man‑
ager. We recommend that you use the console whenever possible. This article describes the proce‑
dures required if you are unable to use a console.

• Configure the Vendor Daemon log (CITRIX.log) from being overwritten
• Customer Success Services renewal files
• Delete license files
• Disable the domain name truncation on Windows
• Find renewal andmaintenance expiration dates

You can use the licensing management tool on citrix.com to download, allocate, install, modify allo‑
cations, return, and hide licenses. For more information, see Manage Licenses at citrix.com My Ac‑
count.

You canuse licensing commands to perform licensing tasks. Formore information, see Licensing com‑
mands.

Configure the Vendor Daemon log (CITRIX.log) from being overwritten

In License Server version 11.16.6 build 34000 that does not support the License Administration Con‑
sole, you can configure the Vendor Daemon log (CITRIX.log) from being overwritten as follows:
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• Go toLMGRD_LOG_FILE location (HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\FLEXlm
License Manager\Citrix Licensing\LMGRD_LOG_FILE) in your system.

• Add a + in front of the path. For example, C:\Program Files (x86)\Citrix\
Licensing\LS\Logs\lmgrd.log changes to +C:\Program Files (x86)\Citrix
\Licensing\LS\Logs\lmgrd.log as seen in the following image.

Customer Success Services

After youdownloadyourCustomerSuccessServices renewal license file fromcitrix.com, youmust add
it to your License Server. Copy the Customer Success Services renewal license files to the same direc‑
tory as your existing license files and reread (usinglmreread) the license files. Formore information
about the lmreread command, see Reread license and options files.

By default, this location is :

• C:\Program Files\Citrix\Licensing\MyFiles on a 32‑bit server

• C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64‑bit server

After you add the renewal license to your License Server, the license automatically unlocks any sub‑
sequent versions of the product released during the Customer Success Services period.

To separate your licenses (two different licenses on two different servers):

1. Select a second server and install the License Server software.
2. Go to citrix.com to modify and allocate your original licenses into two new files. These original

licenses are contained in your current license file on the original License Server.

• Allocate licenses to your first License Server for your first deployment.
• Allocate licenses to create another license file for the second License Server for your sec‑
ond deployment.

3. Generate and download your Customer Success Services files and then copy them to the server
to which you want them applied.
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4. Point all computers to the License Server running the version of the Citrix product you want
them to use. For information about pointing your Citrix product server to the License Server,
see your Citrix product’s administrator guide.

Delete license files

When you upgrade your edition (for example, Standard to Advanced, or Advanced to Premium) you re‑
ceivenewCitrix product licenses. You canallocate these licenses tooneormanyCitrix LicenseServers
through license files created at citrix.com. Rescinded licenses must be deleted from License Servers
within 90 days of new license purchase. Deleting the licenses enables:

• License asset management
• License compliance
• Delete unnecessary alerts from appearing in the management console

Considerations when deleting files:

• Incorrect removal of license files might inadvertently lower the total licenses available.
• Place any new license files on the License Server before deleting any licenses.
• Delete a license file only when all INCREMENT lines in the file are obsolete or unnecessary. For
example, every increment line was replaced with a new license because of an upgrade.

Important

Never delete the options file (citrix.opt) or startup license (citrix_startup.lic).

1. At the License Server, open the Services panel and stop the Citrix Licensing service.
2. Open theWindowsExplorer andnavigate towhere the license files are stored. Bydefault license

files are stored in:

• C: \Program Files\Citrix\Licensing\MyFiles on a 32‑bit server
• C: \Program Files(x86)\Citrix\Licensing\MyFiles on a 64‑bit server

3. Back up all license (.lic) files.
4. Using a text editor (we recommendMicrosoftWordPad), open each license (.lic) file and identify

one or more obsolete license feature INCREMENT lines.
5. Ensure that all increment lines are obsolete or unnecessary. See License file format for informa‑

tion about increment lines.
6. Close the file and change the file name extension from .lic to .old.
7. In the Services panel, restart the Citrix Licensing service.
8. Delete the renamed .old file.
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Disable the domain name truncation

Warning

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of the Registry Editor can be solved. Use the Registry Editor at your own risk. Be sure to back up
the registry before you edit it.

When you host multiple domains and multiple users who have the same user name on different do‑
mains, youcan leave thedomainname truncationenabled. For example, jack@mycompany.comand
jack@newplace.com. If you have unique users on various domains, ensure that the License Server
does not truncate @domain.com.

The License Server detects Citrix Service Provider licenses and enables this functionality.

1. Locate the registry key:

For 32‑bit machines: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\licenseserver

For 64‑bit machines: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\
licenseserver

Name: UDUseDomain

2. Set the registry key to 1.

Data Description

0 The domain field is truncated. (default)

1 The domain field is not truncated.

Find renewal andmaintenance expiration dates

Youmust have unrestricted access toMy Account.

1. From a web browser, go to www.citrix.com.
2. Select Sign In > My Account and type your user ID and password.
3. Select Renew andManage Maintenance Programs.
4. SelectManage Renewal Contacts at the top of the page.
5. Renewal dates are listed next to each license under Current Expiration.
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Licensing commands

December 17, 2023

While the Citrix Licensing Manager provides an easy method of accessing many licensing features,
you can also perform licensing tasks using commands. Youmight use the license administration com‑
mands for advanced operations on the License Server that are not available in the console. Such
operations include diagnosing check‑out problems using lmdiag.

License administration commands are stored in:

• C:\Program Files\Citrix\Licensing\LS on a 32‑bit computer
• C:\Program Files (x86)\Citrix\Licensing\LS on a 64‑bit computer

Description of the licensing commands

Note:

In License Server version 11.16.6 build 34000, existing user management lmadmin.exe is re‑
placed with Citrix owned user management lmgrd.exe. Ensure you do not use lmadmin.

Licensing commands Description

lmgrd Starts andmanages the licensing server and
other associated processes. lmgrd is the core
licensing server file used for the Citrix licensing
Windows service. It hosts the license server port
(default 27000). Use the Citrix Licensing Manager
for licensing configuration and administration
tasks.

lmdiag Diagnoses license check‑out problems.

lmdown Gracefully shuts down the License Manager and
Citrix vendor daemons (disabled by default).

lmhostid Reports the host ID of the server on which Citrix
Licensing is running.

lmreread Causes the License Manager daemon to reread
the license file and start the Citrix vendor
daemon.

lmstat Displays the status of a License Server.
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Licensing commands Description

lmutil Displays a list of licensed utilities or runs other
commands.

lmver Displays version information for the licensing
binaries.

udadmin Displays all licensed users and devices and
deletes specified licensed users and devices.
This command applies to user/device licenses
only. To get a list of licenses, specify
udadmin -list.

CtxManageUserAndGroup Configures user and group access to manage the
License Server.

CtxManageUserAndGroup.exe –
useradd “domain\username” -Role “
admin/user”

Command to add a user.

CtxManageUserAndGroup.exe –
useradd “domain\username” –Role “
adminGroup/userGroup”

Command to add a group.

Format license commands

Formatting conventions for the license administration commands:

Convention Description

Bold A command or switch, such as lmstat.

Italic Replace variables with a value. For example, in
the expression: lmstat ‑c license_file_list. Before
you run the command, replace license_file_list
with the names of one or more license files.
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Convention Description

[Brackets] Brackets around the text indicate the options
that you can add to the command. It might
indicate that the text within the brackets must
be replaced. For example:
lmstat [-a] [-c license_file_list
] [-f [feature]] can be written
as: C:\Program Files (x86)\Citrix
\Licensing\LS>lmstat.exe -a -c
@localhost -f XDT_ENT_UD

Universal arguments

Valid arguments for most license administration commands:

Argument Description

‑all Displays all information about the License
Server.

‑c Lets you specify a license files or License Server
port and host name. If you specify the path
without a license file name, the command
applies to all the license files in the directory. For
a local host: -c @localhost. For a remote
License Server: -c @servername. For a
License Server in a cluster:
-c @clientaccesspointname. For a
specified path: -c path. For the names of one
or more license files:
-c license_file_list. You can enter
more than one license file path by separating
each path with a semicolon. Path names that
include spaces must be enclosed in double
quotes.

‑h License handle, as reported by lmstat -a.
The license handle is a number used to identify a
specific checked out license.

‑help Displays usage information and exits.
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Argument Description

‑s [server] If you don’t specify a server, this argument
displays the status of all the license files listed on
the License Server or the license files on all the
License Servers.

‑verbose Displays a longer description for all errors found.

Diagnose checkout problems (lmdiag)

The lmdiag command allows you to diagnose problems when a product cannot check out a license.
In particular, you can test if your licenses are valid and if the License Server is running. When you run
this command, it attempts to check out a license.

You can also use the lmdiag command to see if a specific type of license is working.

Example:

RunlmdiagonyourCitrix VirtualAppsserverAdvancededition licensesonly. SpecifyMPS_ADV_CCU
as an argument.

Syntax:

lmdiag -c license_file_list [-n] [feature[:keyword=value]]

Argument Description

‑c license_file_list Diagnoses the specified files. You can also
use:-c @localhost or -c @server-name

‑n Runs in non‑interactive mode. lmdiag does not
prompt for any input in this mode.

feature Limits the feedback to the specified feature.

keyword=value If a license file contains multiple lines for a
particular feature, the result is limited to the line
containing the text value. For example:
lmdiag -c @localhost MPS_ENT_CCU:
HOSTID=LICSERV01 attempts a checkout on
the line with the host ID LICSERV01. The
keyword is one of the following: VERSION,
HOSTID, EXPDATE, KEY, VENDOR_STRING,
ISSUER
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If no feature is specified, lmdiag operates on all features in the license files in your list. The lmdiag
command displays information about the license, then attempts to check out each license. When
the checkout succeeds, lmdiag indicates that the checkout was successful. When the checkout fails,
lmdiag gives you the reason for the failure. The lmdiag command tries to connect to each TCP/IP
port on the License Server. It detects if the port number in the license file is incorrect. lmdiag lists
eachTCP/IPport number that is listening, and if ‑c license_file_list is specified, diagnoses the specified
files.

Thelmdiag commanddoes not contact the computer running the Citrix productwhen it attempts to
check out licenses. Thelmdiag command indicates only if there are problems on the License Server.
That is, your product cannot check out licenses because it is pointing to the wrong License Server,
but lmdiag does not detect this problem. For example, a License Server that does not have licenses
for that product on it. The lmdiag command reports that it can check out licenses when the Citrix
product is pointing to the wrong License Server.

Stop daemons (lmdown)

The lmdown command shuts down the License Manager daemon and the Citrix vendor daemon on
your License Server or all License Servers on your network. The lmdown command is disabled by
default.

Syntax:

lmdown -c license_file_list [-vendor CITRIX] [-q] [-all]

Argument Description

‑c license_file_list or ‑c @localhost or ‑c @server Use the specified license files. We always
recommend specifying
-c license_file_listwith lmdown. You
can also use:-c @localhostor
-c @server-name

‑vendor CITRIX Shut down only the Citrix vendor daemon. The
License Manager daemon continues to run.

‑q Do not prompt or print a header. Otherwise,
lmdown asks “Are you sure? [y/n]: .”

‑all If multiple servers are specified, automatically
shuts down all of them. ‑q is implied with ‑all.

Run the lmdown command on a License Server. You can use ‑all to shut down all the License Servers
on your network.
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If lmdown encounters more than one server and you didn’t specify the ‑all argument, the command
displays a choice of License Servers to shut down. For example, the ‑c argument specifies a directory
with many *.lic files. Shut down the remote License Servers by using ‑c and specifying the name of
the License Server.

Note:

If you use the Task Manager to terminate the License Manager daemon (Citrix Licensing Service),
stop the lmgrd process first, then stop the Citrix vendor daemon process.

To stop and restart the Citrix vendor daemon only, use lmdown -c @localhost -vendor
CITRIX, then use lmreread -c @localhost -vendor CITRIX to restart the vendor

daemon.

Checks the license server binding information (lmhostid)

The lmhostid command returns the host ID of the License Server. You can use the command to
check the host name of your License Server. You can open a license file and compare the host name
in the license file to that of your License Server.

Note

Citrix Licensing, versions 11.5 and later for Windows allows you to display multiple host IDs if
there are more than one host.

Syntax:

lmhostid -bindingidentifier

The bindingidentifier is an argument in the command.

Argument Description

‑ether Used for product licenses that are tied to the
MAC address of the appliance.

‑internet Used for Windows‑based Citrix product software
licenses that require a TCP/IP address.

‑hostname Used for Windows‑based Citrix product software
licenses that are tied to the host name of the
License Server. Note: The parameter
hostname is case‑sensitive andmust match
your License Server name exactly.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 151



Licensing 11.17.2 build 48000

Reread license and options files (lmreread)

The lmreread command causes the Citrix vendor daemon to reread changes to the license file and
the options file. After rereading, the Citrix vendor daemon uses the new settings and licenses from
then on.

You cannot use lmreread remotely; run it locally on the License Server.

Syntax:

lmreread -c license_file_list [-all] [-vendor CITRIX]

Argument Description

‑c @localhost or ‑c license_file_list Use the specified license files.

‑all If more than one lmgrd is specified, this
argument instructs all License Manager
daemons to reread.

‑vendor CITRIX Specifies for the Citrix vendor daemon to be
restarted.

Examples:

• lmreread -c @localhost \[-all\]
• lmreread -c @client\\_access\\_point\\_name
• lmreread -c /opt/citrix/licensing/myfiles/CITRIX.lic -vendor
CITRIX

Display the list of licensing utilities (lmutil)

The lmutil command displays a list of licensing utilities when used standalone. When you specify
lmutilwith another command, it runs that command.

Syntax:

lmutil

lmutil other_command

Examples:

• lmutil

Displays all the licensing utilities.

• lmutil lmstat -c @localhost

Runs the lmstat command.
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Determine licensing status (lmstat)

The lmstat command helps you monitor the status of all licensing activities and provides you with
information about license check outs, including:

• The product that checked out one or more licenses
• The checkout data
• The version of the license file
• The License Server name and port
• The date the license was checked out
• Information about the Citrix vendor daemon status and the license files

Thelmstat commanddisplays the information that it receives fromtheLicenseServer. Thelmstat
command displays only one use of the license, even if there are multiple connections sharing that
license.

Syntax:

lmstat [-a] [-c license_file_list] [-f [feature]] [-i [feature] [-s[
server] [-S [CITRIX]] [-t timeout_value]

Argument Description

‑a Displays all information.

‑c @localhost or ‑c @server or ‑c license_file_list Uses the specified license files.

‑f [feature] Displays the products using a feature (product
license). If you don’t specify a feature, usage
information for all features is displayed.

‑i [feature] If you don’t specify a feature, this argument
displays information from the INCREMENT line
for the specified feature (product license) or all
features.

‑s [server] If you don’t specify a server, this argument
displays the status of all license files listed on the
License Server or the license files listed on all the
License Servers.

‑S [CITRIX] Lists all product servers using the features
(product licenses) served by the Citrix vendor
daemon.

‑t timeout_value Sets connection time‑out to timeout_value. This
value limits the amount of time lmstat spends
attempting to connect to the License Server.
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The output from lmstat -c @localhost -a looks similar to this example. The lines in the ex‑
ample might break because of the screen space.

1 License Server status: 27000@localhost
2
3 License file(s) on localhost: C:\Program Files (x86)\Citrix\

Licensing\MyFiles\citrix_startup.lic:C:\Program Files (x86)\
Citrix\Licensing\MyFiles\License.lic:

4
5 localhost: license server UP v11.15.0
6
7 Vendor daemon status (on LicenseServer):
8
9 CITRIX: UP v11.15.0

10
11 Feature usage info:
12
13 Users of CITRIX: (Total of 10000 licenses issued; Total of 1

licenses in use)
14
15 "CITRIX" v2038.0101, vendor: CITRIX, expiry: permanent(no expiration

date)
16 vendor_string: ;LT=SYS;GP=720;SA=0
17 floating license
18
19 XDT DDCPrinc-0001.citrix.com XDT XDT\_PLT\&MPS_PLT_2018.0518 (v1.0)

(localhost/27000 102), start Tue 5/8 17:59
20
21 Users of CTXLSDIAG: (Total of 10000 licenses issued; Total of 0

licenses in use)
22
23 Users of XDT_PLT_CCS: (Total of 200000 licenses issued; Total of 3

licenses in use)
24
25 "XDT_PLT_CCS" v2018.1201, vendor: CITRIX, expiry: 01-dec-2018
26 vendor_string: ;LT=Retail;GP=720;PSL=10;CL=VDS,VDA,VDE,VDP;SA=0;ODP=0;

NUDURMIN=2880;NUDURMAX=525600
27 floating license
28
29 XDT DDCAux-0001.citrix.com XDT 00001E3A (v2018.0518) (localhost

/27000 534201), start Wed 5/9 15:17
30 XDT DDCAux-0001.citrix.com XDT 00001E81 (v2018.0518) (localhost

/27000 392504), start Wed 5/9 15:18
31 XDT DDCAux-0001.citrix.com XDT 00001E0C (v2018.0518) (localhost

/27000 419703), start Wed 5/9 15:18
32 <!--NeedCopy-->

The following represents a breakdown of the information contained in the MPS_ENT_CCU line of the
lmstat output:
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Description

Citrix product name MPS The name of the Citrix product
that has the license checked
out.

Host name mps_server1 Computer where the Citrix
product is running.

Display MPS Name of the Citrix product that
has the license checked out.

Server host license_server1 Computer where the License
Server is running.

Port 27000 TCP/IP port where the License
Server is running.

Handle 203 License handle. The license
handle is a number used to
identify a specific checked out
license.

Checkout time start Wed 3/17 11:56 Time that this license was first
checked out.

The command lmstat -c @localhost -a can potentially generate much network activity in
systems that have many products licenses checked out.

You can use lmstat -a to verify license checkout data.

Display versions of binaries (lmver)

The lmver command displays version information for the licensing binaries, such as the command
utilities.

Syntax:

lmver binary

Example:

lmver lmdiag

Display or release licenses for users or devices (udadmin)

The udadmin displays the licensed users and devices and releases licenses for specified users and
devices.
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Note:

UDAdmin tool is only used for reporting license usage for user/device licensemodel and not con‑
current licenses.

You can release a license for a user only when:

• The employee is no longer associated with the company.
• The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

Caution:

Mass release of licenses, before the automatic 90‑day lease period, outside of the reasons high‑
lighted earlier might violate the Citrix EULA. Before doing so, contact Citrix.

The udadmin command‑line help displays usage information only in English, but you can use the
command on non‑English systems.

Syntax:

udadmin [-options] [-delete | -events | -list | -times]

Options Description

‑f feature name When used with ‑list or ‑delete, displays or
releases the license for only the user or device
for the specified feature name.

‑user user name Releases the license for only the user specified
by the user name.

‑device device name Releases the license for only the device specified
by the device name.

‑a Lists all features and versions installed on the
License Server.

Argument Description

‑delete Releases the license for one user, feature, or
device at a time.

‑events Reports all events logged by the user/device
licensing for each feature sorted in chronological
order.
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Options Description

‑list Displays the users and devices with licenses and
the time since the last update. If significant
activity occurred within 15 minutes of the last
report, the time to the next update appears.
Specifying -list -times generates output
containing a timestamp.

‑times Specifying -list -times generates output
containing a timestamp.

No argument or ? Displays usage information for the udadmin
command.

Examples:

1 - udadmin -list -times
2
3 Usage data is 0 minutes old. Next update in 15 minutes.
4
5 Users:
6
7 u01.01 XDT_ENT_UD 2017.1201 (Thu Sep 14 13:41:07 2017)
8
9 u01.04 XDT_ENT_UD 2017.1201 (Thu Sep 14 13:41:07 2017)

10 .
11 .
12 .
13
14 Devices:
15
16 D.ADV.23 XDT_ADV_UD 2017.1201 (Thu Sep 21 18:31:01 2017)
17
18 D01 XDT_PLT_UD 2017.1201 (Tue Sep 12 14:30:33 2017)
19
20 - udadmin -list -a
21
22 Lists all features, versions, counts of licenses, and the users and

devices for each feature.
23
24 - udadmin -f XDT_ENT_UD -device dn01.88 -delete
25
26 Releases one device from one feature.
27
28 <!--NeedCopy-->
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Upgrade the License Server

February 19, 2024

Before you upgrade

The following information helps you to prepare well before you begin your upgrade.

• Each time you upgrade your Citrix product, upgrade the Citrix License Server also. Each time
a new License Server is released, it might contain better security, fixes to known issues, and so
on.

• Sometimes, new versions of the Citrix product are incompatible with older versions of the Li‑
cense Server. New versions of the License Server are compatible with older versions of the
product and old licenses.

• Version upgrade is moving from any previous version to the newest version of the product. For
example, moving from XenDesktop 7.18 to Citrix Virtual Desktops 7 1909.

• Edition upgrade means the purchase of a higher edition level of a product. For example, you
now have Advanced Edition and you purchase an upgrade to Premium Edition.

Prerequisites and precautions

• For information about system requirements, see System requirements.
• Ensure you download the latest version of License Server, go to Citrix Downloads.
• Installing the License Server from a UNC path (\\server\share) is not supported. So, install the
License Server from your local copy.

• Upgrade your licensing components before upgrading your product, if necessary.
• Uninstall any versions of Citrix Licensing older than version 11.12.1 before installing this version.
• To avoid the failure of any subsequent License Server upgrades: Ensure that when you installed
your License Server, you successfully configured it with the post installation License Server Con‑
figuration tool or uninstalled your previous License Server.

Note:

• The License Server upgrademight fail if there is no or less disk space available on the server.
• For userswhoopt tomanually upload theCitrix telemetry data for compliance, theupgrade
to latest version fromLicenseServer version11.17.2build 45000 can take longer if theyhave
more telemetrydata storedon the server. Beforeupgrading, upload thesedata toCitrix and
delete them for upgrading to happen quickly. For more information about manual upload
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of Citrix telemetry data, see Reporting options.
• If you uninstall the License Server, then the Citrix telemetry data is deleted. You must re‑
port the telemetry data for compliance to Citrix before uninstalling the License Server ver‑
sion 11.17.2 build 45000 or later. For more information about the manual upload of Citrix
telemetry data, see Reporting options.

How to upgrade the License Server

Citrix recommends that you install the newest License Server. The new License Server is backward
compatible and supports older products and license files. However, new products require the newest
License Server to check out licenses correctly. Perform the following steps to upgrade your License
Server:

1. Go to the Citrix Downloads page and download the installer to install or upgrade to the latest
version.

2. Start the License Server installer (CitrixLicensing.exe) as an administrator, and follow the graph‑
ical interface.

To upgrade the License Server from your product media:

If you use the productmedia for your installation, youmight have to enable some functionality by us‑
ing the Citrix Licensing Manager after your installation. For example, use the Citrix Licensing Manager
to enable Customer Success Services renewals.

1. From your License Server, open the media for your product.
2. If you do not see Setup, use Windows Explorer to open Autorun.exe or AutoSelect.exe.
3. Navigate through the Setup screen to Citrix Licensing and follow the instructions.

To upgrade the License Server from the command line:

Ensure that you run the command line with administrator privileges. To start the command prompt
with elevated privileges, choose Start, right‑click Command Prompt, and choose Run as adminis‑
trator.

You cannot change ports during command line upgrades.

The following sample command line installs licensing in silent mode.

CitrixLicensing.exe /quiet /l install.log INSTALLDIR=installdirectory CEIPOPTIN=ANON

• /quiet specifies a silent (quiet) installation.
• /l specifies the log file location
• INSTALLDIR is the location where the License Server executable is stored. Optional parameter.
The default is c:\program files\citrix licensing or c:\program files (x86)\citrix\licensing.
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• CEIPOPTIN specifies whether, or how, to opt in to the Citrix Customer Experience Improvement
Program (CEIP) or Call Home. Optional parameter. The default is NONE.

– DIAGNOSTIC ‑ Call Home
– Unidentified ‑ CEIP
– NONE

You canmodify the CEIP and Call Home choice using the Citrix Licensing Manager.

Important

The Citrix Service Provider program requires the Customer Experience Improvement Program
(CEIP) and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home.

Events during a License Server upgrade

As part of the License Server upgrade, we stop services, upgrade the License Server, and then restart
services. During the upgrade, products enter the grace period and self‑license. When the License
Server is online again, all product servers return from the grace period and reconcile license counts.
This grace period works in the samemanner as the regular grace period functionality.

How to upgrade licenses for your edition

If you are eligible for a version upgrade as a benefit of yourmaintenance, you can download your CSS
Renewal license and add it to the License Server. Also change the product edition setting in the prod‑
uct user interface. It’s best to change the product edition setting when there are few connections to
the affected servers or redirect connections to another computer. When you change the product edi‑
tion setting, restart the product server for the changes to take effect. See the product documentation
for changing the edition setting. If you add the upgrade license to the License Server before you set
the edition to the new edition, the Citrix product stops accepting new connections.

Perform the following steps to upgrade edition licenses:

1. From a web browser, go to http://www.citrix.com.
2. Choose Log In and type your user ID and password.
3. SelectManage Licenses.
4. At the bottom of the landing page, selectUpgrademy licenses.
5. Follow the site options and instructions for upgrading your product edition licenses.
6. Eitherdownloadorordernewmedia. Anemailmessageprovidesyouwith instructions to return

to citrix.com to allocate or receive more feature licenses.
7. Log on to https://www.citrix.com/ to allocate your licenses, generate a license file, download

the license file to your License Server, and reread the file.
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Uninstall the License Server

March 18, 2024

If you want to uninstall License Server from your server completely or have issues with the current
version and prefer a clean installation, you can choose to uninstall it. You have the flexibility to use
either the GUI or the Windows command line for the uninstallation process.

Note

• If you uninstall the License Server, then the Citrix telemetry data is deleted. You must re‑
port the telemetry data for compliance with Citrix before you uninstall the License Server
version 11.17.2 build 45000 or later. For more information about the manual upload of Cit‑
rix telemetry data, see Reporting options.

• The Myfiles folder is kept even after successful uninstallation in the file path C:\
Program Files (x86)\Citrix\Licensing\MyFiles. To make sure that there
is no interruption on the Citrix products.

Uninstall the License Server using the GUI

To uninstall License Server, do the following steps:

1. In the Search on the taskbar, enter Control Panel and select it from the results.
2. Select Programs > Programs and Features.
3. Drag (or right‑click) on Citrix Licensing and select Uninstall or Uninstall/Change. The Citrix

Licensingwizard appears.
4. Click Remove and then click Yeswhen prompted for Are you sure youwant to remove?.
5. Click Finish. The License Server has been successfully removed.

Uninstall the License Server using the Windows command line

To uninstall License Server, run the following command in the Windows command line:

CitrixLicensing.exe /quiet /uninstall /1 uninstall.log

To re‑install, download License Server from Downloads and Install.

Clustered License Servers –configure, install, upgrade, and uninstall

December 17, 2023
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Why clustered License Servers

Cluster servers are groups of computers that are combined to increase availability, reliability, and
scalability. Clustering the License Server lets users continueworking during failure situationswithout
interrupting their access to critical applications.

How clustered License Servers work

When theactivenode ina cluster‑enabledLicenseServer suffers fromhardware failure, failover occurs
automatically. Resources are available again in a few seconds.

A typical cluster configuration has, at a minimum, one active and one passive (backup) server. When
theactive server ina cluster fails, theownershipof the resources in thecluster is transferred toanother
node in the cluster. Typically, users cannot detect when one server in a cluster fails over to another.

When the active node of a clustered License Server fails, there is no impact on users connected to
the Citrix product. The product might briefly enter the licensing grace period and an event might be
written in the product’s event log.

Important:

If Citrix Licensing is installed in a clustered environment and the Windows Firewall is enabled,
then the connection can fail. Connecting remotely to the console or checking out licenses works
until failover occurs in the cluster. Exception rules for CITRIX.exe and lmgrd.exe are created dur‑
ing the installation of Licensing, but do not work after a cluster failover. To work around this
issue, create exceptions for Licensing components on the Exceptions tab of the Windows Fire‑
wall panel. Create an exception for each of the following ports:

• License Server port number is 27000
• Vendor daemon port number is 7279
• Web Services for Licensing port number are 8083

Citrix Licensing in a clustered environment

Like most clusters, a private network is used to send heartbeats, commands, and state information
between the nodes of the cluster. If the connection is interrupted, the nodes try to reconnect by the
private network first, then the public network. The following diagram illustrates a cluster‑enabled
licensing deployment:

Communications in a clustered licensing environment:
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Only one node can use the resources in a cluster at any given time. If you already deployed Citrix
Licensing and you want to migrate your deployment to a cluster‑enabled server, keep the following
points in mind:

• You must give the client access point the same name as the original License Server. Because
you already generated license files that reference a specific server name. If not, then rehost
your license files with the new name of the License Server cluster.

• Host names in license files are case‑sensitive; therefore, the client access point namesmust be
the same case as the host names in the license file. If they are not, youmust rehost your license
files with the correct capitalization of the names. You can use the Failover Cluster Manager to
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ensure that the client access point name matches the host name specified in the license file.
Cluster and host name case is not an issue if you use Studio in Citrix Virtual Apps and Desktops
or the Citrix Licensing Manager (from the Start menu on your License Server) to download your
licenses.

• Point all product installations (for example, servers running Citrix Virtual Apps and Desktops)
serviced by the old License Server to the new License Server cluster. Change product communi‑
cation settings so that they use the name of the client access point as the License Server name.
For information about editing product‑side communication settings, see the product’s docu‑
mentation.

Prerequisites to configure a clustered License Server

The following list outlines the requirements for setting up a License Server in a Microsoft Cluster:

• Microsoft clustering functionality exists in:

– Windows Server 2019
– Windows Server 2016

• Citrix Licensing does not support Clustered Shared Volumes or third party VolumeManagement
products for clusters.

• Before configuring Citrix Licensing for Microsoft clustering, you must have a fully functional Mi‑
crosoft cluster environment. Citrix Licensing Services runs on only one node at a time.

• To cluster the License Server, follow these cluster requirements and other requirements from
Microsoft for hardware and clustering in general.

• Install licensing on the cluster with the License Server installer CitrixLicensing.exe.

• When you install Citrix Licensing on a cluster, ensure that you specify the name of the client
access point when you are prompted for the name of the License Server during product instal‑
lation.

• We recommend that you use identical License Server hardware for each node in the cluster. In
particular, Citrix recommends two network adapters on each node and the servers configured
with a shared disk.

• Ensure that each node has two network adapters. Network adapters are required for the con‑
nection to thepublic network and thenode‑to‑nodeprivate cluster network. Wedonot support
using one network adapter for both connections.

• Thepublic and theprivate IPaddressesmustbeondifferent subnetsbecause theClusterService
recognizes only one network interface per subnet.
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• A name resolutionmethod is necessary to resolve the client access point name. You can choose
name resolution methods such as DNS, WINS, HOSTS, or LMHOSTS.

• Each server that forms the cluster must be in the same domain.

• Set static IP addresses for the private network connector.

• We recommend that you use the Citrix Licensing Manager to allocate licenses to the cluster.

• When you generate a license file at citrix.com, use the name of the client access point when
prompted for the Host ID.

• After you download a license file, copy it to the F:\Program Files\Citrix\Licensing
\MyFiles folder (where F: is the shared drive for the cluster) on the License Server and reread
it.

Important:

Citrix recommends setting static IP addresses for all network adapters in the cluster, both private
and public. If using Dynamic Host Configuration Protocol (DHCP) to obtain IP addresses, access
to cluster nodesmight become unavailable if the DHCP server goes down. If youmust use DHCP
for your public network adapter, use long lease periods to ensure that the dynamically assigned
lease address remains valid even if the DHCP service is temporarily lost or perform a DHCP reser‑
vation.

Configure a clustered License Server

The following steps describe the overall process involved in installing and configuring licensing on a
cluster‑enabled server. These steps assume you configured the clustering on the hardware on which
you intend to install the License Server.

1. Create a cluster resource group. Assign a client access point and shared storage to the resource
group. Ensure that the first node has control of the cluster resources and the resource group
you created points to the first node.

2. On the first node of the cluster, start the Citrix Licensing installer, CitrixLicensing.exe, as an ad‑
ministrator. Install it on the first node to the shared cluster drive (not the quorum drive). Leave
the Last Node in the Cluster check box cleared.

3. Move the resources from the active node in the cluster to the second node.

4. Install the License Server on the second node to the same shared location as the first node. You
can addmore than two nodes to a cluster.

5. When installing the License Server on the last node in the cluster, ensure that you check the Last
Node in the Cluster check box.
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6. Obtain license files that specify the client access point name of the License Server as the host
name. After obtaining license files, you must add them to the License Server and then reread
them.

7. Configure your Citrix product to use the client access point name, not the node name of the
License Server cluster.

Important:

When a clustered License Server fails over, the cluster service renames the lmgrd_debug.log to
the name of the node that previously hosted the services. Then it starts the services on the new
active node and creates a lmgrd_debug.log.

Install licensing on a cluster‑enabled server

Important:

The .msi does not support clustering. To install or upgrade for clustering, use CitrixLicensing.exe.

The following drive letters and paths/variables are used in this procedure:

• D is the drive for your product media.

• C is the local hard drive on the specified node.

• F is thecluster shareddrive resource. (Thisdrive is the installationdrive. That is, theplacewhere
installation files used by each node are stored.)

Because of a NetBios restriction, ensure that the client access point name is fewer than 15 characters.
On non‑English platforms, when starting a License Service installation on a cluster node, the Cluster
Group list on the Configure screenmight contain the system default Cluster Group. Select one of the
non‑default Cluster Groups and the installation continues normally.

1. Create a separate noncore cluster resource group. The resource group must have the attached
storage assigned a drive letter and a client access point. The client access point must have the
same host name used when obtaining the license file. Use the Failover Cluster Manager and
Roles > Configure Role in Windows Server 2016 and Windows Server 2019. Then select the
Other Server type in the menu. Ensure that the first node of the cluster owns all cluster re‑
sources.

2. Run the License Server installer CitrixLicensing.exe as an administrator.
On the Install Location page, set the drive letter to correspond with the cluster shared drive.
By default, the licensing components are installed in F:\Program Files\Citrix\
Licensing.

3. During the installation on the first node, do not select the Last Node in the Cluster check box.
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4. Move the resources for the resource group that you created in Step 1 to the second node.

5. In node 2 of the cluster, run CitrixLicensing.exe as an administrator.

6. Go back to Step 3. You can install more than two nodes on the cluster. You can install more than
two nodes on the cluster. For each additional cluster, repeat Step 3.

7. When installing the License Server on the last node in the cluster, ensure that the Last node in
the cluster check box is checked. The last node is where the ports are configured.

8. Use the Citrix Licensing Manager to import your license files.

Open the console or run commands

All licensingadministration features available in standarddeployments are also availableon clustered
License Servers. These features include themanagement console and the ability to run license admin‑
istration commands.

Browse to the following location to open the Citrix Licensing Manager in a cluster:

https://client access point name:web service port

Where the client access point name is the name of the cluster and the web service port is the port
number for console communications. The default port number is 8083. To specify the location of the
license files in the cluster, you can runmany license administration commands using the argument ‑c
@client access point name. For example:

lmreread -c @client access point name -all

Upgrade a clustered License Server

To upgrade your clustered License Server (from versions 11.12.1 onwards) to the latest version, com‑
plete the following steps:

1. Download the latest License Server build.

2. Run the License Server installer CitrixLicensing.exe as an administrator.

3. Move the resources for the resource group that you created when you installed licensing on a
clustered enabled server, to the second node.

4. In node 2 of the cluster, run CitrixLicensing.exe as an administrator. If node 2 is your last node
in the cluster, ensure you check the Last Node in Cluster option on the Configure Ports page
and clickNext.

5. If you have more than 2 nodes on the cluster, repeat Step 3.

6. Use the Citrix Licensing Manager to import your license files.
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Note:

If you are running a version of a License Server older than 11.12.1, uninstall it and then install
the latest version. Older versions of License Server don’t conform to current Microsoft cluster
guidelines.

Uninstall a clustered License Server

Uninstall licensing fromaclustered LicenseServer using theControl Panel >ProgramsandFeatures
option from the active node.
Ensure that the first node contains all the resources.

1. From the first node in the cluster, start Control Panel > Programs and Features.

2. Remove Citrix Licensing.

3. Using the failover clustermanager, move the resources in the Citrix Licensing resource group to
the second node.

4. Remove Citrix Licensing from the second node. If there are more nodes, repeat Steps 3 and 4
for each node, and then proceed to Step 5.

5. Remove the remaining files from the shared drive.

Note:

The uninstallation process does not remove the license files and options files from the shared
drive. For more information, see Troubleshoot Licensing.

Disaster recovery backup and redundancy

December 18, 2023

Dependingonhowcrucial theapplicationsassociatedwith your licensesare, youmightwant to create
backup License Servers. Although Citrix stores backup copies of your licenses, downloading many
replacement licenses canbe time‑consuming. If theLicenseServer fails, youcanstorebackup licenses
on a network file share, or have a configured backup License Server ready.

You can use the same licenses for your disaster recovery site that you use for your production environ‑
ment.

• Configure and manage your disaster recovery environment independently of your production
environment.
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• Don’t use both the production and backup License Servers to service license checkouts at the
same time.

• Make only one License Server accessible at any one time
• The License Server in your disaster recovery environment must have an identical host name to
the License Server in your production environment.

When the License Server is offline for maintenance activity

The standard 30‑day grace period allows your systems to continue to functionwithout degradation of
performance or denial of service to support License Server maintenance requirements.

What can I do if my License Server is unrecoverable?

When you have a backup copy of your license files available, you have 30 days to do the following:

1. Rename an existing server in your environment to have the identical host name as your original
License Server.

2. Install the License Server component and your backup license files to relicense your environ‑
ment.

What can I do if my License Server is unrecoverable and I do not have a backup copy of
my license files immediately available?

When you don’t have a backup copy of your license files immediately available, you have 30 days to
access your Manage Licenses portal at www.citrix.com. To relicense your environment, do the follow‑
ing:

1. Download your license files.
2. Rename an existing server in your environment to have the same host name as your original

License Server.
3. Install the License Server component and the license files that you downloaded.

What can I do if my License Server is unrecoverable and I cannot rename an existing
server in my environment?

When you can’t rename an existing server in your environment, you have 30 days to relicense your
environment. Do the following:

1. Identify another server in your environment.
2. Install the License Server component.
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3. Access your Manage Licenses portal at www.citrix.com.
4. Return and reallocate your license files using the host name of the new server you selected.
5. Download and install these license files.

Does any failure of the License Server degrade performance or deny service to users?

No. The 30‑day grace period prevents you from experiencing degradation in performance and denial
of service to users.

Redundancy solutions

Setting up redundancy solutions might be necessary only in mission‑critical environments. For
smaller or less mission‑critical deployments, you can back up your License Server by creating a
duplicate License Server and store it on or off the network.

You can ensure redundancy for your mission‑critical environments by:

• Creating a clustered License Server. For more information about clustering and licensing, see
Setting up the License Server on a Microsoft Cluster.

• Using the high availability feature on XenServer minimum release version 5.6.
• Duplicating the License Server and its contents. Give the duplicate computer the same name as
the active License Server and store it off the network.

• Storing another License Server that has a different server name on the network. In this case,
when the active License Server fails, you must change the backup server name to start using it
as the active License Server.

• Using a network appliance that detects server or network outages and route traffic to a backup
server. If you are using only one License Server to service license requests at any time, then you
can use a network appliance to route traffic to a backup server during outages.
All methods let you exchange one server license for another without a loss of service, provided
the exchange occurs within the grace period. For more information, see Grace period.

Remember these key points:

• Because license files reference the server specified during allocation, you can use the files only
on a server that has the same binding information. That is, the server name or FQDN or MAC
address (possibly displayed on the portal as an Ethernet address) as the original License Server.

• You cannot have two License Servers that have the same name on your network active at the
same time.

• Add any other licenses that you download to both the active License Server and the backup
License Server.
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Troubleshoot the License Server

December 17, 2023

If anyof the licensing services fail to start, the cluster detects that licensing is offline and tries to restart
the service three times (by default). When these attempts are unsuccessful, fail over to the next node
begins. Thecluster tries to start the serviceson the secondnode. When theattempts fail on the second
server, the process might enter into an infinite loop. In this case, the computers running the Citrix
products fall into the grace period. During the grace period, client connections are not affected.

Troubleshoot the cluster‑enabled License Server

When troubleshooting a cluster‑enabled License Server, try the following:

• If youmove the resources to the other node, do you still see the issue?

• If the installation fails, ensure that you don’t enable the User Account Control (UAC) when in‑
stalling on a cluster.

• For Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2:

1. In the Failover ClusterManagementwindow, from the left pane, select the cluster. In the
middle pane, the summary information for the cluster appears.

2. Select the Cluster Core Resources title to expand the section.
3. Verify that the cluster resources are all online (green arrow).

The “‑evaluation license‑”warningmessage

After you replace the evaluation license files on the License Server with new license files, the Citrix
product might display the following license expiration message when users log on:

Warning: The following Citrix Product is using an Evaluation license.
This license will expire in...

To resolve this issue:

1. Delete the old evaluation license files from the License Server. Formore information, seeDelete
license files.

2. At the License Server, restart the Citrix Licensing service.
3. At the Citrix product server that needs license validation, point to a fictional License Server and

then point the product back to the actual License Server. (See your product documentation for
information about changing these settings.)

4. If the problem persists, restart the product server (for example, Delivery Controller).
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Required product licenses are not installed on Director or Studio

The following error message is displayed on the Citrix Virtual Apps and Desktops Director or Studio
UI:

• Required product licenses are not installed
• The trial period has expired

The following reasons can cause the error messages:

• No valid licenses are installed on the License Server
• Product Edition and Product Model are not set correctly on Citrix Studio
• If the maintenance dates of the licenses are not compatible with the product version installed

To resolve this issue:

1. On Citrix Studio, check if the licenses are reflecting the correct maintenance dates. If not, real‑
locate and import renewed licenses. For more information, see the Citrix article CTX134629.

2. Verify if Citrix Studio is pointing to a valid License Server.
3. Click Edit Product Edition under Actions and choose the correct licensing edition or model as

per the licenses applied.

• If the right edition or model is set and still the error remains, toggle between the license
editions. Then choose the correct one.

• If the above steps do notwork, click “change license server”under actions and click con‑
nect.

4. Relaunch Citrix Studio and then reboot the product server if the issue persists.

Note:

License Server VPX is not compatible with Citrix Virtual Apps and Desktops (Version 7.x and
above).

Licensing FAQ

December 18, 2023

The following questions are asked frequently about your licensing environment.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 172

https://support.citrix.com/article/CTX134629


Licensing 11.17.2 build 48000

Licenses

What is a license file and what do I do with it?

The license file is a text file that contains the following:

• Product licensing information
• License Server name (or other binding identifier)
• Customer Success Services membership renewal date
• License expiration date (if applicable)
• Other system information

When you purchase a Citrix product and allocate licenses, a license file is generated. The License
Server uses this file to determine whether to grant a license to a Citrix product. Formore information,
see License files.

Why return a license?

Anexample canbe if you’redecommissioninga LicenseServer, but you’re not ready todeploy existing
licenses elsewhere. For more information, see Return allocations.

What happens to returned licenses?

Returned licenses are put back in the licensing pool. You can then allocate these licenses in any quan‑
tity at any time. After you return a license, remove the old license file from the License Server. For
more information, see Return allocations and Modify licenses.

What happens when I hide a license?

Hide (previously called archiving) doesn’t remove licenses from an account. Hiding removes them
from view. To view hide and unhide licenses, see Hide and unhide licenses.

How can I get a copy of my license file?

Youcanobtainacopyof your license file fromyourLicenseServer. Alternatively, all purchased licenses
and allocated license files are available from the secure My Account > Manage Licenses portal at
www.citrix.com.
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Allocating licenses

For more information about allocating licenses, see Allocate licenses.

What does allocating licensesmean?

When you allocate licenses, you apportion purchased licenses by product and License Server so you
can split them among multiple environments or use cases. For example, your organization might
own 1,000 licenses for the same product. You might want to use 800 in 1 location and 200 in another
location. You can allocate 800 licenses to a License Server in the first location today, and allocate the
remaining 200 later to a different License Server.

What’s the difference between a host ID type and a host ID?

The host ID type is the required binding type that you supply to allocate licenses. The host ID is the
License Server host name, MAC address, or other binding ID required to allocate licenses.

Why can’t I partially allocate some licenses?

Some licenses do not allow partial allocation.

The License Server

Can I rename the License Server?

License files run only on the License Server that is included during the license allocation. License files
contain the host name or binding identifier of the License Server you specify when you allocate the
licenses. You cannot use the license file that you generated for a particular License Server or a MAC
address (for an appliance), on a different License Server or appliance.

Create license files that reference the new server name or MAC address by returning allocations
and generating the new file on citrix.com. For more information, see Manage Licenses on
citrix.com.

If I upgrademy License Server does it affect my license files?

No. The License Server and all product licenses are fully backward compatible and do not introduce
any issues into your environment. For more information about upgrading the License Server, see
Upgrade the License Server.
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Whenwe do an in‑place upgrade dowe back up the historical data?

Yes.

Can a single License Server supply licenses to users connecting from different servers using
different product editions?

Yes. A single license server can support multiple Citrix product deployments to include different edi‑
tions or license types. One License Server can contain licenses formultiple editions of a Citrix product.
The type of license checked out corresponds to the edition that is configured on the product server.
A product server is configured to consume a specific edition of a license and checks out that license
edition.

For more information and examples, see Single License Server and different servers using different
product editions.

License Administration Console

Where is the License Administration Console?

The License Administration Console is not available in License Server 11.16.6 and later. We recom‑
mend you
use the Citrix Licensing Manager to manage the License Server.

How to configure the Vendor Daemon log (CITRIX.log) from being overwritten while using
11.16.6 build 34000 that does not support the License Administration Console?

For information, see Configure the Vendor Daemon log (CITRIX.log) from being overwritten.

Disaster recovery andmaintenance

How do I licensemy disaster recovery site?

You can use the same licenses for your disaster recovery that you use for your production environ‑
ment.

• Configure and manage your disaster recovery environment independently of your production
environment.

• Don’t use both the production and backup License Servers to service license checkouts at the
same time.
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• Make only one License Server accessible at any one time
• The License Server in your disaster recovery environment must have an identical host name to
the License Server in your production environment.

For more information, see Disaster recovery ‑ back up and redundancy.

https://docs.citrix.com/en-us/licensing/current-release/backup.html
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